HP DesignJet T790 and T1300 Printer Series

Using your printer
Legal notices

The information contained herein is subject to change without notice.

The only warranties for HP products and services are set forth in the express warranty statement accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

Hi-Speed USB certified

IPv6-ready

Trademarks

Adobe®, Acrobat®, Adobe Photoshop® and Adobe® PostScript® 3™ are trademarks of Adobe Systems Incorporated.

Corel® is a trademark or registered trademark of Corel Corporation or Corel Corporation Limited.

ENERGY STAR and the ENERGY STAR mark are registered U.S. trademarks.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

PANTONE® is Pantone, Inc.’s check-standard trademark for color.
# 1 Introduction

- Safety precautions .......................................................... 2
- HP Start-Up Kit ............................................................... 2
- Using this guide .............................................................. 2
- Printer models ................................................................. 3
- The printer’s main features ............................................... 4
- The printer’s main components ........................................ 5
- The front panel ............................................................... 8
- Printer software ............................................................. 9
- Web Services ................................................................ 10
- Turn the printer on and off ............................................. 11
- The printer’s internal prints ............................................. 11

# 2 Installing the software

- Choose which connection method to use ........................ 13
- Connect the printer to your network ................................ 13
- Connect a computer to the printer by network (Windows) 14
- Connect a computer to the printer by USB cable (Windows) 15
- Uninstall the printer software (Windows) ......................... 16
- Connect a computer to the printer by network (Mac OS) 16
- Connect a computer to the printer by USB cable (Mac OS) 18
- Uninstall the printer software (Mac OS) ......................... 19

# 3 Setting up the printer

- Introduction .................................................................. 21
- Set up your Web-connected printer ................................. 21
- Web Services manual configuration ............................... 21
- Paper suitability options (T1300 series) ......................... 22
- Turn nesting on and off (T1300 series) ......................... 23
- Turn usage information on and off ............................... 24
- Turn e-mail notifications on and off ......................... 24
- Turn alerts on and off (Windows only) ......................... 24
- Control access to the printer ....................................... 25
- Require account ID (T1300 series) ............................... 26
4 Personalizing the printer ........................................................................................................................................................................................................ 27
  Change the language of the front-panel display .......................................................................................................................... 28
  Access the HP Utility ........................................................................................................................................................................... 28
  Access the Embedded Web Server ...................................................................................................................................................... 28
  Change the language of the HP Utility ............................................................................................................................................. 29
  Change the language of the Embedded Web Server ....................................................................................................................... 29
  Change the sleep mode setting ............................................................................................................................................................. 29
  Turn the buzzer on and off ................................................................................................................................................................. 29
  Change the front-panel display brightness ...................................................................................................................................... 29
  Change the units of measurement ....................................................................................................................................................... 29
  Configure network settings ................................................................................................................................................................. 29
  Change the graphic language setting ................................................................................................................................................. 30
  Manage printer security .......................................................................................................................................................................... 31
  Change your printer’s email address .................................................................................................................................................... 31

5 Paper handling ........................................................................................................................................................................................................ 32
  General advice .......................................................................................................................................................................................... 33
  Load a roll onto the spindle ............................................................................................................................................................... 33
  Load a roll into the printer ................................................................................................................................................................. 35
  Unload a roll .......................................................................................................................................................................................... 38
  Load a single sheet ............................................................................................................................................................................... 38
  Unload a single sheet ........................................................................................................................................................................... 40
  View information about the paper ..................................................................................................................................................... 40
  Paper presets ......................................................................................................................................................................................... 40
  Printing paper info .............................................................................................................................................................................. 41
  Move the paper .................................................................................................................................................................................... 41
  Maintain paper ..................................................................................................................................................................................... 41
  Change the drying time ...................................................................................................................................................................... 41
  Turn the automatic cutter on and off ............................................................................................................................................... 42
  Feed and cut the paper ......................................................................................................................................................................... 42

6 Working with two rolls (T1300 series) .......................................................................................................................................................... 44
  The uses of a multiroll printer ............................................................................................................................................................. 44
  How the printer allocates jobs to paper rolls ...................................................................................................................................... 44

7 Printing ......................................................................................................................................................................................................... 46
  Introduction ........................................................................................................................................................................................ 47
  Print from a USB flash drive ............................................................................................................................................................... 47
  Print from a computer using the Embedded Web Server or HP Utility (T1300 series) ................................................................. 48
  Print from a computer using a printer driver ...................................................................................................................................... 49
  Advanced print settings ......................................................................................................................................................................... 49
8 Web-connected printing .......................................................................................................................... 61
  Print by email ........................................................................................................................................ 61

9 Job queue management (T790 PS and T1300 series) ............................................................................ 62
  Introduction .......................................................................................................................................... 63
  The job queue in the front panel (T790 PS and T1300 series) ................................................................. 63
  The job queue in the Embedded Web Server or HP Utility (T1300 series) .................................................. 65

10 Color management .............................................................................................................................. 69
  Introduction .......................................................................................................................................... 70
  How colors are represented ...................................................................................................................... 70
  A summary of the color management process ............................................................................................ 70
  Color calibration ..................................................................................................................................... 70
  Color management from printer drivers ..................................................................................................... 71
  Color management from printer drivers (PostScript printers) ........................................................................ 74
  Color management from the Embedded Web Server (T1300 series) ......................................................... 77
  Color management from the front panel ...................................................................................................... 78

11 Practical printing examples ................................................................................................................ 80
  Print a draft for revision with the correct scale ............................................................................................ 81
  Print a project ........................................................................................................................................... 83
  Print a presentation ................................................................................................................................... 90
  Print and scale from Microsoft Office ......................................................................................................... 95

12 Retrieving printer usage information .................................................................................................. 101
  Get printer accounting information .......................................................................................................... 102
  Check usage statistics ............................................................................................................................... 102
  Check usage statistics for a job .................................................................................................................. 102
  Request accounting data by email ............................................................................................................ 103

13 Handling ink cartridges and printheads ............................................................................................... 105
  About the ink cartridges ............................................................................................................................. 106
  Check the ink cartridges status .................................................................................................................... 106
  Remove an ink cartridge ............................................................................................................................. 106
  Insert an ink cartridge ............................................................................................................................... 107
  About the printheads .................................................................................................................................. 108
  Check the printhead status .......................................................................................................................... 109
  Remove a printhead .................................................................................................................................... 109
  Insert a printhead ....................................................................................................................................... 112

14 Maintaining the printer ......................................................................................................................... 115
  Check printer status .................................................................................................................................... 116
  Clean the exterior of the printer ................................................................................................................ 116
Troubleshooting print-quality issues

15 Accessories

16 Troubleshooting paper issues

17 Troubleshooting print-quality issues

Maintain the ink cartridges ......................................................................................................................... 116
Move or store the printer ............................................................................................................................... 116
Update the firmware ........................................................................................................................................ 117
Update the software ......................................................................................................................................... 118
Printer maintenance kits .............................................................................................................................. 118
Secure Disk Erase ........................................................................................................................................... 118

15 Accessories ................................................................................................................................................ 119
How to order supplies and accessories ........................................................................................................ 120
Introduction to the accessories ..................................................................................................................... 124

16 Troubleshooting paper issues ................................................................................................................ 128
The paper cannot be loaded successfully ................................................................................................... 129
The paper type is not in the driver ................................................................................................................ 130
The printer printed on the wrong paper type ............................................................................................... 132
An “on hold for paper” message (T1300 series) ......................................................................................... 132
The roll paper will not advance ................................................................................................................... 133
The paper has jammed ................................................................................................................................... 133
A strip stays on the output tray and generates jams .................................................................................... 136
The printer displays out of paper when paper is available ........................................................................ 137
Prints do not fall neatly into the basket ....................................................................................................... 137
The sheet stays in the printer when the print has been completed .............................................................. 137
The paper is cut when the print has been completed .................................................................................. 137
The cutter does not cut well .......................................................................................................................... 137
The roll is loose on the spindle .................................................................................................................... 137
Recalibrate the paper advance .................................................................................................................... 138

17 Troubleshooting print-quality issues .................................................................................................... 140
General advice .............................................................................................................................................. 141
Print quality troubleshooting wizard ............................................................................................................ 141
Horizontal lines across the image (banding) ............................................................................................... 142
Lines are too thick, too thin or missing ......................................................................................................... 143
Lines appear stepped or jagged ..................................................................................................................... 143
Lines print double or in the wrong colors ..................................................................................................... 144
Lines are discontinuous ............................................................................................................................... 144
Lines are blurred .......................................................................................................................................... 145
Line lengths are inaccurate ............................................................................................................................ 145
The whole image is blurry or grainy ............................................................................................................. 146
The paper is not flat ........................................................................................................................................ 146
The print is scuffed or scratched ................................................................................................................. 147
Ink marks on the paper .................................................................................................................................. 147
Black ink comes off when you touch the print ............................................................................................. 148
Edges of objects are stepped or not sharp .................................................................................................... 148
Edges of objects are darker than expected .............................................................. 148
Horizontal lines at the end of a cut sheet print ......................................................... 149
Vertical lines of different colors ........................................................................... 149
White spots on the print ......................................................................................... 149
Colors are inaccurate ............................................................................................ 149
Colors are fading ..................................................................................................... 150
The image is incomplete (clipped at the bottom) ...................................................... 150
The image is clipped ............................................................................................... 151
Some objects are missing from the printed image ..................................................... 151
A PDF file is clipped or objects are missing ............................................................. 152
The Image Diagnostics Print ................................................................................... 152
If you still have a problem ....................................................................................... 154

18 Troubleshooting ink cartridge and printhead issues ............................................. 155
Cannot insert an ink cartridge ................................................................................. 156
Ink cartridge status messages ................................................................................ 156
Cannot insert a printhead ....................................................................................... 156
The front-panel display recommends reseating or replacing a printhead ............... 156
Clean the printheads ............................................................................................. 157
Clean the printhead drop detector ........................................................................ 157
Align the printheads .............................................................................................. 159
Printhead status messages ..................................................................................... 161

19 Troubleshooting general printer issues ............................................................... 162
The printer will not start .......................................................................................... 163
The printer does not print ....................................................................................... 163
The printer seems slow .......................................................................................... 163
Communication failures between computer and printer ......................................... 164
Cannot access the HP Utility .................................................................................. 164
Cannot access the Embedded Web Server ............................................................ 164
Cannot connect to the Internet .............................................................................. 165
Web Services issues ............................................................................................... 165
Automatic file system check .................................................................................. 165
Alerts ....................................................................................................................... 166

20 Front-panel error messages .................................................................................. 167
The system error log .............................................................................................. 169

21 HP Customer Care ............................................................................................. 170
Introduction ............................................................................................................ 171
HP Professional Services ....................................................................................... 171
HP Instant Support ............................................................................................... 172
HP Proactive Support ........................................................................................... 172
1 Introduction

- Safety precautions
- HP Start-Up Kit
- Using this guide
- Printer models
- The printer’s main features
- The printer’s main components
- The front panel
- Printer software
- Web Services
- Turn the printer on and off
- The printer’s internal prints
Safety precautions

The following precautions ensure the proper use of the printer and prevent the printer from being damaged. Follow these precautions at all times.

- Use the power supply voltage specified on the label. Avoid overloading the printer's electrical outlet with multiple devices.
- Ensure that the printer is well-grounded. Failure to ground the printer may result in electrical shock, fire and susceptibility to electromagnetic interference.
- Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for service, see Contact HP Support on page 173.
- Use only the electrical cord supplied by HP with the printer. Do not damage, cut or repair the power cord. A damaged power cord can cause fire or electric shock. Replace a damaged power cord with an HP-approved power cord.
- Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the printer. Doing so may cause fire, electric shock or other serious hazards.
- Turn off the printer and unplug the power cord from the power outlet in any of the following cases:
  - When placing your hands inside the printer
  - If there is smoke or an unusual smell coming from the printer
  - If the printer is making an unusual noise not heard during normal operation
  - A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of the printer
  - During a thunderstorm
  - During a power failure

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer’s software and documentation.

Using this guide

This guide can be downloaded from the HP Knowledge Center (see Knowledge Center on page 171).

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance

These chapters help you carry out normal printer procedures and include the following topics.

- Installing the software on page 12
- Setting up the printer on page 20
- Personalizing the printer on page 27
- Paper handling on page 32
Troubleshooting

These chapters help you solve problems that may occur while printing and include the following topics.

- Troubleshooting paper issues on page 128
- Troubleshooting print-quality issues on page 140
- Troubleshooting ink cartridge and printhead issues on page 155
- Troubleshooting general printer issues on page 162
- Front-panel error messages on page 167

Accessories, support and specifications

These chapters, Accessories on page 119, HP Customer Care on page 170 and Printer specifications on page 174, contain reference information, including customer care, the printer specifications and part numbers for paper types, ink supplies and accessories.

Glossary

The Glossary on page 178 contains definitions of printing and HP terms used in this documentation.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer from being damaged. Follow the instructions marked with these symbols.

⚠️ WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or death.

⚠️ CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or damage to the printer.

Printer models

This guide covers the following printer models, normally referring to them by their short names for brevity.
### The printer’s main features

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 610 mm (24 in) or 1118 mm (44 in) wide. Some major features of the printer are shown below:

- Print resolution of up to 2400 × 1200 optimized dpi, from a 1200 × 1200 dpi input, using the **Best** print-quality option, the **Maximum Detail** option and photo paper
- The printer can be controlled from its front panel or from a remote computer using the Embedded Web Server or the HP Utility
- Touch-sensitive front panel in color, with an intuitive graphical user interface
- Job previews in the front panel
- Job previews on remote computers (T1300 series only)
- Includes Web-connected features such as automatic firmware upgrades and HP ePrint
- Driverless printing: Files in common graphical formats can be printed directly without needing a printer driver. Just insert a USB flash drive or connect a laptop computer containing your files.
- Paper flexibility and automatic easy load, see [Paper handling on page 32](#), with information and presets accessible from the front panel and the HP Utility
- Handles cut-sheet and roll paper
- Six-ink system
- Accurate and consistent color reproduction with automatic color calibration
- Color emulations, see [Printer emulation on page 72](#)
- Economode for printing economically
- Two rolls loaded at once provide fast and easy switching between different rolls, or long runs of unattended printing (T1300 series only)
- High productivity features such as job previewing and nesting using the HP Utility or the printer’s Embedded Web Server (T1300 series only)
- Ink and paper usage information available from the Embedded Web Server, see [Access the Embedded Web Server on page 28](#)
- Access to the online HP Knowledge Center (see [Knowledge Center on page 171](#))
The printer’s main components

The following front and rear views of the 1118mm (44 in) printer illustrate the main components. The 610 mm (24 in) printer (not shown) has the same components in a narrower body.

Front view

1. Ink cartridge
2. Ink cartridge slots
3. Blue lever
4. Window
5. Front panel
6. Printhead carriage
7. Printhead
8. Output tray
9. Paper alignment lines
10. Basket
1. Roll cover
2. Communication ports
3. Power switch
4. Power socket
5. Spindle
6. Spindle stop
7. Paper roll
**Communication ports**

1. Hi-Speed USB device port, to connect a computer
2. Fast (T790) or Gigabit (T795, T1300) Ethernet port, to connect to a network
3. Diagnostic LEDs, to be used by service engineers
4. Hi-Speed USB host port, intended for connecting an accessory

There is another Hi-Speed USB host port on the other side of the printer, beside the front panel, intended for connecting a USB flash drive.

**The wall spacers**

If you place the printer with its back against a wall, lower the two wall spacers at the rear of the printer to ensure that the rear of the printer is a minimum distance from the wall. Otherwise, you may experience paper advance problems.
The front panel

The front panel is located on the front right of the printer. It gives you complete control of your printer: from the front panel, you can print, view information about the printer, change printer settings, perform calibrations and tests, and so on. The front panel also displays alerts (warning and error messages) when needed.

1. A Hi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be printed. When a USB flash drive is inserted, a USB icon is displayed on the front panel's home screen.

2. The front panel itself: a touch-sensitive screen with a graphical user interface.

3. The Power key, with which you can turn the printer on or off. The key is illuminated when the printer is on. It flashes when the printer is in transition between on and off.

The front panel has a large central area to display dynamic information and icons. On the left and right sides you can see up to six fixed icons at different times. Normally they are not all displayed at the same time.

Left and right fixed icons

- Press to return to the home screen.
- Press to view help about the current screen.
- Press to go to the previous item.
- Press to go to the next item.
- Press to go back to the previous screen. This does not discard any changes made in the current screen.
- Press to cancel the current process.
Home screen dynamic icons

The following items are displayed only on the home screen.

- Press to view information about printer status, change printer settings, or initiate actions such as loading paper or replacing ink supplies. A smaller warning icon appears if there are actions that need to be performed.

- To the right of the above button is a message showing the printer status or the most important current alert. Press this message to see a list of all current alerts, with an icon indicating the severity of each alert.

- Press to print a file from a USB flash drive, or to print from a computer. See Printing on page 46.

- Press to print using HP ePrint. See Web-connected printing on page 61.

- Press to view information about the USB flash drive(s). This icon appears only when one or more USB flash drives are inserted.

- Press to view and manage the job queue. A smaller warning icon appears if there are jobs on hold. See Job queue management (T790 PS and T1300 series) on page 62.

- Press to access available applications. See http://www.hpconnected.com (availability varies by product, country, and region).

- While a PostScript or PDF job is printing (PostScript printers only), the Adobe PDF icon is displayed; pressing it has no effect.

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. To change the time that elapses before sleep mode, press , then , then Setup > Front panel options > Sleep mode wait time. You can set a time between 1 and 240 minutes.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external interaction with it.

Information about specific uses of the front panel can be found throughout this guide.

Printer software

The following software is provided with your printer:

- The HP-GL/2 and HP RTL driver for Windows
- The PCL3GUI raster driver for Mac OS (non-PostScript printers)
- PostScript drivers for Windows, Mac OS and Linux (PostScript printers)
- HP DesignJet Preview
- The Embedded Web Server and (alternatively) the HP Utility allow you to:
  - Manage the printer from a remote computer
  - View the status of the ink cartridges, the printheads and the paper
  - Access the HP Knowledge Center, see Knowledge Center on page 171
  - Update the printer's firmware, see Update the firmware on page 117
— Perform calibrations and troubleshooting
— Submit print jobs (T1300 series only)
— Manage the job queue, see Job queue management (T790 PS and T1300 series) on page 62
— View job accounting information (T1300 series only), see Retrieving printer usage information on page 101
— Change various printer settings
— Manage e-mail notifications
— Change permissions and security settings (T1300 series only)

See Access the Embedded Web Server on page 28 and Access the HP Utility on page 28.

NOTE: New versions of all printer software can be expected to appear from time to time. In some cases, when you receive your printer there may already be later versions available on HP's website of some of the software provided with it.

Web Services

Your printer can be connected to the Internet and the Web, providing various benefits:

● Automatic firmware updates (see Update the firmware on page 117)
● Print on HP printers from almost anywhere
● Print on HP printers from almost any device, including smartphones and tablet computers

To take advantage of these benefits, your printer must be connected to the Internet.

For the latest information, see http://www.hpconnected.com (availability varies by product, country, and region).

Turn the printer on and off

TIP: The printer can be left powered on without wasting energy. Leaving it on improves response time and overall system reliability. When the printer has not been used for a certain period of time (the default time is determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer’s front-panel display, or sending a new job to print, returns it to active mode, and it can resume printing immediately. To change the sleep mode time, see Change the sleep mode setting on page 29.

NOTE: In sleep mode, the printer performs maintenance service to the printheads from time to time. This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave the printer powered on or in sleep mode to avoid wasting ink and time.

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to use the Power key on the front panel.

However, if you plan to store the printer for a long period or the Power key does not seem to work, you are recommended to turn it off using the power switch at the rear.
To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the printheads. Preparing the printheads takes about 75 seconds. However, if the printer has been off for six weeks or more, preparing the printheads could take up to 45 minutes.

The printer’s internal prints

The internal prints give various kinds of information about your printer. They can be requested from the front panel.

Before requesting any internal print, check that the printer and the paper are ready for printing.

- The loaded paper should be at least A3 landscape—420 mm (16.53in) wide—otherwise the print may be clipped.
- The front panel should be displaying the Ready message.

To print any internal print, press **1**, then **9**, then scroll down to Internal prints and press it, then select the internal print you want. The following internal prints are available.

- Demo prints: show some of the capabilities of the printer
  - Print drawing demo
  - Print rendering demo
  - Print GIS map
- Configuration: shows all the current front-panel display settings
- Usage report: shows estimates of the total number of prints, number of prints by paper type, number of prints by print-quality option and total amount of ink used per color (the accuracy of these estimates is not guaranteed) (T1300 series only)
- HP-GL/2 palette: shows the color or grayscale definitions in the currently selected color palette
- Service information: provides information needed by service engineers
- PostScript font list: shows PostScript fonts available (PostScript printers only)
Installing the software

- Choose which connection method to use
- Connect the printer to your network
- Connect a computer to the printer by network (Windows)
- Connect a computer to the printer by USB cable (Windows)
- Uninstall the printer software (Windows)
- Connect a computer to the printer by network (Mac OS)
- Connect a computer to the printer by USB cable (Mac OS)
- Uninstall the printer software (Mac OS)
Choose which connection method to use

The following methods can be used to connect your printer.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Speed</th>
<th>Cable length</th>
<th>Other factors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Ethernet (T790 series only)</td>
<td>Fast; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches)</td>
</tr>
<tr>
<td>Gigabit Ethernet (T795 &amp; T1300 series only)</td>
<td>Very fast; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches)</td>
</tr>
<tr>
<td>Jetdirect print server (optional accessory)</td>
<td>Moderate; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches); Provides additional features; See <a href="http://www.hp.com/go/jetdirect">http://www.hp.com/go/jetdirect</a> for more details</td>
</tr>
<tr>
<td>Hi-Speed USB</td>
<td>Very fast</td>
<td>Short: 5 m (16 ft)</td>
<td>A certified Hi-Speed USB cable is necessary for reliable communication.</td>
</tr>
</tbody>
</table>

**NOTE:** The speed of any network connection depends on all components used in the network, which can include network interface cards, routers, switches and cables. If any one of these components cannot operate at high speed, you will have a low-speed connection. The speed of your network connection can also be affected by the total amount of traffic from other devices on the network.

Connect the printer to your network

The printer is able to configure itself automatically for most networks, in a similar way to any computer in the same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front panel: press \[Paper Input Button\], then \[Network Button\].

**Network configuration**

For more details about the current network configuration, go to the front panel and press \[Paper Input Button\], then \[Network Button\], then Connectivity > Network connectivity > Fast/Gigabit Ethernet > Modify configuration; or, for Jetdirect, Connectivity > Network connectivity > Jetdirect EIO > Modify configuration. From here it is possible, though not normally necessary, to change the settings manually; this can also be done remotely using the Embedded Web Server or the HP Utility.

**TIP:** You may find it helpful to print out the full printer network configuration on paper. This can be done from the front panel: press \[Paper Input Button\], then \[Network Button\], then Internal print > Service information prints > Print connectivity config. If you do not print out the full network configuration, consider making a note of the printer’s IP address and network name.

If you accidentally misconfigure the printer’s network settings, you can restore the network settings to their factory values from the front panel: press \[Paper Input Button\], then \[Network Button\], then Connectivity > Network connectivity > Fast/Gigabit Ethernet > Restore factory settings; or, for Jetdirect, Connectivity > Network connectivity > Jetdirect EIO > Restore factory settings. Then you must restart the printer. This automatically provides a working network configuration for most networks. The printer’s other settings remain unchanged.
Using IPv6

Your printer supports almost all network connectivity features using IPv6, just as it does using IPv4. To make full use of IPv6, you may need to connect your printer to an IPv6 network in which there are IPv6 routers and servers.

In most IPv6 networks, the printer will configure itself automatically as follows, and no user configuration is necessary:

1. The printer assigns itself a link-local IPv6 address (which starts with “fe80::”).
2. The printer assigns itself stateless IPv6 addresses as indicated to it by any IPv6 routers on the network.
3. If no stateless IPv6 addresses can be assigned, the printer will try to obtain IPv6 addresses using DHCPv6. It will also do so if the routers instruct it to do so.

The stateless and DHCPv6 IPv6 addresses can be used to access the printer, and in most IPv6 networks this will be appropriate.

The link-local IPv6 address works only in the local subnet. Although it is possible to access the printer using this address, it is not recommended.

It is possible to assign a manual IPv6 address to the printer, using the front panel or the Embedded Web Server. It is also possible to disable IPv6 completely in the printer, and therefore it is not possible to configure the printer as IPv6-only.

NOTE: In typical IPv6 use, your printer will have multiple IPv6 addresses, although it has only one IPv4 address.

TIP: You will generally find it easier to use IPv4 unless you have a specific need to use IPv6.

Microsoft Windows Vista, Microsoft Windows Server 2008, and the new HP Printing and Imaging devices will have IPv6 enabled by default. For further information on IPv6, see http://h20000.www2.hp.com/bc/docs/support/SupportManual/c00840100/c00840100.pdf. This document discusses how name resolution plays a fundamental role in Dual-Stack transition methods. Using the name resolution algorithm in Windows Vista, the document goes through various network environments and studies how the introduction of routable IPv6 addresses will affect network applications. It also discusses DHCPv6, SLAAC and the impact to DNS, and makes some recommendations.

Using IPSec

Your printer supports IPSec.

However, successful IPSec configuration requires advanced network expertise, and is beyond the scope of this document. For IPSec to work, the printer’s IPSec configuration must exactly match that of the other devices in your network. Any discrepancy will prevent communication with your printer until the configuration is corrected or IPSec is disabled. For more information on IPSec configuration, download the file IPsec_Admin_Guide.pdf from http://www.hp.com/go/T790/manuals or http://www.hp.com/go/T1300/manuals.

Connect a computer to the printer by network (Windows)

The following instructions apply if you intend to print from software applications using a printer driver. See Printing on page 46 for alternative ways of printing.

Before you begin, check your equipment:

- The printer should be set up and on.
- The Ethernet switch or router should be on and functioning correctly.
- The printer and the computer should be connected to the network (see Connect the printer to your network on page 13).
Now you can proceed to install the printer software and connect to your printer.

**Printer software installation**

1. Make a note of the printer’s IP address from the front panel (see [Access the Embedded Web Server on page 28](#)).

2. Insert the *HP Start-up Kit* DVD into your computer. If the DVD does not start automatically, run the `setup.exe` program in the root folder of the DVD.

3. Press the **Software Installation** button.

4. Press the **Express Network Install** button, and choose your printer from the list of networked printers that appears, identifying it by its IP address if necessary. The printer drivers and other HP software, such as the HP Utility.

   If your computer fails to find any printers on the network, the **Printer Not Found** window is displayed, which helps you to try to find your printer. If you have a firewall in operation; you may have to disable it temporarily in order to find the printer. You also have the options of searching for the printer by its hostname, IP address or MAC address.

   In some cases, when the printer is not in the same sub-net as the computer, specifying the printer's IP address may be the only successful option.

**Connect a computer to the printer by USB cable (Windows)**

You can connect your printer directly to a computer without going through a network, by using the printer’s built-in Hi-Speed USB device port.

**Tip:** A USB connection may be faster than a network connection, but the cable is limited in length and it is more difficult to share the printer.

**Note:** The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor’s Forum ([http://www.usb.org/](http://www.usb.org/)) should be used with this printer.

**Printer software installation**

The following instructions apply if you intend to print from software applications using a printer driver. See [Printing on page 46](#) for alternative ways of printing.

1. **Do not connect the computer to the printer yet.** You must first install the printer software on the computer, as follows.

2. Insert the *HP Start-up Kit* DVD into your DVD drive. If the DVD does not start automatically, run the `setup.exe` program in the root folder of the DVD.

3. Press the **Software Installation** button.

4. Press the **Custom Install** button.

5. In some cases, you may see a message warning you that the installer would need to communicate through the firewall in order to search the network for printers. As you have no need to do this, you can check the box **Continue installation without searching the network**.

6. If you see a list of networked printers, select **Help me find my printer** (including network, USB or parallel connected printers).

7. Select **USB Cable**

**Note:** You can connect your printer and complete the installation later if you prefer. To do so, check the box marked **I want to connect my printer after completing the setup wizard**.
8. When prompted to do so, connect your computer to the printer with a certified USB cable. Ensure that the printer is turned on.

9. The printer drivers and the HP Utility are installed.

**TIP:** If you would like to share the printer with other people connected to your network, press the Printer Properties button in the Ready to Install window, set Printer Name to the name under which the printer will be shared, then set Shared to Yes.

### Printer sharing considerations

- Any other users sharing your directly connected printer will be able to send print jobs, but will not be able to receive information from the printer—which affects alerts, status reports, paper management, administration and troubleshooting.

- Any other users sharing your directly connected printer will be unable to use the printer’s own print preview facility, although the application’s print preview will still be available. See Preview a print on page 54.

**TIP:** The best way to share the printer over a network is to connect the printer not to any computer, but to the network. See Connect a computer to the printer by network (Windows) on page 14.

### Uninstall the printer software (Windows)

1. Insert the HP Start-up Kit DVD into your DVD drive. If the DVD does not start automatically, run the setup.exe program in the root folder of the DVD.

2. Press the Software Installation button.

3. Press the Modify Installation button, and follow the instructions on your screen to uninstall the printer software.

### Connect a computer to the printer by network (Mac OS)

You can connect your printer to a network under Mac OS X by using the following methods:

- Bonjour
- TCP/IP

**NOTE:** The printer does not support AppleTalk.

The following instructions apply if you intend to print from software applications using a printer driver. See Printing on page 46 for alternative ways of printing.

Before you begin, check your equipment:

- The printer should be set up and on.
- The Ethernet switch or router should be on and functioning correctly.
- The printer and the computer should be connected to the network (see Connect the printer to your network on page 13).

Now you can proceed to install the printer software and connect to your printer.
Bonjour connection

1. Go to the front panel and press , then then . Note the mDNS service name of your printer.
2. Insert the HP Start-up Kit DVD into your DVD drive.
3. Open the DVD icon on your desktop.
4. Open the Mac OS X HP DesignJet Installer.
5. Follow the instructions on your screen.
6. The printer software is installed, including the printer driver and other HP software, such as the HP Utility.
7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer. Follow the instructions on your screen.
8. When you reach the Select Printer screen, look for your printer’s mDNS service name (which you noted in step 1) in the Printer Name column.
   ● If you find the right name, scroll sideways if necessary to see the Connection Type column, and check that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down the list.
   ● If you cannot find your printer’s name with a Bonjour connection type, check the box My printer is not in the list.
   Click Continue.
9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click Quit to exit, or Create New Queue if you want to connect another printer to the network.
10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

TCP/IP connection

1. Go to the front panel and make a note of the printer’s URL (see Access the Embedded Web Server on page 28).
2. Insert the HP Start-up Kit DVD into your DVD drive.
3. Open the DVD icon on your desktop.
4. Open the Mac OS X HP DesignJet Installer.
5. Follow the instructions on your screen.
6. The printer software is installed, including the printer driver and other HP software, such as the HP Utility.
7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer. Follow the instructions on your screen.
8. When you reach the Select Printer screen, look for your printer’s URL (which you noted in step 1) in the Printer Name column.
   ● If you find the right name, scroll sideways if necessary to see the Connection Type column, and check that it shows IP Printing. Then highlight that line. Otherwise, continue searching further down the list.
   ● If you cannot find your printer’s name with an IP Printing connection type, check the box My printer is not in the list.
Click **Continue**.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click **Quit** to exit, or **Create New Queue** if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

### Connect a computer to the printer by USB cable (Mac OS)

You can connect your printer directly to a computer without going through a network, by using the printer's built-in Hi-Speed USB device port.

**Printer software installation**

The following instructions apply if you intend to print from software applications using a printer driver. See [Printing on page 46](#) for alternative ways of printing.

1. Make sure the printer is either turned off, or disconnected from the computer.
2. Insert the **HP Start-up Kit** DVD into your DVD drive.
3. Open the DVD icon on your desktop.
4. Open the **Mac OS X HP DesignJet Installer**.
5. Follow the instructions on your screen.
6. The printer software is installed, including the printer driver and the HP Utility.
7. Make sure that the printer is turned on and connected to the computer with a certified USB cable.

**NOTE:** The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor’s Forum ([http://www.usb.org/](http://www.usb.org/)) should be used with this printer.

8. Shortly afterwards, a print queue is created automatically for your printer.

### Sharing the printer

If your computer is connected to a network, you can make your directly connected printer available to other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.
2. To enable printer sharing, go **Sharing**, select **Printer Sharing**, and then check the printer(s) that you want to share.
3. Your printer now automatically appears in the list of shared printers displayed by any other computer running Mac OS and connected to your local network.

Please bear in mind the following considerations.

- Any other users wishing to share your printer must install the printer software on their own computers.
- Anyone sharing your directly connected printer will be able to send print jobs, but will not be able to receive information from the printer—which affects alerts, status reports, paper management, administration and troubleshooting.
- You may find that sharing your directly connected printer with other users will slow down your computer unacceptably.
TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to the network. See Connect a computer to the printer by network (Mac OS) on page 16.

Uninstall the printer software (Mac OS)

1. Insert the HP Start-up Kit DVD into your DVD drive.
2. Open the DVD icon on your desktop.
3. Open the Mac OS X HP DesignJet Uninstaller, and follow the instructions on your screen to uninstall the printer software.

To delete the print queue, select the Print & Fax dialog from the system preferences. Select the name of the printer and click the – button.
3 Setting up the printer

- Introduction
- Set up your Web-connected printer
- Web Services manual configuration
- Paper suitability options (T1300 series)
- Turn nesting on and off (T1300 series)
- Turn usage information on and off
- Turn e-mail notifications on and off
- Turn alerts on and off (Windows only)
- Control access to the printer
- Require account ID (T1300 series)
- Set Windows driver preferences
Introduction

This chapter describes various printer settings that the printer administrator may wish to control as soon as a new printer is assembled and ready for use.

Set up your Web-connected printer

Your printer can connect to the Internet to benefit from various Web Services:

- Automatic firmware updates
- Use HP ePrint to print by email

To set up your printer for Web Services, please follow these steps, explained in more detail below:

1. Make sure that your printer is correctly connected to the Internet.

2. Run the Connectivity Wizard: At the front panel, press then Connectivity > Connectivity wizard.

   If you cannot find the Connectivity Wizard in the menu, please update your firmware and then try again.

   If the Wizard downloads new firmware, the printer may need to restart.

   **TIP:** When the Wizard displays your printer code and email address, you are recommended to make a note of them.

3. Optional step: If you are the printer administrator, log in at HP Connected (http://www.hpconnected.com; availability varies by product, country, and region) to customize your printer’s email address or manage printer security for remote printing.

Congratulations, you now have completed Web Services setup. HP ePrint is ready to use.

For the latest information, support, and terms of use of HP Connected, see http://www.hpconnected.com (availability varies by product, country, and region).

Web Services manual configuration

The Connectivity Wizard (see Set up your Web-connected printer on page 21) is normally sufficient for Web Services configuration, but there are also facilities for manual configuration if you wish to use them.

Configure the printer’s Internet connection

You can configure the printer’s Internet connection from the Embedded Web Server or from the front panel.

**NOTE:** If an administrator password has been set, it will be required to change these settings. Thus, the administrator can prevent the printer from being connected to the Internet, if desired.

- **In the Embedded Web Server:** select Setup > Internet connection.
- **Using the front panel:** press then Connectivity > Internet connectivity.

The following settings are available:

- **Enable Internet connection:** The default value is Yes.
- **Proxy > Enable proxy:** Enable or disable a proxy server.
- **Proxy > Address:** Enter the proxy address, empty by default.
Configure firmware updates

You can choose from the Embedded Web Server or from the front panel whether and how to download firmware updates.

NOTE: If an administrator password has been set, it will be required to change these settings.

- **In the Embedded Web Server**: select Setup > Firmware update.
- **Using the front panel**: press then Updates > Firmware update.

The following settings are available:

- **Check**: If you select Automatically (the default setting), the printer will check automatically every week (or after the printer has been restarted seven times, whichever happens first) whether new firmware is available. If you select Manually, the printer will not check automatically; you can check manually whenever you like.
- **Download**: If you select Automatically (the default setting), the printer will automatically download new firmware whenever it becomes available. If you select Manually, you will be asked to approve each download.

NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install the new firmware, you must confirm the installation manually.

- **Firmware update information**: Information about the firmware currently installed
- **Firmware update history**: A list of firmware versions that have been installed in the printer. It is usually possible to reinstall the version immediately before the version that is currently installed, if you have some problem with the current version.

Paper suitability options (T1300 series)

Paper mismatch action

If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put the job on hold until some suitable paper is loaded, or it can ignore the problem and print the job on the unsuitable paper. There are several ways in which the loaded paper may be considered unsuitable:

- The paper type is not as specified for the job
- The paper source (roll 1, roll 2 or sheet) is not as specified for the job
- The paper size is smaller than specified for the job

You can set the printer's behavior in such cases from the front panel.

- Press then Setup > Job management options > Paper mismatch action > Print anyway if you want such jobs to print on whatever paper is loaded. This is the default option when printing from a software application or from the Embedded Web Server; but it does not work when printing from a USB flash drive, nor when copying.
- Press then Setup > Job management options > Paper mismatch action > Put job on hold if you want such jobs to be put on hold. The printer will send an alert whenever a job is put on hold.
When a job is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded (in which case, all jobs waiting for that paper type can be printed). Meanwhile, other jobs with different requirements can continue printing.

**Roll switching options**

If two rolls are loaded, both of which are suitable for the job, the roll will be chosen according to your preferences. These can be set from the front panel: press \[\text{Setup}\] then \[\text{Paper options}\] then \[\text{Roll switching options}\].

- **Minimize paper waste.** If this option is chosen, the printer will choose the narrowest roll that meets all the criteria, to avoid wasting paper due to trimming. This is the default option.
- **Minimize roll changes.** If this option is chosen, the printer will choose the roll that is currently active, to avoid wasting time with a roll switch.
- **Use roll with less paper.** If this option is chosen, the printer will choose the roll that has the least paper.

**NOTE:** This option is effective only if you have enabled Printing paper info (see Printing paper info on page 41). Otherwise, it has the same effect as Minimize paper waste.

**Turn nesting on and off (T1300 series)**

Nesting means automatically printing images or document pages side by side on the paper when feasible, rather than one after the other. This is done to avoid wasting paper. See Nest jobs to save roll paper (T1300 series) on page 57.

To turn nesting on or off, you must first make sure that the job queue is enabled (see Turn off the job queue on page 64 or Turn off the job queue on page 68) and the start of printing is set to After Processing (see Select when to print a job in the queue on page 63 or Select when to print a job in the queue on page 66). Then:

- **In the HP Utility for Windows:** select **Settings > Job Management > Nest.**
- **In the HP Utility for Mac OS:** select **Configuration > Printer Settings > Configure Printer Settings > Job Management > Nest.**
- **In the Embedded Web Server:** select **Setup > Printer settings > Job management > Nest.**
- **Using the front panel:** press \[\text{Setup}\] then \[\text{Job management}\] then \[\text{Nest options}\] then \[\text{Enable nesting}\].

In each case, you will see the following options:

- **In order:** pages are nested in the order in which they are sent to the printer. The nested pages are printed as soon as one of three conditions is met:
  - The next page will not fit on the same row as the other pages already nested.
  - No page has been sent to the printer during the specified wait time.
  - The next page is incompatible with the pages already nested (see Nest jobs to save roll paper (T1300 series) on page 57).

- **Optimized order:** pages are not necessarily nested in the order in which they are sent to the printer. When it receives an incompatible page, the printer holds it and waits for compatible pages to complete the nest. The nested pages are printed as soon as one of three conditions is met:
The nesting wait time can be set at the front panel: press \[\text{Menu} \] then \[\text{Setup} \] then \[\text{Job management} \] then \[\text{Nest options} \] then \[\text{Select wait time} \].

**TIP:** Optimized order uses the minimum amount of paper; however, it may take longer to print because the printer waits for compatible pages to arrive.

### Turn usage information on and off

The printer can send usage information periodically by e-mail. You can request this in the following ways:

- **In the HP Utility for Windows:** select Settings > Accounting.
- **In the HP Utility for Mac OS:** select Configuration > Printer Settings > Configure Printer Settings > Accounting.
- **In the Embedded Web Server:** select Setup > Printer settings > Accounting.

In each case, you must set the following options:

- **Send accounting files:** On (the default is Off)
- **Send accounting files to:** a valid e-mail address
- **Send accounting files every:** choose a number of days (1–60) or a number of prints (1–500)

You must also ensure that the e-mail server has been configured. To configure the e-mail server using the Embedded Web Server, select Setup > E-mail server, and fill in the following fields:

- **SMTP server:** the IP address of the outgoing mail server (SMTP) that will process all e-mail messages from the printer. If the mail server requires authentication, e-mail notifications will not work.
- **Printer e-mail address:** each e-mail message sent by the printer must include a return address, which does not need to be a real, functional E-mail address, but it should be unique, so that recipients of the message can identify the printer that sent it.

### Turn e-mail notifications on and off

In order to receive e-mail notifications from the printer, you must have configured the e-mail server (see Turn usage information on and off on page 24).

You can turn specific e-mail notifications on or off by selecting Notifications from the Setup tab of the Embedded Web Server.

### Turn alerts on and off (Windows only)

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of your printing jobs changes its status. The alerts are displayed by the printer’s front panel, by the HP Utility, by the printer driver and by the Embedded Web Server.

You can tell the printer which kinds of alerts you would like to see (if any). To access the alert settings:
Control access to the printer

Front-panel security settings

From the front panel, you can press \( \text{Home} \), then \( \text{Menu} \), then \( \text{Setup} > \text{Security} \), to control some of the features of the printer.

- **USB drive**: Enable or disable the use of a USB flash drive.
- **Firmware upgrade from USB**: Enable or disable firmware updates from a USB flash drive.
- **Enable Internet connection**: Enable or disable the Internet connection.

  **NOTE**: If you disable it, you also disable automatic firmware upgrades and HP ePrint.

- **Printer access control**: Enable, disable, or change the administrator password.

  If an administrator password has been set, it must be given in order to perform the following operations:
  - Change the security settings (including the administrator password itself)
  - Change the configuration of the Internet connection
  - Change the Automatic Firmware Update configuration
  - Enable or disable automatic downloading and/or installation of automatic firmware updates
  - Restore an earlier firmware version
  - External hard disk options
  - Reset factory defaults

  **NOTE**: The administrator password can contain only characters that appear on the front panel's on-screen keyboard. If you set a new password with the Embedded Web Server, it will reject characters that do not appear in that limited character set.

Embedded Web Server security settings

From the Embedded Web Server, you can select the **Security** tab to control access to the printer in various ways:
Specify separate administrator and guest passwords to control access to the Embedded Web Server

Enable or disable Ethernet and USB connections to the printer

Enable or disable various groups of front panel operations

Use the same security settings that are available in the front panel (see above)

**NOTE:** An administrator password may be required.

**NOTE:** For more information, see the Embedded Web Server’s online help.

### Disable your HP ePrint connection

You can disable the connection to HP ePrint if required for security. At the front panel, press the [Connectivity] button, then [HP ePrint] > [HP ePrint settings] > [HP ePrint connectivity] and select [Disable].

**Disable** just puts the remote printing function on hold. If you want to resume using it, you just need to re-enable it in the same menu. No more setup steps are required at the HP Connected website.

If you want to disable remote printing permanently, select **Disable permanently**. To use remote printing again, you will need to set it up again from scratch (see *Set up your Web-connected printer on page 21*).

**NOTE:** You can prevent non-administrators from changing these options by setting an administrator password in the Embedded Web Server (**Setup > Security**).  

### Require account ID (T1300 series)

If you want to keep records of printer usage by different user accounts, you can set your printer to require an account ID for each job.

- In the HP Utility for Windows: select **Settings** > **Accounting** > **Require account ID**.
- In the HP Utility for Mac OS: select **Configuration** > **Printer Settings** > **Configure Printer Settings** > **Accounting** > **Require account ID**.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on hold for accounting".

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for accounting" by the printer, you can introduce the account ID in the HP Utility by going to the **Job Center** > **Job Queue** and clicking the job that is on hold. A window with a text box will be displayed and you can enter the account ID into it.

### Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to set color emulation or paper-saving options. To do this, press the **Start** button on your computer’s screen, then select **Printers and Faxes**. In the Printers and Faxes window, right-click on your printer’s icon, and select **Printing Preferences**. Any settings you change in the Printing Preferences window will be saved as default values.
4 Personalizing the printer

- Change the language of the front-panel display
- Access the HP Utility
- Access the Embedded Web Server
- Change the language of the HP Utility
- Change the language of the Embedded Web Server
- Change the sleep mode setting
- Turn the buzzer on and off
- Change the front-panel display brightness
- Change the units of measurement
- Configure network settings
- Change the graphic language setting
- Manage printer security
- Change your printer’s email address
Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages.

- If you can understand the current front-panel display language, press [ SETUP ], then [ FRONT PANEL OPTIONS ], then [ SELECT LANGUAGE ].

- If you cannot understand the current front-panel display language, start with the printer powered off. Press the [ POWER ] key to turn it on. When you see icons appear on the front panel, press [ SETUP ] and then [ FRONT PANEL OPTIONS ]. The front panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel display. Press your preferred language.

Access the HP Utility

The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP or Jetdirect connection.

- Under Windows, start the HP Utility from your desktop shortcut or from [ START ] > [ ALL PROGRAMS ] > [ HP ] > [ HP UTILITY ] > [ HP UTILITY ]. This launches the HP Utility, showing the printers installed on your computer.

- Under Mac OS, launch the HP Utility from your dock shortcut or by selecting [ STARTUP_DISK ] > [ LIBRARY ] > [ PRINTERS ] > [ hp ] > [ UTILITIES ] > [ HP UTILITY ]. This launches the HP Utility, showing the printers installed on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that printer.

If you have followed these instructions but failed to get through to the HP Utility, see Cannot access the HP Utility on page 164.

Access the Embedded Web Server

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web browser running on any computer.

To access the Embedded Web Server directly, you must have a TCP/IP connection to your printer. However, you can access the Embedded Web Server indirectly through the HP Utility, if you connect to your printer with a USB connection.

The following browsers are known to be compatible with the Embedded Web Server:

- Internet Explorer 6 for Windows XP, and later
- Safari 2 for Mac OS X 10.5, and later
- Firefox 2.0 and later
- Google Chrome 1.0 and later

The Adobe Flash plugin version 7 or later is recommended for viewing job previews.

To access the Embedded Web Server on any computer, open your Web browser and give the IP address of your printer.

You can see your printer’s IP address on the front panel by pressing [ SETUP ] and then [ FRONT PANEL OPTIONS ].

If you have followed these instructions but failed to get through to the Embedded Web Server, see Cannot access the Embedded Web Server on page 164.
Change the language of the HP Utility

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only), French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

- Under Windows, select Tools > Set Language and select a language from the list.
- Under Mac OS, the language is changed as for any other application. In System Preferences, select International and re-launch the application.

Change the language of the Embedded Web Server

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish, Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese. It uses whichever language you have specified in your Web browser’s options. If you have specified a language that it cannot support, it works in English.

To change the language, you must change your Web browser’s language setting. For example, in Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then ensure that the language you want is at the top of the list in the dialog box.

Change the sleep mode setting

If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep mode to save power. To change the time the printer waits before it goes into sleep mode, go to the front panel and press , then Setup > Front panel options > Sleep mode wait time. Select the wait time you want and then press OK; you can set the time from 1 to 240 minutes. The default time is 25 minutes.

Turn the buzzer on and off

To turn the printer’s buzzer on or off, go to the front panel and press , then Setup > Front panel options > Enable buzzer, and select on or off. By default, the buzzer is set to on.

Change the front-panel display brightness

To change the brightness of the front-panel display, press , then Setup > Front panel options > Select display brightness, and select a value you want. Press OK to set the value. The default brightness is set to 50.

Change the units of measurement

To change the units of measurement in the front-panel display, press , then Setup > Front panel options > Select units, and select English or Metric. By default the units are set to metric.

Configure network settings

You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front panel.

To do so with the Embedded Web Server, select the Setup tab, then Networking.

With the HP Utility under Windows, select the Settings tab, then Network Settings. Under Mac OS, select Configuration > Network Settings.
The following settings are available.

- **IP Configuration method**: Specify the way to set an IP address, selecting BOOTP, DHCP, Auto IP or Manual.
- **Host name**: Specify the IP name of the printer. The name may contain up to 32 ASCII characters.
- **IP address**: Specify the IP address of the printer. Duplicate IP addresses on a TCP/IP network will cause communication to fail.

**TIP**: Make sure that the combination of IP address, subnet mask and default gateway is valid. If these three fields are inconsistent, you may not be able to connect to the printer at all until you fix the problem from the front panel.

**TIP**: If you change the current IP address and click *Apply*, the browser loses the current connection to the printer because it is pointing to the old address. To reconnect, browse to the new IP address.

- **Subnet mask**: Specify a subnet mask, which determines which bits specify the network and which bits uniquely specify the node within the network.
- **Default gateway**: Specify the IP address of a router or computer that is used to connect to other networks or sub-networks. If none exist, use the IP address of the computer or the IP address of the printer.
- **Domain name**: Specify the name of the DNS domain in which the printer resides (for example, support.hp.com).

**NOTE**: The domain name does not include the host name: it is not the fully qualified domain name, such as printer1.support.hp.com.

- **Idle timeout**: Specify the time that an idle connection is allowed to remain open when a remote computer is waiting for the printer. The default value is 280 seconds. If set to zero, the timeout is disabled and the connection is allowed to remain open indefinitely.
- **Default IP**: Specify the IP address to use when the printer is unable to obtain an IP address from the network when powered on or when reconfigured to use BOOTP or DHCP.
- **Send DHCP requests**: Specify whether DHCP requests are transmitted when a legacy default IP address or a default Auto IP is assigned.

To configure the same network settings from the front panel, press `}`, then `}`, then `Connectivity > Network connectivity > Fast/Gigabit Ethernet > Modify configuration`.

You have various other options available from the `Connectivity > Network connectivity > Advanced` menu.

- **I/O timeout**: Specify the time that an idle connection is allowed to remain open when the printer is waiting for a remote computer. The default value is 30 seconds. If set to zero, the timeout is disabled and the connection is allowed to remain open indefinitely.
- **Allow SNMP**: Specify whether SNMP is permitted.
- **Embedded Web Server > Allow EWS**: Specify whether the Embedded Web Server is enabled.
- **Web Services > HP Utility software**: View the HP Utility software settings.
- **Web Services > Color and paper management**: View the color and paper management settings.
- **Restore factory settings**: restore the initial default values of the network settings.

### Change the graphic language setting

You can change the graphic language setting from the HP Utility with the following steps.
1. Under Windows, select the Settings tab then Printer settings > Printing preferences.

Under Mac OS, select Configuration then Printer settings > Configure printer settings > Printing preferences.

2. Select one of the following options.

- Select Automatic to let the printer determine which type of file it is receiving. This is the default setting; it works for most software applications. You should not normally need to change it.
- Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going through a printer driver.
- Select PDF only if you are sending a file of that type directly to the printer, without going through a printer driver (PostScript printers only).
- Select PostScript only if you are sending a file of that type directly to the printer, without going through a printer driver (PostScript printers only).
- Select TIFF only if you are sending a file of that type directly to the printer, without going through a printer driver (PostScript printers only).
- Select JPEG only if you are sending a file of that type directly to the printer, without going through a printer driver (PostScript printers only).

You can change the graphic language setting from the front panel. Press , then , then Setup > Printing preferences > Graphics language. Select the desired option.

NOTE: If the graphic language is set from the HP Utility, it overrides the front panel setting.

Manage printer security

When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your printer’s email address can print to your printer by just sending a file to it. Although HP provides a spam filtering service, you should be careful about giving out your printer’s email address, as everything sent to that address may be printed on your printer.

If you are the printer administrator, you can manage printer security or change your printer status to lock mode by visiting HP Connected at http://www.hpconnected.com (availability varies by product, country, and region). You can also customize your printer’s e-mail address and manage print jobs from there. On your first visit, you will need to create an HP Connected account.

Change your printer’s email address

You can change your printer’s email address at HP Connected: (availability varies by product, country, and region).
5 Paper handling

- General advice
- Load a roll onto the spindle
- Load a roll into the printer
- Unload a roll
- Load a single sheet
- Unload a single sheet
- View information about the paper
- Paper presets
- Printing paper info
- Move the paper
- Maintain paper
- Change the drying time
- Turn the automatic cutter on and off
- Feed and cut the paper
General advice

⚠️ **CAUTION:** Before starting a paper loading process, ensure you have enough room around the printer, both in front and behind.

⚠️ **CAUTION:** Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

⚠️ **CAUTION:** All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in landscape orientation.

🌟 **TIP:** For photo paper wear cotton gloves to avoid transferring oils onto the paper.

⚠️ **CAUTION:** Keep the basket closed throughout the loading process.

Load a roll onto the spindle

1. Open the roll cover.
2. Remove the black end of the spindle from the printer, then the blue end.

⚠️ **CAUTION:** Be sure to remove the black end first. Removing the blue end first could damage the black end.

⚠️ **WARNING!** Do not insert your fingers into the spindle supports during the removal process.

3. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from the end of the spindle.

4. If the roll is long; rest the spindle horizontally on a table and load the roll on the table.

💡 **TIP:** You may need two people to handle a large roll.
5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing the correct orientation.

**NOTE:** From the back of the printer, the blue stopper is inserted into the right-side holder.

![Image of roll orientation]

Ensure both ends of the roll are as close to the spindle stops as possible.

6. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

7. Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of different paper types on different spindles. Extra spindles are available for purchase, see **Accessories on page 119**.

---

**Load a roll into the printer**

To start this procedure, you must have a roll loaded on the spindle. See **Load a roll onto the spindle on page 33**.

**TIP:** If you have a T1300 series printer, do not try to open both roll covers at once; this may cause problems. Always close one cover before opening the other.

**NOTE:** The first three steps below are optional: you can start with step 4. However, in this case the printer will not keep track of the length of the roll, and will print no barcode on the roll when it is next unloaded. So you are recommended to follow all the steps, starting with step 1, unless you have turned off the **Printing paper info** option. See **Printing paper info on page 41**.

1. From the front panel, press ☐ then the roll icon, then **Load**.

   Alternatively, press ☐ then ☐ then **Paper > Paper load > Load roll 1** or **Load roll 2**.

   If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.
You should stand behind the printer when loading the lower roll (roll 2). You may stand behind or in front of the printer when loading the upper roll (roll 1).

⚠️ **CAUTION:** If your height is less than 1.6 m (5 ft 3 in), loading a roll while standing in front of the printer may cause back pain or other physical problems.

2. In the T1300 series only, if you start to load roll 1 while roll 2 is already loaded, roll 2 is withdrawn to the standby position, so that it can be printed on again without reloading whenever required.

⚠️ **NOTE:** If at any time you open a roll cover while that roll is in the standby position, the roll will be automatically unloaded, and you will have to reload it the next time you want to print on it.

3. Open the roll cover, if it is not already open.

4. Rest the spindle's black end on the left side roll holder. Do not put the end completely into the roll holder.

5. Rest the blue end of the spindle on the right side roll holder.

6. With both hands, push the spindle into both roll holders at the same time.

7. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the paper slightly and cut a straight edge.
8. Insert the edge of the paper into the printer.

⚠️ WARNING! Do not push your fingers inside the printer's paper path.

💡 TIP: When loading the upper roll, avoid inserting roll paper into the cut-sheet slot. If you do so, the printer beeps and the front panel asks you to remove the paper.

9. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer detects the paper, it feeds it in automatically.

10. If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode; you should remove and discard the cut strip of paper.

11. If the leading edge of the paper has no barcode, the front panel prompts you to select the paper category and type.

💡 TIP: If you have loaded a paper type whose name does not appear in the paper list, see The paper type is not in the driver on page 130.
12. If the **Printing paper info** option is enabled, the front panel may ask you to specify the length of the roll. See [Printing paper info on page 41](#).

13. The printer checks the alignment and measures the width, then the front panel prompts you to close the roll cover.

   If the roll is not correctly aligned, follow the instructions on the front-panel display.

   **NOTE:** If you have an unexpected issue at any stage of the paper loading process, see [The paper cannot be loaded successfully on page 129](#).

---

## Unload a roll

Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow the appropriate procedure as described below.

### Quick procedure with paper on the roll

If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically.

   **NOTE:** When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know the length of the roll when it is next loaded. See [Printing paper info on page 41](#).

   **NOTE:** If you open the cover of roll 1 while a sheet is loaded, the sheet is also unloaded.

### Front panel procedure with paper on the roll

If there is paper on the roll, you can unload it from the front panel.

1. Press \[\text{ }\] then the roll icon, then **Unload**.

   Alternatively, press \[\text{ }\] then \[\text{ }\] then **Paper > Paper unload > Unload roll 1** or **Unload roll 2**.

2. You may need to open the roll cover.

### Roll out of paper procedure

If the end of the paper is no longer attached to the core, use the following procedure.

1. If you have already started the unload process, press \[\text{ }\] on the front panel to cancel that procedure.

2. Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.

3. Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the printer is recommended. You may need to open the roll cover.

4. Lower the blue lever.

---

## Load a single sheet

1. When using a T1300 series printer, ensure that the cover of roll 1 is closed. If it is opened while a sheet is loaded, the sheet will be immediately unloaded.

2. At the front panel, press \[\text{ }\] then the roll 1 icon, then **Load > Load sheet**.

   Alternatively, press \[\text{ }\] then \[\text{ }\] then **Paper > Paper load > Load sheet**.
3. If a roll is already loaded, you have to wait while it is automatically unloaded. In the T1300 series only, the roll is not unloaded, but withdrawn to the standby position, so that it can be printed on again without reloading as soon as the sheet paper has been unloaded.

**NOTE:** If at any time you open a roll cover while that roll is in the standby position, the roll will be automatically unloaded, and you will have to reload it the next time you want to print on it (T1300 series only).

4. Select your paper category and type.

**TIP:** If you have loaded a paper type whose name does not appear in the paper list, see The paper type is not in the driver on page 130.

5. When prompted by the front panel, insert the sheet into the cut-sheet slot on the right side of the printer.

Load your sheet aligned with the load line and insert until the paper will not continue; with thicker sheets, you feel resistance.

**WARNING!** Do not push your fingers inside the printer’s paper path.

6. Press the OK key on the front panel to feed the paper into the printer. Guide the sheet into the printer; this is especially important with thicker papers.

7. The printer checks the alignment and measures the sheet.

**NOTE:** Depending on the length of the sheet, it feeds out the front of the printer.

8. If the length of the sheet is more than 600 mm (23 in), the front panel prompts you to check that the rear of the sheet is hanging backwards over the roll cover (and not forwards over the printer window).

9. If the sheet is not correctly aligned, you may be asked to correct the alignment. Please follow the instructions on the front-panel display.

**NOTE:** If you have an unexpected problem at any stage of the paper loading process, see The paper cannot be loaded successfully on page 129.
Unload a single sheet

To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.

To unload a sheet without printing, go to the front panel and press \[\text{ }\] then the roll 1 icon, then Unload > Unload sheet.

Alternatively, press \[\text{ }\] then \[\text{ }\] then Paper > Paper unload > Unload sheet.

The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the basket.

View information about the paper

To view the loaded paper information, press \[\text{ }\] then the roll icon.

The following information is displayed on the front panel:

- Paper type you have selected
- Roll or sheet status
- Width of the paper in millimeters (estimated)
- Length of the paper in millimeters (estimated)

If no paper is loaded, the message Out of paper is displayed.

The same information is displayed in the HP Utility for Windows (Overview tab > Supplies Status tab), the HP Utility for Mac OS (Information group > Printer Status > Supplies Details) and the Embedded Web Server (upper-right corner).

Paper presets

Each supported paper type has its own characteristics. For optimum print quality, the printer changes the way it prints on each different paper type. For example, some may need more ink and some may require a longer drying time. So the printer must be given a description of the requirements of each paper type. This description is called the paper preset. The paper preset contains the ICC profile, which describes the color characteristics of the paper; it also contains information on other characteristics and requirements of the paper that are not directly related to color. Existing paper presets for your printer are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer only contains paper presets for the most commonly used paper types. If you have a paper type for which your printer has no preset, you cannot select that paper type in the front-panel display.

There are two ways to assign a preset for a new paper type.

- Use an HP factory paper preset by selecting the closest category and type in the front panel or the HP Utility, see The paper type is not in the driver on page 130.

  \[\text{NOTE: }\] Colors may not be accurate. This method is not recommended for high-quality prints.


  \[\text{NOTE: }\] HP provides presets for HP paper types only. If you do not find the paper preset you want on the Web, you may find that it has been added to the latest firmware for your printer. You can check the firmware release notes for information, see Update the firmware on page 117.
Printing paper info

Enable the **Printing paper info** option to record the printer's estimate of the remaining roll length, paper width and type. The information is a combination of barcode and text that is printed on the leading edge of the roll when the paper is unloaded from the printer.

![Barcode](image)

**NOTE:** The paper-length estimate is available only if the printer registered the amount of paper that was on the roll when you loaded it. To provide this information to the printer, specify the roll length on the front panel when loading the paper, or load a roll that has the paper-data barcode printed on it.

**NOTE:** The barcode and text are printed on the roll only when the loading and unloading processes are started from the front panel's Paper menu.

**NOTE:** This option can be expected to work only with papers that are completely opaque. It may fail with transparent or translucent papers.

To enable the **Printing paper info** option, go to the front panel and press ![Menu button] then ![Settings button] then **Setup > Printing preferences > Paper options > Enable printing paper info**.

**NOTE:** Enabling this option slightly changes the paper loading and unloading procedures.

Move the paper

If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. You may want to do this in order to have more or less white space between the last print and the next one.

To move the paper, press ![Menu button] then ![Settings button] then **Paper > Move paper**.

Maintain paper

To maintain paper quality, follow the recommendations below.

- Store rolls covered by another piece of paper or cloth
- Store cut sheets covered and clean or brush them before loading them in the printer
- Clean input and output platens
- Always keep the window of your printer closed

**NOTE:** Photo and coated paper requires careful handling, see The print is scuffed or scratched on page 147.

Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints where time is of higher importance or when you need to be sure ink is dry before handling.

Press ![Menu button] then ![Settings button] then **Setup > Print retrieval > Select drying time**. You can select:

- **Extended**, to set a longer than recommended time to ensure ink is completely dry
- **Optimal**, to set the default and recommended time for your selected paper (this is the default setting)
- **Reduced**, to set a shorter than recommended time when quality is of lower importance
- **None**, to disable the drying time and remove your print as soon as it finishes printing

⚠️ **CAUTION:** If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the print.

ℹ️ **NOTE:** If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the paper until after the printhead maintenance has completed.

### Turn the automatic cutter on and off

To turn the printer’s paper cutter on or off:

- From the HP Utility for Windows, select the **Settings** tab and change the **Cutter** option in **Printer Settings > Advanced**.
- From the HP Utility for Mac OS, select **Configuration > Printer Settings > Advanced** and change the **Cutter** option.
- From the Embedded Web Server, select the **Setup** tab, then **Printer Settings > Advanced**, and change the **Cutter** option.
- From the front panel, press , then , then **Setup > Print retrieval > Enable cutter** and change the cutter option.

The default setting is **On**.

ℹ️ **NOTE:** If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on loading, unloading and switching between rolls.

💡 **TIP:** To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper on page 42.

### Feed and cut the paper

If you go to the front panel and press , then , then **Paper > Form feed and cut**, the printer advances the paper and makes a straight cut across the front edge. There are several possible reasons why you might want to do this.

- To trim the leading edge of the paper if it is damaged or not straight.
- To feed and cut the paper when the automatic cutter has been disabled.
- To cancel the waiting time and print the available pages immediately, if the printer is waiting to nest more pages (T1300 series only).

ℹ️ **NOTE:** The printheads are serviced after each print, and the paper cannot be cut until the process completes, so you may notice a delay.

⚠️ **CAUTION:** Remove the cut piece from the output tray. If strips or short prints are left in the output tray the printer could jam.
**NOTE:** Photo and coated paper requires careful handling, see [The print is scuffed or scratched on page 147](#).

**TIP:** To move the paper without cutting it, see [Move the paper on page 41](#).
The uses of a multiroll printer

A multiroll printer can be useful in several different ways:

- The printer can automatically switch between different paper types according to your needs.
- The printer can automatically switch between different paper widths according to your needs. This enables you to save paper by printing smaller images on narrower paper.
- If you load two identical rolls into the printer, you can leave it printing unattended for a long time, because it can switch from one roll to the other automatically when the first is exhausted. See Unattended printing/overnight printing (T1300 series) on page 59.

When working with multiple rolls, bear in mind that a protected roll is protected from use unless the roll number or its paper type are specifically requested. See Roll protection (T1300 series) on page 59.

The current status of both rolls is shown on the front panel if you press .

**NOTE:** When you print from a USB flash drive, multiroll printing is considerably simplified: either you specify manually which roll you want to use, or you can select Save paper, in which case the printer chooses the narrowest roll on which the print will fit. You cannot specify the paper type.

How the printer allocates jobs to paper rolls

When you submit a print job from the Embedded Web Server or the printer driver, you can specify (using the Paper type or Type is option) that you want it to be printed on a particular paper type; you can even specify (using the Paper source, Source is or Paper Feed option) that you want it to be printed on a particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also look for a paper roll large enough to print the image without clipping.

- If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy. See Roll switching options on page 23.
- If just one of the rolls is suitable for the job, it will be printed on that roll.
- If neither roll is suitable for the job, it will be held in the job queue with the status “On hold for paper”, or printed on an unsuitable roll, depending on the paper mismatch action. See Paper mismatch action on page 22.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the printer, and on which rolls.

Here are some settings that may be used in typical situations.
NOTE: The **Type** is and **Source** is settings are in the printer driver and the Embedded Web Server; the **Roll switching policy** is set in the front panel.

- With different paper types loaded:
  - **Type is**: select the paper type you require
  - **Source is**: Automatically select / Predetermined
  - **Roll switching policy**: doesn't matter

- With different paper widths loaded:
  - **Type is**: Any
  - **Source is**: Automatically select / Predetermined
  - **Roll switching policy**: Minimize paper waste

**TIP:** You can also save paper in some cases by rotating or nesting your images. See [Use paper economically on page 57](#).

- With identical rolls loaded:
  - **Type is**: Any
  - **Source is**: Automatically select / Predetermined
  - **Roll switching policy**: Minimize roll changes
7 Printing

- Introduction
- Print from a USB flash drive
- Print from a computer using the Embedded Web Server or HP Utility (T1300 series)
- Print from a computer using a printer driver
- Advanced print settings
Introduction

There are five different ways in which you can choose to print, depending on your circumstances and preferences.

- Print a TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript file directly from a USB flash drive. See Print from a USB flash drive on page 47.
- Print a file that is already in the job queue. See Reprint a job from the queue on page 64.
- Print a TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript file directly from a computer connected to the printer, using the Embedded Web Server or the HP Utility. See Print from a computer using the Embedded Web Server or HP Utility (T1300 series) on page 48.
- Print any kind of file from a computer connected to the printer by network or USB cable, using a software application that can open the file, and a printer driver supplied with your printer. See Print from a computer using a printer driver on page 49.

**NOTE:** To print PDF or PostScript files, a PostScript printer is required.

Print from a USB flash drive

1. Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript files into one of the printer’s USB ports.

   **NOTE:** To print PDF or PostScript files, a PostScript printer is required.

   **NOTE:** The use of USB flash drives with your printer may be disabled by the administrator: see Control access to the printer on page 25.

2. At the front panel, go to the home screen and press the home button.

3. Select the file to be printed. Files that can be printed are indicated with □; files that cannot be printed are indicated with X. You can press folders to browse their contents.

4. The default print settings are displayed. If you want to change them, press Settings. The following settings are available:

   - **Size** allows you to resize the print in two different ways: to a percentage of its original size, or to fit a particular paper size. The default is 100% (its original size).
   - **Color** allows you to choose color or grayscale printing.
   - **Print quality** allows you to set the print quality to Best, Normal or Fast.
   - **Roll** allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which automatically chooses the narrowest roll on which the print will fit.
   - **Rotation** allows you to rotate the print by any multiple of 90°, or you can choose Automatic, which rotates the print automatically if that will save paper.

   **NOTE:** If you change the settings in this way, the changed settings apply to the current job but are not saved permanently. You can change the default settings by pressing the home button, then the print mode button, then Print from USB preferences.

5. To display a preview of the printed job on the front panel, press the preview button.

   When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.
6. When you are satisfied with the print settings, press **Start**.

7. If two rolls are loaded, you can choose to print on either roll, or you can let the printer choose automatically.

   **NOTE:** The printer will automatically rotate the image by 90° if it can save paper by doing so.

8. After printing, you can choose to print another file or go to the job queue. If you print another file immediately without returning to the home screen, the temporary settings used for the previous file are used again.

### Print from a computer using the Embedded Web Server or HP Utility (T1300 series)

You can print files in this way from any computer that can access the printer’s Embedded Web Server. See [Access the Embedded Web Server on page 28](#).

From the Embedded Web Server, select the **Main** tab and then **Submit job**. From the HP Utility, select **Job Center > Submit Job**. You will see the window below.

Press the **Add files** button to choose the files from your computer that you want to print. The files must be in one of the following formats:

- HP-GL/2
- RTL
- TIFF
- JPEG
- PDF (PostScript printers only)
- PostScript (PostScript printers only)

   **NOTE:** When you print to a file, the file should be in one of the above formats, but its name may have an extension such as *.plt* or *.prn*.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and number of copies), you can just press the **Print** button and they will be sent to the printer.
If you need to specify printing settings, go to the Job settings section and select the options you need. Each option has explanatory text on the right, so that you can understand the behavior of each setting. Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job contains no setting, the setting in the printer will be used.

If you have chosen some non-default settings and expect to reuse the same group of settings in the future, you can save them all under a single name from the Manage presets tab, and recall them using that name later.

Print from a computer using a printer driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the computer (see Installing the software on page 12), and the computer must be connected to the printer by network or USB cable.

When the printer driver has been installed and the computer is connected to the printer, you can print from a software application by using the application’s own Print command and selecting the correct printer.

Advanced print settings

The rest of this chapter explains the various print settings that you can use when printing with a printer driver, the Embedded Web Server or the HP Utility. These methods offer a relatively large number of settings in order to satisfy all requirements.

**Tip:** In general you are recommended to use the default settings unless you know that they do not meet your requirements.

**Tip:** If you intend to reuse a particular group of settings repeatedly, you can save those settings under a name of your own choice and recall them later. A saved group of settings is known as a ‘quick set’ in the Windows printer driver, and as a ‘preset’ in the Embedded Web Server.

Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you can also select Economode, which uses a lower rendering resolution and consumes less ink. It therefore increases printing speed even further, but reduces print quality. Economode can be selected only from the custom options (not from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum detail. See High-quality printing on page 55.

**Note:** In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print Quality Options dialog box (select Custom options and then Settings). In the Mac OS Print dialog, it is displayed in the Summary panel.

You can select print-quality options in the following ways:
In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. If you select Standard Options, you will see a simple slider with which you can select speed or quality. If you select Custom Options, you will see the more specific options described above.

In the Mac OS Print dialog (non-PostScript printers): go to the Paper/Quality panel and look at the Quality Options section. If you select Standard quality options, you will see a simple slider with which you can select speed or quality. If you select Custom quality options, you will see the more specific options described above.

In the Mac OS PostScript Print dialog (PostScript printers): go to the Paper/Quality panel and look at the Quality Options section. If you select Standard quality options, you will see a simple slider with which you can select speed or quality. If you select Custom quality options, you will see the more specific options described above.

On the Embedded Web Server's Submit Job page (T1300 series): select Basic settings > Print quality. If you then select Standard options, you can choose between Speed and Quality. If you select Custom options, you will see the more specific options described above.

Using the front panel: press  then  then Setup > Printing preferences > Print quality.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has already received (even if they have not started to print yet).

Select paper size

The paper size can be specified in the following ways.

NOTE: The paper size specified here should be the paper size in which the document was created. It is possible to rescale the document to a different size for printing. See Rescale a print on page 53.

- In the Windows driver dialog: select the Paper/Quality tab, then select your paper size from the Document Size list.
- In the Mac OS Page Setup dialog: select your printer from the Format for list, then select your paper size from the Paper Size list.

NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

- Using the front panel: press  then  then Setup > Printing preferences > Paper options > Select paper size.

NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front panel.

Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various different ways to specify it.

Use the Windows printer driver

1. Select the Paper/Quality tab.
2. Press the Custom button.
3. Enter the name and dimensions of your new paper size.
4. Press **OK**. The new paper size is automatically selected.

A custom paper size created in this way has the following characteristics:

- The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.
- The paper size is local to the printer queue. It will not be seen from other printer queues in the same computer.
- In Domain server networks, the paper size is local to the computer. It will not be seen from other computers sharing the printer queue.
- In Workgroup networks, the paper size will be shared among all the computers sharing the printer queue.
- If the printer queue is deleted, the paper size is deleted with it.

**Use Windows forms**

1. From the Start menu, or from the Control Panel, select **Printers and Faxes**.
2. From the **File** menu, select **Server Properties**.
3. In the **Forms** tab, check the **Create a new form** box.
4. Enter the name and dimensions of your new paper size. Leave the margins as 0.00.
5. Press the **Save Form** button.
6. Go to the printer driver, and select the **Paper/Quality** tab.
7. Select **More...** from the drop-down list of paper sizes.
8. Select your new paper size from the group of Custom sizes.

A custom paper size created in this way has the following characteristics:

- The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.
- Restricted users cannot create paper forms. The “manage documents” role in the Windows Active Directory is the minimum required.
- The paper size is local to the computer. It will be seen in all the printer queues that have been created on the computer and that support paper of that size.
- If a printer queue is shared, this paper size will appear in all the client computers.
- If a printer queue is shared from another computer, this paper size will not appear on the driver’s document size list. A Windows form in a shared queue needs to be created in the server.
- If the printer queue is deleted, the paper size is not deleted.

**Use the Mac OS printer driver**

1. Go to the **Page Setup** dialog.

   **NOTE:** If your application offers no **Page Setup** dialog, please use the **Print** dialog.

2. Select **Paper Size > Manage Custom Sizes**.
Use the Embedded Web Server (T1300 series only)

1. Go to the Submit Job page.

Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper (increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in several ways.

- **In the Windows driver dialog:** select the Paper/Quality tab and then the Margins/Layout button.
- **In the Mac OS Print dialog (non-PostScript printers):** select the Margins/Layout panel.
- **In the Mac OS PostScript Print dialog (PostScript printers):** select the Margins/Layout panel.
- **On the Embedded Web Server's Submit Job page (T1300 series):** select Advanced settings > Paper > Layout/Margins.

You will then see at least some of the following options.

**NOTE:** Under Mac OS, the available margins options depend on the paper size selected. For instance, for borderless printing you must select a paper size name that includes the words "no margins".

- **Standard.** Your image will be printed on a page of the size you have selected, with a narrow margin between the edges of the image and the edges of the paper. The image should be small enough to fit between the margins.
- **Oversize.** Your image will be printed on a page slightly larger than the size you have selected. If you cut off the margins, you will be left with a page of the size you selected, with no margins remaining between your image and the edges of the paper.
- **Clip Contents By Margins.** Your image will be printed on a page of the size you have selected, with a narrow margin between the edges of the image and the edges of the paper. In this case, if the image is the same size as the page, the printer assumes that the extreme edges of the image are either white or unimportant, and do not need to be printed. This may be useful when your image already contains a border.
- **Borderless (T1300 series only).** Your image will be printed on a page of the size you have selected, with no margins. The image is slightly enlarged to ensure that no margin is left between the edges of the image and the edges of the paper. If you select Automatically by Printer, this enlargement is done automatically. If you select Manually in Application, you must select a custom page size slightly larger than the page on which you intend to print. See also Print with no margins (T1300 series) on page 56.

Print on loaded paper

To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your printer driver.

- **In the Windows driver dialog:** select the Paper/Quality tab, then select Any in the Paper Type drop-down list.
- **In the Mac OS Print dialog (non-PostScript printers):** select the Paper/Quality panel, then select Any in the Paper Type drop-down list.
- **In the Mac OS PostScript Print dialog (PostScript printers):** select the Paper/Quality panel, then select Any in the Paper Type drop-down list.

**NOTE:** Any is the default Paper Type selection.
Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally larger). This may be useful:

- If your software does not support large formats
- If your file is too large for the printer's memory—in this case, you can reduce the paper size in your software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

- **In the Windows driver dialog:** go to the **Features** tab and look at the Resizing Options section.
  - The **Print document on** option adjusts the image size to the paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.
  - The **% of actual size** option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size.

- **In the Mac OS Print dialog (non-PostScript printers):** select the **Paper Handling** panel, then **Scale to fit paper size**, and select the paper size to which you want to scale the image. If you want to increase the size of the image, make sure that the **Scale down only** box is unchecked.

- **In the Mac OS Print dialog (PostScript printers):** select the **Finishing** panel, then **Print document on**, and select the paper size to which you want to scale the image. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.

- **On the Embedded Web Server's Submit Job page (T1300 series):** select **Advanced settings > Resizing**.
  - The **Standard** and **Custom** options adjust the image size to the standard or custom paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A4-size image, it is enlarged to fit the A2 paper. If the ISO A3 paper size is selected, the printer reduces a larger image to fit the A3 size.
  - The **% of actual size** option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size.

- **Using the front panel:** press 
  then 
  then **Setup > Printing preferences > Paper options > Resize**.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise the image will be clipped.

Change the treatment of overlapping lines

**NOTE:** This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:

- **Off:** where the lines cross, only the color of the top line is printed. This is the default setting.
- **On:** where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and press 
  then 
  then **Setup > Printing preferences > HP-GL/2 options > Enable merge**. You can set the merge option from your software in some applications. Settings in your software override the front-panel settings.
Preview a print

Previewing a print on the screen allows you to check the layout of the print before printing, which may help you to avoid wasting paper and ink on a bad print.

- To preview a print under Windows, you have the following options:
  - Use your application’s print preview option.
  - Check the **Show preview before printing** option (for the T1300 series only), which you can find in the driver’s Paper/Quality tab and Features tab. The preview may be provided in different ways, depending on your printer and printer driver.

- To preview a print under Mac OS, you have the following options:
  - Use your application’s print preview option.
  - Click the **Preview** button at the bottom of the Print dialog box. This is the basic print preview provided by Mac OS.
  - If you are using the PostScript driver for the T1300 PS printer, check the **Show print preview** option, which you can find in the driver’s Printing dialog, in the Finishing panel. This preview is provided by the Embedded Web Server and will appear in a Web browser window.

  **NOTE:** This option does not work if the printer is connected by USB cable to a different computer (printer sharing).

  - If you are using the PCL driver for the T790 or T1300 series, check the **Show print preview** option, which you can find in the driver’s Printing dialog, in the Finishing panel. This opens the HP Print Preview application, with more features, such as the ability to change paper size, paper type and print quality, and to rotate the image.

  **NOTE:** This option does not work if the printer is connected by USB cable to a different computer (printer sharing).

- To preview a print using the Embedded Web Server for the T1300 series, select **Basic settings > Hold for preview**.

Print a draft

You can specify fast draft-quality printing in the following ways:

- In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move the print-quality slider to the extreme left (‘Speed’).

- In the Mac OS Print dialog (non-PostScript printers): go to the Paper/Quality panel and move the print-quality slider to the extreme left (‘Speed’).

- In the Mac OS PostScript Print dialog (PostScript printers): go to the Paper/Quality panel and move the print-quality slider to the extreme left (‘Speed’).

- On the Embedded Web Server’s Submit Job page (T1300 series): select **Basic settings > Print quality > Standard options > Speed**.

- Using the front panel: press then Setup > Printing preferences > Print quality > Select quality level > Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for documents containing only text and line drawings.
● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Select Custom Options, then set the quality level to Fast and check the Economode box.

● In the Mac OS Print dialog (non-PostScript printers): go to the Paper/Quality panel and set the quality options to Custom, then set quality to Fast and check the Economode box.

● In the Mac OS PostScript Print dialog (PostScript printers): go to the Paper/Quality panel and set the quality options to Custom, then set quality to Fast and check the Economode box.

● On the Embedded Web Server's Submit Job page (T1300 series): select Basic settings > Print quality > Custom. Set Quality level to Fast, and Economode to On.

● Using the front panel: press [Setup], then [Setup], then Setup > Printing preferences > Print quality > Enable economode.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

High-quality printing
You can specify high-quality printing in the following ways:

● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move the print-quality slider to the extreme right (‘Quality’).

● In the Mac OS Print dialog (non-PostScript printers): go to the Paper/Quality panel and move the print-quality slider to the extreme right (‘Quality’).

● In the Mac OS PostScript Print dialog (PostScript printers): go to the Paper/Quality panel and move the print-quality slider to the extreme right (‘Quality’).


● Using the front panel: press [Setup], then [Setup], then Setup > Printing preferences > Print quality > Select quality level > Best.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

If you have a high-resolution image
If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print Quality Options box under Windows), print sharpness may be improved by selecting the Maximum Detail option. This option is available only if you are printing on glossy paper and you have selected Best print quality.

● In the driver dialog (Mac OS Print dialog): select Custom instead of Standard print-quality options, then check the Maximum Detail box.


● Using the front panel: press [Setup], then [Setup], then Setup > Printing preferences > Print quality > Enable maximum detail.

NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase the amount of ink used.

Print in gray shades
You can convert all colors in your image to shades of gray: see Printing in grayscale on page 73.
Print with no margins (T1300 series)

Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done only on rolls of glossy paper.

In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink deposited outside the paper is absorbed by the sponge situated in the platen.

You can request printing with no margins in the following ways:

- **In the Windows driver dialog**: select the Paper/Quality tab and press the Margins/Layout button. Then select Borderless.

- **In the Mac OS Page Setup dialog (T1300)**: select a paper size name that includes the words “no margins”. Then, in the Print dialog, select Margins/Layout > Borderless.

  **NOTE**: If your application offers no Page Setup dialog, please use the Print dialog.

- **In the Mac OS PostScript Page Setup dialog (T1300 PS)**: select a paper size name that includes the words “no margins”. Then, in the Print dialog, select Margins/Layout > Borderless.

  **NOTE**: If your application offers no Page Setup dialog, please use the Print dialog.

- **On the Embedded Web Server's Submit Job page**: select Advanced settings > Paper > LayoutMargins > Borderless.

When you select Borderless, you must also select one of the following Image Enlargement options:

- **Automatically by printer** means that the printer automatically enlarges your image slightly (normally by a few millimeters in each direction) in order to print over the edges of the paper.

- **Manually in application** means that you must enlarge the image yourself in your application, and select a custom paper size that is slightly larger than the actual paper size.

  **NOTE**: If the first print job after loading paper is a borderless job, the printer may trim the leading edge of the paper before printing.

At the end of a borderless print, the printer normally cuts the print slightly inside the image area to ensure that the print is borderless. It then cuts the paper again so that no residual part of the image is included in the next print. However, if the job is cancelled, or if there is white space at the bottom of the image, only a single cut is made.

Print with crop lines (T1300 series)

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop lines with individual jobs in the following ways:

- **In the Windows driver dialog**: select the Features tab, then Crop lines.

- **In the Mac OS Print dialog**: select the Finishing panel, then Crop lines.

- **On the Embedded Web Server's Submit Job page**: select Advanced settings > Roll options > Enable crop lines > Yes.

Alternatively, you can choose to print crop lines with all jobs by default:

- **In the Embedded Web Server**: select Setup > Printer settings > Job management > Use crop lines when printing > On.

- **Using the front panel**: press , then , then Setup > Printing preferences > Paper > Enable crop lines > On.
To print crop lines with nested jobs (see Nest jobs to save roll paper (T1300 series) on page 57), you must select a different option:

- In the Embedded Web Server: select Setup > Printer settings > Job management > Use crop lines when nest is enabled > On.
- Using the front panel: press \[\text{Hold} \], then \[\text{Setup} \] > Job management > Nest options > Enable crop lines > On.

**Use paper economically**

Here are some recommendations for making economical use of paper:

- If you are printing relatively small images or document pages, you can use nesting to print them side by side instead of one after another. See Nest jobs to save roll paper (T1300 series) on page 57.
- You may be able to save some roll paper by using the following options:
  - In the Windows driver dialog: select the Features tab and then Remove top/bottom blank areas and/or Rotate by 90 degrees or Autorotate.
  - In the Mac OS Print dialog (non-PostScript printers): select the Finishing panel, then Remove Top/Bottom Blank Areas.
  - In the Mac OS PostScript Print dialog (PostScript printers): select the Finishing panel, then Remove Top/Bottom Blank Areas and/or Rotate by 90 degrees.
  - On the Embedded Web Server's Submit Job page (T1300 series): select Advanced settings > Roll options > Remove top/bottom blank areas and/or Rotate.
- If you check the print preview on your computer before printing, you can sometimes avoid wasting paper on prints containing obvious mistakes. See Preview a print on page 54.

**Nest jobs to save roll paper (T1300 series)**

Nesting means automatically printing images or document pages side by side on the paper, rather than one after the other. This is done to avoid wasting paper.

1. Direction of paper flow
2. Nesting off
3. Nesting on
4. Paper saved by nesting

**When does the printer try to nest pages?**

When both of the following are true:
- The printer is loaded with roll paper, not sheet paper.
- The printer's Nest option is turned on. See Turn nesting on and off (T1300 series) on page 23.

What pages can be nested?

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot be split between two rolls.

Which pages qualify for nesting?

In order to be in the same nest, the individual pages must be compatible in all of the following ways:

- All pages must have the same print quality setting (Economode, Fast, Normal or Best).
- The Maximum Detail setting must be the same on all pages.
- The Layout/Margins setting must be the same for all pages.
- The Mirror Image setting must be the same for all pages.
- The Rendering Intent setting must be the same for all pages.
- The Cutter setting must be the same for all pages.
- The color adjustment settings must be the same for all pages. See Color adjustment options on page 73.
- Pages must be all color, or all grayscale: not some in color and some in grayscale.
- All pages must be in one or other of the following two groups (the two groups cannot be mixed in the same nest):
  - HP-GL/2, RTL, TIFF, JPEG
  - PostScript, PDF
- JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some cases.

How long does the printer wait for another file?

So that the printer can make the best nest possible, it waits after a file has been received to check whether a subsequent page will nest with it or with pages already in the queue. This waiting period is the nest wait time; the factory default nest wait time is 2 minutes. This means that the printer waits for up to 2 minutes after the last file is received before printing the final nest. You can change this waiting time from the printer's front panel: press ✹, then ✽, then Setup > Job management options > Nest options > Select wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel.

Use ink economically

Here are some recommendations for making economical use of ink.

- For draft prints, use plain paper and move the print-quality slider to the left end of the scale ('Speed'). For further economy, select custom print quality options, then select Fast and Economode.
- Clean the printheads only when needed, and clean only those printheads that need cleaning. Cleaning the printheads can be useful, but it uses a small amount of ink.
● Leave the printer permanently turned on so that it can maintain the printheads in good condition automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done, the printer may need to use much more ink later to restore the health of the printheads.

● Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some ink, and its frequency is related to the number of passes made by the printheads. Therefore, nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper (T1300 series) on page 57).

Roll protection (T1300 series)

If you choose to protect a roll, jobs will be printed on it only if the job explicitly specifies the roll number or the paper type loaded on the roll. This may be useful, for example, in the following cases.

● To stop people from accidentally printing unimportant jobs on expensive paper.

● To avoid printing on a particular roll when printing from AutoCAD without interacting with the HP printer driver.

To protect a roll, go to the front panel and press , then , then Setup > Printing preferences > Paper options > Roll protection.

NOTE: If you protect a roll, then later unload the current roll and load a new one, the new roll remains protected. You are protecting the roll number, not one specific roll of paper. That roll number will remain protected until you cancel the protection.

TIP: If you print without specifying a roll number or paper type, you will not be able to print on any protected roll.

Unattended printing/overnight printing (T1300 series)

The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent image quality.

Here are some recommendations to help you deal with a long queue of printing jobs.

● If feasible, use brand-new long rolls of paper.

● If you want to print on partly-used rolls, you can check the paper type and the remaining length in the Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your jobs.

NOTE: Information on the remaining length is available only if you told the printer the length of the roll when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

● Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically switch to the other.

● Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may be put “on hold for paper” if the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 22).

● Check the ink levels remaining in your ink cartridges.

● When you have submitted your print jobs, you can use the Embedded Web Server from a remote location to monitor their status.

● Drying time should be set to Optimal.

● Press , then , then Setup > Printing preferences > Paper options > Roll switching options > Minimize roll changes or Use roll with less paper.

We recommend the following settings, depending on the paper type and what kind of prints you are making.
Recommended settings for unattended printing

<table>
<thead>
<tr>
<th>Print type</th>
<th>Print mode</th>
<th>MaxDetail</th>
<th>Drying time</th>
<th>Paper types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines</td>
<td>Normal</td>
<td>Off</td>
<td>Optimal</td>
<td>Coated, Bond, Heavyweight Coated, Glossy</td>
</tr>
<tr>
<td>Lines and fills</td>
<td>Normal</td>
<td>On</td>
<td>Optimal</td>
<td>Coated, Bond, Heavyweight Coated, Glossy</td>
</tr>
<tr>
<td>Maps</td>
<td>Best</td>
<td>On</td>
<td>Optimal</td>
<td>Coated, Heavyweight Coated, Glossy</td>
</tr>
<tr>
<td>Renderings, photographs</td>
<td>Best</td>
<td>On</td>
<td>Optimal</td>
<td>Coated, Heavyweight Coated, Glossy</td>
</tr>
</tbody>
</table>
Your printer can be connected to the Web, providing various benefits:

- Automatic firmware updates (see Update the firmware on page 117)
- Print on HP printers from almost anywhere
- Print on HP printers from almost any device, including smartphones, tablets, and laptops

For the latest information, see http://www.hpconnected.com (availability varies by product, country, and region).

### Print by email

After you have enabled Web Services, you can print to your printer by email. Just check the Web Services menu or the ePrint menu for the email address of your printer, then send the file you want to print to that email address as an attachment.

In this way, you can print from anywhere with an Internet connection, without needing any printer driver. There are a few limitations that you should bear in mind:

- The attached files to be printed must be in PDF, JPEG, or TIFF formats.
- The maximum file size is 10 MB, but your email server may have a lower limit.
- Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally in portrait orientation (some printers may offer autorotation).
9 Job queue management (T790 PS and T1300 series)

- Introduction
- The job queue in the front panel (T790 PS and T1300 series)
- The job queue in the Embedded Web Server or HP Utility (T1300 series)
Introduction

The job queue management options described in this chapter are available for the following printers.

- T1300 series: all options in this chapter
- T790 PS: front panel options only
- T790, T795: no job queue management

The job queue in the front panel (T790 PS and T1300 series)

To see the job queue on the front panel, press on the home screen.

Job queue page

The job queue page shows all jobs that are available in the job queue. It includes jobs that are being received, parsed, rendered, printed and already printed.

Each line shows the name of the job and its status. For more information on a particular job, including a preview of the job, press the line showing the job.

Jobs that cannot be completed for any reason appear at the top of the queue.

Job preview

The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the job. Job preview is available once the job is processed.

**NOTE:** Do not try to preview a job with more than 64 pages, which may cause software problems.

To preview a job, first press the name of the job in the job queue. The front panel displays a page of information about the job. Then press to see the preview.

**NOTE:** Previews may be blocked by an administrator, in which case you will not be able to see them.

When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.

You can also press to preview the previous job, or to preview the next job.

Select when to print a job in the queue

**NOTE:** The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. Press then then Setup > Job management options > When to start printing.

There are three options you can select:

- **When After Processing** is selected, the printer waits until the whole page has been processed and then it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

- **When Immediately** is selected, the printer prints the page as it is processed. This is the quickest setting, but the printer may stop halfway through a print to process data. This setting is not recommended for complex images with dense color.

- **When Optimized** is selected (this is the default setting), the printer calculates the best time to begin printing the page. It is usually the best compromise between the **After Processing** and **Immediately** settings.
Prioritize a job in the queue

You can select a job in the queue and make it the next one to be printed. After selecting the job, press **Move to front**.

If nesting is turned on (T1300 series only), the prioritized job may still be nested with others. If you really want this job to be printed next, and not nested with others, first turn nesting off and then move it to the front of the queue as described above.

In the following cases, the **Move to front** button is not displayed:

- The job is already at the front of the queue.
- The job is on hold—in this case the **Resume printing** button is displayed instead.
- The job has finished—in this case the **Reprint** button is displayed instead.
- The job has some error condition.

Pause a job in the queue

If you select the job in the queue that is currently printing, you will see a **Pause** button, which you can press to pause printing. The **Pause** button then changes to a **Resume** button, which you can press to resume printing.

Alternatively, you can press the **Options** button at the top right of the job queue screen, and then press **Pause printing**.

Reprint a job from the queue

To reprint an already-printed job, select the job from the queue, then select **Reprint**.

When reprinting a print job, you cannot change the print settings, because the job has already been rasterized.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid printing it, you can simply select the job and then press **Delete**.

**NOTE:** If an administrator password has been set, it will be required.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is **printing**), you can press **Cancel** and then **Delete**.

Delete all jobs

To delete all jobs in a queue, press the **Options** button at the top right of the job queue screen, and then press **Delete all jobs**.

**NOTE:** If an administrator password has been set, it will be required.

Turn off the job queue

To turn off the job queue, press **Setup** then **Setup > Job management options > Enable queue > Off**.
The job queue in the Embedded Web Server or HP Utility (T1300 series)

The HP Utility provides a different way of accessing the Embedded Web Server’s job management facilities, but the facilities are exactly the same whether you use the Embedded Web Server or the HP Utility.

To see the queue in the Embedded Web Server, select **Job queue** in the **Main** tab.

**Job queue page**

By default, access to the job queue is open to all users. An administrator can set a password so that users are required to enter a password for:

- Seeing job previews
- Canceling or deleting jobs

The job queue page shows all jobs that are available in the print queue. The print queue includes jobs that are being received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:

- **Preview**: Click the icon to see the job preview. The job preview is available once the job is processed.
- **File name**: Click the file name to see the properties of the job.
- **Status**: Gives the current job status.
- **Pages**: Number of pages in the job.
- **Copies**: Number of copies printed.
- **Date**: Date and time the printer received the job.
- **User**: The user’s name.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title of the corresponding column. You can perform the following operations on one or all jobs in the queue:

- **Cancel**: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains stored in the printer, but will not be printed unless you click **Reprint**.
- **Hold**: Holds the select jobs until you click **Continue** to print.
- **Continue**: All selected jobs, which are on hold, continue printing.
- **Reprint**: Prints more copies of a job. Type the number of copies (default 1, maximum 99) and click **Print**.
- **Move to front**: Sends all selected jobs to the top of the job queue.
- **Delete**: Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.

**NOTE**: The **Delete** operation can be disabled by an administrator.

- **Refresh**: Refreshes the page, ensuring the information is updated.

**NOTE**: The job queue page does not automatically update.

**Job preview**

The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the job. Job preview is available once the job is processed.
NOTE: Do not try to preview a job with more than 64 pages, which may cause software problems.

To reach the preview page, click the magnifying glass icon, which appears in the Preview column on the job queue page. The preview page shows the following job details along with a thumbnail preview of the job:

- **File name**: The file name of the job.
- **Loaded paper**: The type of paper loaded in the printer.
- **Job dimensions**: The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which appears on the right-hand side of the printer image.

NOTE: Browsers without the Adobe Flash plug-in show the job image as yellow shaded. Browsers that have the Adobe Flash plug-in version 7 and above show an enhanced preview of the job image inside the paper loaded in the printer.

### Select when to print a job in the queue

NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. Select the **Setup** tab, then **Printer settings > Start printing**.

There are three options you can select:

- **When After Processing** is selected, the printer waits until the whole page has been processed and then it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.
- **When Immediately** is selected, the printer prints the page as it is processed. This is the quickest setting, but the printer may stop halfway through a print to process data. This setting is not recommended for complex images with dense color.
- **When Optimized** is selected (this is the default setting), the printer calculates the best time to begin printing the page. It is usually the best compromise between the **After Processing** and **Immediately** settings.

### Prioritize a job in the queue

You can select any job in the queue and make it the next one to be printed. After selecting the job, click **Reprint**.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be printed next, and not nested with others, first turn nesting off and then move it to the front of the queue as described above.

### Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid printing it, you can simply select the job and then select **Delete**.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is **printing**), you can select **Cancel** and then **Delete**.

### Reprint or copy a job in the queue

To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server and click the **Reprint** icon, then specify the number of copies you want. The job will be moved to the top of the queue. To make more than one print of a non-printed job in the queue from the front panel, select the job and choose **Copies**, then specify the number of copies required. This overrides any value set by your software.
If **Rotate** was **On** when you sent the file, every copy will be rotated.

You cannot use this method for PCL3GUI jobs. To reprint old jobs that are PCL3GUI, you may be able to use your operating system's printer spooler, if you have already set the spooler to save old jobs. This facility depends on your operating system.

When reprinting a print job, you cannot change the print settings, because the job has already been rasterized.

**Job status messages**

These are the possible job status messages, approximately in the order in which they may be seen:

- **Receiving**: the printer is receiving the job from the computer
- **Waiting to process**: the job has been received by the printer and is waiting to be rendered (for jobs submitted through the Embedded Web Server only)
- **Processing**: the printer is parsing and rendering the job
- **Preparing to print**: the printer is performing writing system checks before printing the job
- **Waiting to print**: the job is waiting for the print engine to become free to proceed with printing
- **Waiting for nest**: the printer is set up with Nesting=On and is waiting for other jobs in order to complete the nest and proceed with printing
- **On hold**: the job was sent with the **on hold for preview** option and is on hold

Do not send a job for preview with more than 64 pages, this may cause the driver software to crash.

If the printer hangs up while printing a job, and the queue facility is turned on, the partially printed job will appear in the queue as **on hold** when the printer is next turned on. When you resume the job, it will start printing at the page at which it was interrupted.

- **On hold for paper**: the job can't be printed because the right paper is not loaded in the printer. Load the required paper, see [Paper handling on page 32](#), and click **Continue** to resume the job.
- **On hold for accounting**: the job can't be printed because the printer requires all jobs to have an account ID: enter the account ID and then click **Continue** to resume the job.

To set an account ID, see [Require account ID (T1300 series) on page 26](#).

- **Printing**
- **Drying**
- **Cutting paper**
- **Ejecting page**
- **Canceling**: the job is being canceled, but will remain in the printer job queue
- **Deleting**: the job is being deleted from the printer
- **Printed**
- **Canceled**: the job has been canceled by the printer
- **Canceled by user**
- **Empty job**: the job does not contain anything to print
Reactivate a job on hold

When the printer puts a job on hold you receive an alert, see Alerts on page 166, which explains why the job is on hold. Follow the instructions on the screen to remove the hold and continue printing.

Turn off the job queue

To turn off the job queue, select the Setup tab, then Printer settings > Job management > Queue and select Off.
10 Color management

- Introduction
- How colors are represented
- A summary of the color management process
- Color calibration
- Color management from printer drivers
- Color management from printer drivers (PostScript printers)
- Color management from the Embedded Web Server (T1300 series)
- Color management from the front panel
Introduction

Your printer has been engineered with advanced hardware and software features to ensure predictable and dependable results.

- Color calibration for consistent colors.
- One gray and two black inks provide neutral grays on all paper types.
- The Photo Black ink provides pure blacks when printing on photo papers.
- Color emulation of other HP DesignJet printers.

How colors are represented

All devices that display color use a color model to represent color in numerical terms. Most monitors use the RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-Yellow-black) color model.

An image can be converted from one color model to another, but in general the conversion is not perfect. Your printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents colors a little differently from another device, even if they use the same color model. However, software can adjust the colors in an image according to the characteristics of the particular device, using a color profile of the device, in order to achieve correct colors.

A summary of the color management process

To get the accurate and consistent colors that you want, you should follow these steps for each paper type that you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and then (see Color calibration on page 70). In addition, you may wish to calibrate immediately before a particularly important print job for which color consistency is vital.

2. When printing, select the correct color preset for the paper type you are using.

Color calibration

Color calibration enables your printer to produce consistent colors with the particular printheads, inks and paper type that you are using, and under your particular environmental conditions. After color calibration, you can expect to get similar prints from any two different printers situated in different geographical locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of the following circumstances:

- Whenever a printhead is replaced
- Whenever a new paper type is introduced that has not yet been calibrated with the current set of printheads
- Whenever the environmental conditions (temperature and humidity) change significantly

You can check the color calibration status of the currently loaded paper at any time by pressing and then on the front panel. The status may be one of the following:

- Recommended: the paper has not been calibrated.
**NOTE:** Whenever you update the printer’s firmware, the color calibration status of all papers is reset to **Recommended**.

- **Obsolete**: the paper has been calibrated, but the calibration is now out of date because a printhead has been replaced, and should be repeated.
- **Done**: the paper has been calibrated, and the calibration is up to date.
- **Disabled**: this paper cannot be calibrated.

**NOTE:** Color calibration cannot be performed on plain paper, nor on any kind of transparent material.

You can also check the color calibration status by using the HP Utility.

You can start color calibration in the following ways:

- From the HP Utility for Windows: select **Color Center > Calibrate paper**, and choose the paper to be calibrated.
- From the HP Utility for Mac OS: select **Paper Preset Management** from the HP Color Center group, choose the paper to be calibrated, press the button and select **Calibrate Paper**.
- From the front panel: press , then , then **Image quality maintenance > Calibrate color**.

The calibration process is fully automatic and can be performed unattended after you have loaded paper of the type you wish to calibrate—which should be A4 or any larger size. If you have more than one roll loaded, the printer will ask which roll you want to use for the calibration.

The process takes about 3–5 minutes and consists of the following steps.

1. A calibration chart is printed, which contains patches of each ink used in your printer.

2. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors have time to stabilize.

3. The chart is scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for consistent color printing on that paper type. It also calculates the maximum amount of each ink that can be applied to the paper.

---

**Color management from printer drivers**

**Color management options**

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:
• **Application-Managed Colors**: in this case your application program must convert the colors of your image to the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC profile of your printer and paper type.

• **Printer-Managed Colors**: in this case your application program sends your image to the printer without any color conversion, and the printer converts the colors to its own color space. The details of this process depend on the graphics language that you are using.

  — **PostScript (PostScript printers)**: the PostScript interpreter module performs the color conversion using the profiles stored in the printer and any additional profiles sent with the PostScript job. This kind of color management is done when you are using the PostScript driver and you specify printer color management or when you send a PostScript, PDF, TIFF or JPEG file directly to the printer through the Embedded Web Server. In either case you have to select the profiles to use as default (in case the job doesn't specify any) and the rendering intent to apply.

  — **Non-PostScript (PCL, RTL, HP-GL/2)**: the color management is done using a set of stored color tables. ICC profiles are not used. This method is somewhat less versatile than the alternatives, but is a little simpler and faster, and can produce good results with standard HP paper types. This kind of color management is done when you are using a non-PostScript driver and you specify printer color management, or when you send a PCL, RTL or HP-GL/2 file directly to the printer through the Embedded Web Server.

  **NOTE**: There are only two color spaces that the printer can convert to its own color space using the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB and ColorSync if you are using Mac OS.

  ColorSync is the Mac OS built-in Color Management System; so, when you select ColorSync, color management is performed by Mac OS, and it is done based on the ICC profiles of the specified paper type. ColorSync is available with the PCL3GUI driver only.

  ColorSync can be selected from the **Color Matching** panel.

You are recommended to consult the Knowledge Center (see Knowledge Center on page 171) to see how to use the color management options of your particular application.

To choose between **Application-Managed Colors** and **Printer-Managed Colors**:

• In the Windows driver dialog: select the **Color** tab.

• In the Mac OS Print dialog: select the **Color Options** panel.

• In some applications: you can make this choice in the application.

### Printer emulation

If you want to print a particular job and to see approximately the same colors that you would get from printing the same job on a different HP DesignJet printer, you can use the emulation mode provided by your printer.

**NOTE**: This option is available only when printing an HP-GL/2, PostScript or PDF job. It will work correctly only when printing on plain, coated or heavyweight coated paper.

• In the Windows HP-GL/2 or PostScript driver dialog: select the **Color** tab, then **Printer Managed Colors**, then select **Printer Emulation** from the Source Profile list. You can then select from the Emulated Printer list.

• In the Mac OS Print dialog (non-PostScript printers): select the **Color Options** panel, then **Color Management > Printer**, then select **Printer Emulation** from the Source Profile list.

• In the Mac OS Print dialog (PostScript printers): select the **Color Options** panel, then select from the Printer Emulation list.
Color adjustment options

The aim of color management is to print accurate colors. If you perform color management correctly, then you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:

- If your color management is not working correctly for some reason
- If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color or in grayscale. If you are printing in pure black and white, there are no color adjustment options.

Printing in color

You can adjust the colors of your print in similar ways under Windows and Mac OS:

- **In the Windows driver dialog:** select the Color tab, ensure that the Advanced color adjustments box is checked, then press the Settings button beside it.
- **In the Mac OS Print dialog (non-PostScript printers):** select the Color Options panel, select Color from the Mode list, then press the Adjust button.
- **In the Mac OS PostScript Print dialog (PostScript printers):** select the Color Options panel, select Color from the Mode list, then press the Adjust button.

Under either operating system, you will then be able to make adjustments using a lightness slider and three color sliders.

- The lightness slider simply makes the whole print lighter or darker.
- The color sliders can be used to fade or emphasize each of the primary colors in the print. The primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the color model used in the image.

The Reset button restores each slider to its default central position.

Printing in grayscale

You can convert all colors in your image to shades of gray in the following ways:

- **In your application program:** many programs provide this option.
- **In the Windows driver dialog:** go to the Color tab and look at the Color Options section. Select Print in Grayscale. You can also select Print in pure black and white if you want only black and white, without gray shades.
• In the Mac OS Print dialog (non-PostScript printers): go to the Color Options panel and select Grayscale from the Mode drop-down list. You can also select Pure Black and White if you want only black and white, without gray shades.

• In the Mac OS PostScript Print dialog (PostScript printers): go to the Color Options panel and select Grayscale from the Mode drop-down list. You can also select Pure Black and White if you want only black and white, without gray shades.

• On the Embedded Web Server's Submit Job page (T1300 series): select Color, then set Color/Grayscale to Print In Grayscale. You can also select Pure Black and White if you want only black and white, without gray shades.

You can adjust the gray balance of your print in similar ways under Windows and Mac OS:

• In the Windows driver dialog: select the Color tab, ensure that the Advanced color adjustments box is checked, then press the Settings button beside it.

• In the Mac OS Print dialog (non-PostScript printers): select the Color Options panel, select Grayscale from the Mode list, then press the Adjust button.

• In the Mac OS PostScript Print dialog (PostScript printers): select the Color Options panel, select Grayscale from the Mode list, then press the Adjust button.

Under either operating system, you will then be able to make adjustments using separate controls for highlights, midtones and shadows.

The lightness slider simply makes the whole print lighter or darker. This slider is available in the same window as the other grayscale controls.

The zone definition sliders can be used to define what you mean by highlight, midtone and shadow.

The other controls for highlight, midtone and shadow can be used to adjust the gray balance of highlights, midtones and shadows respectively.

The Reset button restores each control to its default setting.

**Color management from printer drivers (PostScript printers)**

This facility is available when printing with the PostScript driver.
HP Professional PANTONE Emulation

When you use a named PANTONE color in an image, your application will normally send to the printer a CMYK or RGB approximation to that color. But the application does not take the printer or the paper type into account, it merely produces a generic approximation of the PANTONE color, which will look different on different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics of the printer and the paper type. The results look as similar to the original PANTONE colors as is possible on a given printer using a given paper type. This technology is designed to produce emulations similar to those set up manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on by default.

- In the Windows PostScript driver dialog: go to the Color tab and select HP Professional PANTONE Emulation.
- In the Mac OS PostScript Print dialog: go to the Color Options panel and select HP Professional PANTONE Emulation.

You can also use the Embedded Web Server to print a swatch book showing emulations of PANTONE colors as made by your printer, together with a measure of the color difference (ΔE) between each emulation and the original PANTONE spot color. So HP Professional PANTONE Emulation not only provides the closest match that can be achieved on your printer; it also gives clear information on how close the emulation is to the original spot color. See Printing PANTONE swatch books (T1300 PS) on page 78.

Color emulation

Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and CMYK devices such as presses and printers.

You can set color emulation in the following ways:

- In the Windows PostScript driver dialog: select the Color tab, and Printer Managed Colors.
- In the Mac OS Print dialog: select the Color Options panel, then select Printer from the Color Management list.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide the most common standards for the different devices.

The options are as follows.

CMYK color emulation

A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to the printer, because different printers will produce different colors from the same CMYK data. If the image file you are printing was not created specifically for your printer, it will require some readjustment, which can be done using one of the following options provided with your printer.

- None (Native): no emulation. The printer will use its default internal conversion from CMYK to RGB, without following any color standard. This does not imply that results will be bad
- ISO Coated 2-ECI is based on the characterization dataset FOGRA39L.txt, applicable to the following reference printing conditions according to the international standard ISO 12647-2:2004/Amd 1: commercial and specialty offset, paper type 1 and 2, gloss or matt coated paper, positive plates, tone value increase curves A (CMY) and B (K), white backing.
- Coated GRACoL 2006-ISO12647 provides GRACoL proofing and printing on Grade 1 coated paper, ISO 12647-2 Paper type 1.
PSO Uncoated ISO12647-EC is based on the characterization data set FOGRA47L.txt, applicable to the following reference printing condition according to the international standards ISO 12647-2:2004 and ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, paper type 4, uncoated white paper, positive plates, tone value increase curves C (CMY) and D (K), white backing.

PSO LWC Improved-ECI is based on the characterization data set FOGRA45L.txt, applicable to the following reference printing condition according to the international standards ISO 12647-2:2004 and ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, improved LWC paper (light weight coating), positive plates, tone value increase curves B (CMY) and C (K), white backing.

Web Coated SWOP 2006 Grade 3 provides SWOP® proofing and printing on U.S. Grade 3 coated publication paper.

Web Coated SWOP 2006 Grade 5 provides SWOP® proofing and printing on U.S. Grade 5 coated publication paper.

U.S. Sheetfed Coated 2 uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 350% total area of ink coverage, negative plate, bright white offset stock.

U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white offset stock.

U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 300% total area of ink coverage, negative plate, coated publication-grade stock.

U.S. Web Uncoated 2 uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white offset stock.

Euroscale Uncoated 2 uses specifications designed to produce quality separations using Eurosacle inks under the following printing conditions: 260% total area of ink coverage, positive plate, uncoated white offset stock.

Japan Web Coated (Ad) uses specifications developed by the Japan Magazine Publisher Association for digital proofing of images in the Japanese magazine/advertising market.

Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper. It is designed to produce quality separations using 350% total ink coverage, positive film and coated paper.

Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated) paper. It is designed to produce quality separations using 310% total ink coverage, positive film and uncoated paper.

Japan Color 2002 Newspaper uses the Japan Color 2002 for Newspapers specification. It is designed to produce quality separations using 240% total ink coverage, positive film and standard newsprint paper.

Japan Color 2003 WebCoated is for type 3 coated paper. It is designed to produce quality separations for standard ISO printing using 320% total ink coverage, positive film, and coated paper on heat-set web offset presses.

JMPA: Japanese standard for offset press.

Toyo is designed to produce quality separations for Toyo printing presses.

DIC is designed to produce quality separations for Dainippon Ink Company printing presses.

NOTE: These options have no effect if the application is defining its own CMYK space, known as calibrated CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation

Your printer is provided with the following color profiles:
None (Native): no emulation, for use when the color conversion is done by the application or operating system, and therefore the data arrive at the printer already color-managed.

sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard space is endorsed by many hardware and software manufacturers, and is becoming the default color space for many scanners, printers and software applications.

ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space provides a smaller gamut alternative to Adobe RGB (1998) for print production work.

Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety of desktop publishing applications. Use this space for files that you plan to display on Apple monitors, or for working with old desktop publishing files.

Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do print production work with a broad range of colors.

Color management from the Embedded Web Server (T1300 series)

Submit Job options

When you send jobs to the printer using the Embedded Web Server's Submit Job page, you have the following color management options.

If you leave an option set to Default, the setting saved in the job will be used. If the job contains no setting, the front-panel setting in the printer will be used.

T1300 and T1300 PS options

- **Color/Grayscale**: you can choose to print in color, in shades of gray or in pure black and white.
- **Default RGB source profile**: you can choose from a selection of RGB source profiles recognized by the printer.
- **Printer emulation**: you can choose to emulate a different HP DesignJet printer. Default: Off (no printer emulation).

T1300 PS options (with PostScript or PDF jobs)

- **Default CMYK source profile**: you can choose from a selection of CMYK source profiles recognized by the printer. Default: US Coated SWOP v2.
- **Rendering intent**: you can select the rendering intent.
- **Black point compensation**: you can turn black point compensation on or off.
- **HP Professional PANTONE Emulation**: you can turn HP Professional PANTONE Emulation on or off.

Rendering intent

Rendering intent is one of the settings used when doing a color transformation. As you probably know, some of the colors you want to print may not be reproducible by the printer. The rendering intent allows you to select one of four different ways of handling these so-called out-of-gamut colors.

- **Saturation (graphics)**: best used for presentation graphics, charts or images made up of bright, saturated colors.
- **Perceptual (images)**: best used for photographs or images in which colors blend together. It tries to preserve the overall color appearance.
- **Relative colorimetric (proofing)**: best used when you want to match a particular color. This method is mainly used for proofing. It guarantees that, if a color can be printed accurately, it will be printed accurately. The other methods will probably provide a more pleasing range of colors but do not guarantee that any particular color will be printed accurately. It maps the white of the input space to the white of the paper on which you are printing.

- **Absolute colorimetric (proofing)**: the same as relative colorimetric, but without mapping the white. This rendering is also used mainly for proofing, where the goal is to simulate the output of one printer (including its white point).

**Perform black point compensation**

The black point compensation option controls whether to adjust for differences in black points when converting colors between color spaces. When this option is selected, the full dynamic range of the source space is mapped into the full dynamic range of the destination space. It can be very useful in preserving shadows when the black point of the source space is darker than that of the destination space. This option is allowed only when the **Relative colorimetric** rendering intent is selected (see [Rendering intent on page 77](#)).

**Printing PANTONE swatch books (T1300 PS)**

You can use the Embedded Web Server or the HP Utility to print a swatch book showing emulations of PANTONE colors as made by your printer, together with a measure of the color difference (ΔE) between each emulation and the original PANTONE spot color.

To print a swatch book, select the Embedded Web Server’s **Main** tab, then **HP Professional PANTONE Emulation**. Select the PANTONE stock to emulate, and one or more strips of PANTONE colors that you want to print. You can select color strips from more than one PANTONE stock. When you have selected all the colors you want, press the **Next** button. The next window displays your selection; you can press **Print** to print that selection, or **Back** to change the selection.

**Color management from the front panel**

You can color-calibrate the loaded paper type from the front panel by pressing **quality maintenance** > **Calibrate color**. See [Color calibration on page 70](#).
The other color options in the front panel can all be found by pressing \[Setup\], then \[Setup\], then \[Setup > Printing preferences > Color options\].

**NOTE:** These front panel settings can all be overridden by the printer driver or (with the T1300 series) Embedded Web Server job submission settings.

### T790 series and T1300 series options

- **Color/Grayscale:** you can choose to print in color or in shades of gray. Default: Print in color.
- **Select RGB source profile:** you can choose from a selection of RGB source profiles recognized by the printer. Default: sRGB (HP).
- **Emulate printer:** you can choose to emulate a different HP DesignJet printer. Default: Off (no printer emulation).

**TIP:** If you have old HP-GL/2 or PostScript files made for a different HP DesignJet printer, you can send them to the printer and use the front panel to turn on the appropriate emulation mode.

### T1300 PS options (with PostScript or PDF jobs)

- **Select CMYK source profile:** you can choose from a selection of CMYK source profiles recognized by the printer. Default: US Coated SWOP v2.
- **Select rendering intent:** you can select the rendering intent. Default: Perceptual.
- **Black point compensation:** you can turn black point compensation on or off. Default: On.
- **HP Professional PANTONE Emulation:** you can turn HP Professional PANTONE Emulation on or off. Default: On.
11 Practical printing examples

- Print a draft for revision with the correct scale
- Print a project
- Print a presentation
- Print and scale from Microsoft Office
Print a draft for revision with the correct scale

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check the plot size.

2. Select File > Print and ensure that Page Scaling is set to None.

NOTE: The page size will not be automatically selected according to the drawing size.
3. Press the **Properties** button and then select the **Paper/Quality** tab.

4. Choose whatever **Document Size** and **Print Quality** you want to use. If you want to define a new custom paper size, press the **Custom** button.

5. Select the **Features** tab, and then **Autorotate**.
6. Click **OK**, and check that the print preview in the Print dialog box seems correct.

---

**Print a project**

This section demonstrates how to print a project from AutoCAD and the Embedded Web Server.

**Using AutoCAD**

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.

2. Click the Plot icon at the top of the window.
3. The Plot window opens.

4. You can see further options by pressing the circular button in the lower right corner of the window.

**NOTE:** The Quality option here does not refer to the final print quality but to the quality of AutoCAD viewport objects that are sent for printing.
5. Press the **Properties** button.

6. Select the **Device and Document Settings** tab, and press the **Custom Properties** button.
7. In the Paper/Quality tab, check the Show preview before printing box, and select the paper type that you intend to use.

![Image of printing properties with Paper/Quality tab highlighted]

**NOTE:** If you select neither the paper source nor the paper type, the printer will not print on any protected roll (see Roll protection (T1300 series) on page 59).

8. Select the print quality (your own choice between speed and quality of printing).

9. If you intend to print on roll paper, you must decide where the printer should cut the paper. Press the Margins/Layout button and select Clip contents by margins.
10. Select the **Features** tab, then select the **Autorotate** option. If you have a T1300 series printer, select the **Crop lines** option also. Autorotation can help to avoid wasting paper, and the crop lines will show you where to cut the paper after printing.

11. Press the **OK** button and save your configuration changes to a PC3 file.
12. When you have pressed the OK button in the Plot window, the printer will construct a print preview (T1300 series only).

If you have the HP DesignJet software suite installed, you will see the preview in HP DesignJet Preview.

Using the Embedded Web Server to submit files (T1300 series)

From the HP Utility or the Embedded Web Server, select Job Center > Submit Job. With some Web browsers, you will see the window below; with other Web browsers, the mechanism for adding files is slightly different.
Press the Add files button (or Choose File, Add another file) to choose the files from your computer that you want to print. The files must be in one of the following formats:

- PDF (PostScript printers only)
- PostScript (PostScript printers only)
- TIFF (PostScript printers only)
- JPEG (PostScript printers only)
- HP-GL/2
- RTL

**NOTE:** When you print to a file, the file should be in one of the above formats, but its name may have an extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and number of copies), you can just press the Print button and the project will be sent to the printer.

If you need to specify printing settings, go to the Job settings section and select the options you need. Each option has explanatory text on the right, so that you can understand the behavior of each setting. Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job contains no setting, the setting in the printer will be used.

**Using printer emulation**

Printer emulation can be requested by selecting Advanced settings > Color > Color management > Printer emulation.

You can select Off (no printer emulation) or the name of the printer model that you want to emulate.

This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

**Using clip contents by margins**

You can select this margins option from Advanced settings > Paper > Layout/Margins > Print with margins > Layout > Clip contents by margins.
Use this option when the contents to be printed have white borders and a size equal to that of the paper you have selected. The printer will use the white border for its margins and you will get a page of size equal to that which is selected in the driver.

**Print a presentation**

This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

**Using AutoCAD**

1. Open the AutoCAD file and select a layout.

2. Click the Plot icon at the top of the window.

3. Ensure that the correct printer is selected, then press the **Properties** button.
4. Select the **Device and Document Settings** tab, and press the **Custom Properties** button.

5. In the **Paper/Quality** tab, check the **Show preview before printing** box, and select the paper type that you intend to use.

**NOTE:** If you select neither the paper source nor the paper type, the printer will not print on any protected roll (see **Roll protection (T1300 series) on page 59**).

6. Select the print quality (your own choice between speed and quality of printing).
7. If you intend to print on roll paper, you must decide where the printer should cut the paper. Press the **Margins/Layout** button and select **Clip contents by margins**.

8. If you are using photo or glossy paper, you can select **Borderless** printing (T1300 series only).

9. Select the **Features** tab, then select the **Autorotate** option. If you have a T1300 series printer, select the **Crop lines** option also. Autorotation can help to avoid wasting paper, and the crop lines will show you where to cut the paper after printing.
10. Press the **OK** button and save your configuration changes to a PC3 file.

11. When you have pressed the **OK** button in the Plot window, the printer will construct a print preview (T1300 series only).

**Using Adobe Photoshop**

1. In Photoshop CS5, select **File > Print** and then select your printer.
2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, press the Custom button. Enter the width, the length and the name of your custom paper size. Press the Save and OK buttons.
3. Select **Show preview before printing**. You may also wish to change the default paper source, paper type and print quality.

4. In the **Color** tab, the default color management option is **Printer managed colors**, and this is the correct option because you have already selected **Printer Manages Colors** in Photoshop.

---

**Print and scale from Microsoft Office**

This section demonstrates how to print and scale from Microsoft Office 2007.

**Using PowerPoint**

1. Select the Office Button, then **Print**, and select the name of your printer.
2. Select **Properties > Features > Print document on** to scale the document to a particular size.

3. Select the **Paper/Quality** tab, then select **Paper Source** and **Paper Type**.
4. Select **Margins/Layout**, then select **Clip contents by margins** to keep the size.

Using Project

1. Select **File > Page Setup > Print**.

2. Select your printer’s name, then **Close**.
3. Select **Page Setup**, and choose the **Paper Size** you want.

![Page Setup dialog box](image)

4. Select **Options** to go to the printer driver. The default options in the **Paper/Quality** tab are probably suitable: **Paper source**: Printer auto select and **Paper Type**: Any.

![Printer driver settings](image)

5. Select **Features** > **Print document on** to scale the document to a particular size. Alternatively, you can scale the document in Project.

![Printer driver settings](image)
**Using Excel**

1. Select the Office Button, then **Print**. Select your printer's name, then click **Close**.

2. Select the **Page Layout** tab, then **Size**, and choose the paper size you want.
3. Select the Office Button, then Print > Properties to go to the printer driver. In the Paper/Quality tab, select Paper source, Paper Type and Print Quality.

4. Select Features > Print document on to scale the document to a particular size. Alternatively, you can scale the document in Excel.
12 Retrieving printer usage information

- Get printer accounting information
- Check usage statistics
- Check usage statistics for a job
- Request accounting data by email
Get printer accounting information

There are various different ways of getting accounting information from your printer.

- View printer usage statistics for the whole lifetime of the printer, see Check usage statistics on page 102.
- View ink and paper usage for each of your recent jobs by using the HP Utility, see Check usage statistics for a job on page 102. If the HP Utility is not available, see Access the HP Utility on page 28.
- Request accounting data by email. The printer sends data in XML at regular intervals to a specified email address; the data may be interpreted and summarized by a third-party application, or displayed as an Excel spreadsheet. See Request accounting data by email on page 103.
- Use a third-party application to request printer status, printer usage or job accounting data from the printer through the Internet. The printer provides data in XML to the application whenever requested. HP provides a Software Development Kit to facilitate the development of such applications.

Check usage statistics

There are various ways of checking your printer's usage statistics.

NOTE: The accuracy of the usage statistics is not guaranteed.

From the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 28.
2. Go to the Main tab.
3. Select History > Usage.

From the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 28.
2. Under Windows, go to the Overview tab and click on the Printer usage link.
   Under Mac OS, select Information > Printer Usage and click on the Lookup button.

From the front panel

1. Press ⚡.
2. Press ⏸.
3. Press Internal prints.
5. Press Print usage report.

Check usage statistics for a job

There are two ways to check usage statistics for a particular job.

NOTE: The accuracy of the usage statistics is not guaranteed.
Accounting statistics with the HP Utility (T1300 series)

1. Access the HP Utility, see Access the HP Utility on page 28.
2. Select Job center to view information regarding the most recent jobs.
3. Under Windows, click on the Accounting link.
   Under Mac OS, select Job Accounting and click on the Look Up button.

Accounting statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 28.
2. Go to the Main tab.
3. Select History > Accounting.

Request accounting data by email

1. Obtain the IP address of the outgoing mail server (SMTP) from your IT department; this is required in order to send email messages.
2. Ensure that the outgoing email server is configured to enable relaying of email messages that the printer will send.
3. Open your Web browser and connect to the printer’s Embedded Web Server.
4. Select the Setup tab.
5. From the Configuration menu in the left-hand column, select Date & Time.
6. Ensure that the printer’s date and time have been set correctly.
7. From the Configuration menu, select Email server.
8. Enter the IP address of the outgoing mail server (SMTP).
9. Specify an email address for the printer. The latter does not need to be a valid email address, because the printer will not receive messages; but it should have the form of an email address. It serves to identify the printer when it sends email messages.
10. From the Configuration menu, select Printer settings.
11. In the Accounting section, if you set Require account ID to On, then every time someone sends a print job to the printer, he or she must provide an account ID: for example, an ID corresponding to his or her department or to a specific project or client. If someone sends a job without providing an account ID, the printer will hold the unidentified job in the queue without printing it until an account ID is provided.
    If you set Require account ID to Off, then the printer will print all jobs whether or not they have an account ID.
12. Set Send accounting files to Enabled.
13. Set Send accounting files to the email address (or addresses) to which you want the accounting information sent. This may be an address that you have created specifically to receive automatically generated messages from the printer.
14. Set **Send accounting files every** to the frequency with which you want the information sent, choosing a specific number of days or prints.

15. You may want to set **Exclude personal information from accounting email** to On, so that the accounting messages will not contain personal information. If this option is Off, information such as user name, job name, and account ID will be included.

When you have completed the above steps, the printer will send accounting data by email with the frequency that you specified. The data are provided in XML and can easily be interpreted by a third-party program. The data provided on each print job include when the job was submitted, when the job was printed, the printing time, the type of image, the number of pages, the number of copies, the paper type and size, the amount of each color of ink used and various other attributes of the job. Accounting data are also provided on scan and copy jobs.

You can download an Excel template from HP's Web site ([http://www.hp.com/go/designjet/accounting](http://www.hp.com/go/designjet/accounting)) that will enable you to display the XML data more readably in the form of a spreadsheet.

Analysis of the accounting data will enable you to bill customers precisely and flexibly for the use of your printer. You can, for instance:

- Bill each customer for the total amount of ink and paper used by that customer over a particular period.
- Bill each customer separately per job.
- Bill each customer separately for each project, broken down by job.

**NOTE:** In some circumstances Excel may lose or misplace the decimal point in a number: for instance, the number 5.1806 may be misunderstood as 51806 and displayed as 51,806. This is an Excel problem that cannot be solved by HP.
13 Handling ink cartridges and printheads

- About the ink cartridges
- Check the ink cartridges status
- Remove an ink cartridge
- Insert an ink cartridge
- About the printheads
- Check the printhead status
- Remove a printhead
- Insert a printhead
About the ink cartridges

Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper. To purchase additional cartridges, see Accessories on page 119.

⚠ CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the Glossary on page 178). Avoid touching pins, leads and circuitry.

Check the ink cartridges status

To view the ink levels of your ink cartridges, press \[ \text{on the front panel, then } \text{. There is a Replace ink cartridges option on the ink information page in case you want to do so (see also Remove an ink cartridge on page 106).}

To get more information on your ink cartridges, you can press the color of the cartridge on which you want information.

You can also get this information from the HP Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 156.

HP Utility procedures

- In the HP Utility for Windows, go to the Overview tab, each cartridge's status is under Supplies Status > Cartridges.
- In the HP Utility for Mac OS, select Printer Status in the Information group.

Remove an ink cartridge

There are two occasions when you need to remove an ink cartridge.

- The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can use up the remaining ink in the first cartridge at a more convenient time).
- The ink cartridge is empty or faulty, and you must replace it to continue printing.

⚠ CAUTION: Do not try to remove an ink cartridge while printing.

⚠ CAUTION: Remove an ink cartridge only if you are ready to insert another one.

⚠ CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

⚠ NOTE: When a cartridge runs out of ink, the current job is not automatically cancelled: unless you cancel it manually, it will resume printing when the empty cartridge has been replaced. If there is a delay in replacing the cartridge, you may see some banding on the print.

1. From the front panel, press \[ then \[ then Replace ink cartridges.

Alternatively, press \[ then \[ then Ink > Replace ink cartridges.
2. Open the ink cartridge cover on the left-hand side of the printer.

3. Grip the cartridge you wish to remove.

4. Pull the cartridge straight up.

   **NOTE:** Avoid touching the end of the cartridge that is inserted into the printer, as there may be ink on the connection.

   **NOTE:** Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

### Insert an ink cartridge

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters (in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the cartridge label.
3. Insert the ink cartridge into its slot.

4. Push the cartridge into the slot until it snaps into position. You should hear a beep and see confirmation that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 156.

5. When all cartridges have been inserted, close the cover.

6. The front-panel display confirms that all cartridges have been correctly inserted.

About the printheads

The printheads are connected to the ink cartridges and jet ink onto the paper.

⚠️ CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices (see the Glossary on page 178). Avoid touching pins, leads and circuitry.
Check the printhead status

The printer automatically checks and services the printheads after each print. Follow the steps below to get more information on your printheads.

1. From the front panel, press then , then the printhead on which you want information.

2. The front panel displays:
   - Colors
   - Product name
   - Product number
   - Serial number
   - Status, see Front-panel error messages on page 167
   - Volume of ink it has used
   - Warranty status

You can also get most of this information from the HP Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 161.

If the warranty status is See warranty note, this indicates that non-HP ink is being used. See the Legal Information document provided with your printer for details of the warranty implications.

Remove a printhead

⚠️ CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

⚠️ CAUTION: Printhead replacement must be performed with the printer powered on.

1. From the front panel, press , then , then Replace printheads.

   Alternatively, press , then , then Ink > Replace printheads.

2. The printer moves the carriage into the correct position.

⚠️ CAUTION: If the carriage is left in the removal position for more than three minutes without inserting or removing any printheads, it tries to move back to its normal position in the right-hand end.
3. When the carriage has stopped moving, the front-panel display asks you to open the window.

4. Locate the carriage on the right side of the printer.

5. Pull the handle up and toward you to release the wire loop.

6. Push the handle back to raise the lid.
7. This gives you access to the printheads.

8. To remove a printhead, lift up the blue handle.

9. Using the blue handle, use steady force to disengage the printhead.
10. Pull the blue handle upward until the printhead is released from the carriage.

⚠️ **CAUTION:** Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.

### Insert a printhead

**NOTE:** You cannot insert a new printhead successfully if either of the connected ink cartridges is empty, or nearly empty. In this case, you should replace the ink cartridge before inserting the new printhead.

1. Remove the orange protective caps by pulling them down.

2. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check that the colored label on the printhead matches the colored label of the carriage slot into which the printhead is to be inserted.
3. Insert the new printhead into its correct slot in the carriage.

⚠️ **CAUTION:** Insert the printhead slowly and vertically, straight down. It may be damaged if you insert it too fast, or at an angle, or if you rotate it as you insert it.

4. Push down as indicated by the arrow shown below.

⚠️ **CAUTION:** When installing the new printhead there may be some resistance, so you need to press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead on page 156.

5. Insert all other printheads that need to be installed, and close the carriage lid.
6. Ensure the end of the blue handle catches the wire loop on the near side of the carriage.

7. Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer beeps.

**NOTE:** If the printer does not beep when you insert the printhead and the Replace message appears on the front-panel display, the printhead may need to be reinserted.

8. Close the window.

9. The front-panel display confirms that all printheads are correctly inserted. The printer starts checking and preparing the printheads. The default routine process, when all printheads are changed, takes 10 minutes. If the printer finds problems in preparing the printheads, it takes longer, up to 45 minutes. For a single printhead insertion, the times vary between 2 and 40 minutes. After all printheads are checked and prepared, the printhead realignment procedure runs automatically if paper is loaded, see Align the printheads on page 159.

10. You are recommended to perform a color calibration after inserting a new printhead. See Color calibration on page 70.
14 Maintaining the printer

- Check printer status
- Clean the exterior of the printer
- Maintain the ink cartridges
- Move or store the printer
- Update the firmware
- Update the software
- Printer maintenance kits
- Secure Disk Erase
Check printer status

You can check the current status of the printer in various ways:

- If you start the HP Utility and select your printer, you see a page of information describing the status of the printer and its paper and ink supplies.
- If you access the Embedded Web Server, you see information about the general status of the printer. The Supplies page in the Main tab describes the status of the paper and ink supplies.
- At the front panel, you can press for information about paper, ink levels, ink cartridges, and printheads. If there is a current problem, you are taken automatically to the area with the most urgent problem.

If there are any current alerts, the upper row of the home screen shows the top-priority alert. Press the alert message to see a list of all current alerts.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

⚠️ WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean it. Do not let water get inside the printer.

⚠️ CAUTION: Do not use abrasive cleaners on the printer.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain the best print quality, replace a cartridge when it reaches its expiration date. The printer’s front panel notifies you when any cartridge reaches its expiration date.

You can also check a cartridge’s expiration date at any time: see Check printer status on page 116.

See also Handling ink cartridges and printheads on page 105.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare the printer, follow the instructions below.

1. Do not remove the ink cartridges or printheads.
2. Make sure that no paper is loaded.
3. Make sure that the printer is idle.
4. Disconnect any cables connecting the printer to a network or a computer.

If you need to leave the printer turned off for a long time, follow the additional steps below.

1. Turn off the power using the Power key on the front panel.
2. Also turn off the power switch at the rear of the printer.
3. Disconnect the printer’s power cable.

⚠️ CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious damage.
When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the printer has been off for a six weeks or more, preparing the printheads could take up to 45 minutes.

⚠️ CAUTION: If the printer remains off for a long period of time, the printheads may become unusable. In this case, you need to replace the printheads with new ones.

⚠️ TIP: Because preparing and purging the printheads uses both time and ink, you are strongly recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printheads. In both cases, the printer wakes up from time to time to maintain the printheads. Thus you can avoid going through lengthy preparation processes before using your printer.

### Update the firmware

The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from HP. These updates increase the printer’s functionality, enhance its features, and may correct minor problems.

⚠️ IMPORTANT: You are strongly recommended to update the firmware periodically in order to take advantage of the latest developments.

There are various ways of downloading and installing firmware updates; you can choose whichever you find most convenient. They can be divided into two categories: automatic and manual updates.

⚠️ NOTE: The firmware includes a set of the most commonly used paper presets. Extra paper presets can be downloaded separately; see Paper presets on page 40.

#### Automatic firmware updates

Automatic firmware updates are a convenience that is possible with Web-connected printers. Your printer can automatically download the latest firmware release and install it for you.

**Important notes**

- Your printer must be connected to the Internet; see Set up your Web-connected printer on page 21.
- To configure automatic firmware updates, you can use the front panel or the Embedded Web Server; see Set up your Web-connected printer on page 21.
- If an administrator password has been set, it will be required to change these settings.
- A firmware update package can be large; you may want to consider whether there are any implications for your network or Internet connection. Downloads made with a Jetdirect adaptor are slower than those made with the built-in Ethernet adaptor.
- A firmware update is downloaded in the background: the printer can be printing at the same time. However, it cannot be installed in the background: printing must stop.

#### Manual firmware updates

Manual firmware updates can be performed in the following ways:

- Using the Embedded Web Server, select the Firmware update maintenance tab and then Firmware update. Press Check now to check whether new firmware is available. If new firmware is available, some information about the new firmware is displayed, and you are given the opportunity to download and install it.
- Using the HP Utility under Windows, select your printer, the Support tab and then Firmware Update.
● Using the HP Utility under Mac OS, select **Firmware Update** in the Support group.

● Using HP Web Jetadmin, with which you can make manual firmware updates or request automatic updates.

● Using a USB flash drive. Download the firmware file from [http://www.hp.com/go/T790/firmware](http://www.hp.com/go/T790/firmware) or [http://www.hp.com/go/T1300/firmware](http://www.hp.com/go/T1300/firmware) (according to your printer model) into the USB flash drive and insert it into the Hi-Speed USB host port beside the front panel. A firmware update assistant will appear on the front panel to guide you through the update process.

### Update the software


If your operating system is Windows, HP Software Update regularly offers to update your software automatically.

### Printer maintenance kits

Four maintenance kits are available for your printer, containing components that may need to be replaced after long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see [Contact HP Support on page 173](#)) and request the maintenance kit. The kits are installed by service engineers only.

### Secure Disk Erase

The printer's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility can completely erase your information from the hard disk to protect it from unauthorized access. You can choose to erase particular files, or the whole hard disk.

Secure Disk Erase provides three different levels of security:

- **Non-Secure Fast Erase:** all pointers to the information are erased. The information itself remains on the hard disk until the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains on the disk, it is difficult for most people to access, but may be accessed using software designed for the purpose. This is the normal method in which files are erased on most computer systems; it is the fastest method but the least secure.

- **Secure Fast Erase:** all pointers to the information are erased, and the information itself is also overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but more secure. It may still be possible to access fragments of the erased information by using special tools to detect residual magnetic traces.

- **Secure Sanitizing Erase:** all pointers to the information are erased, and the information itself is repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense 5220-22.m requirements for clearing and sanitization of disk media. This is the default security level when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print management software: see [http://www.hp.com/go/webjetadmin](http://www.hp.com/go/webjetadmin).

If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support: see [Contact HP Support on page 173](#).

**NOTE:** If you choose to erase the whole hard disk, you may be asked to restart the printer several times during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with Secure Sanitizing Erase.
15 Accessories

- How to order supplies and accessories
- Introduction to the accessories
How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your printer:

- Contact HP Support (see Contact HP Support on page 173).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies

The following ink supplies can be ordered for your printer.

<table>
<thead>
<tr>
<th>Ink cartridges</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 72 69 ml Photo Black Ink Cartridge</td>
<td>C9397A</td>
</tr>
<tr>
<td>HP 72 69 ml Cyan Ink Cartridge</td>
<td>C9398A</td>
</tr>
<tr>
<td>HP 72 69 ml Magenta Ink Cartridge</td>
<td>C9399A</td>
</tr>
<tr>
<td>HP 72 69 ml Yellow Ink Cartridge</td>
<td>C9400A</td>
</tr>
<tr>
<td>HP 72 69 ml Gray Ink Cartridge</td>
<td>C9401A</td>
</tr>
<tr>
<td>HP 72 130 ml Matte Black Ink Cartridge</td>
<td>C9403A</td>
</tr>
<tr>
<td>HP 72 130 ml Photo Black Ink Cartridge</td>
<td>C9370A</td>
</tr>
<tr>
<td>HP 72 130 ml Cyan Ink Cartridge</td>
<td>C9371A</td>
</tr>
<tr>
<td>HP 72 130 ml Magenta Ink Cartridge</td>
<td>C9372A</td>
</tr>
<tr>
<td>HP 72 130 ml Yellow Ink Cartridge</td>
<td>C9373A</td>
</tr>
<tr>
<td>HP 72 130 ml Gray Ink Cartridge</td>
<td>C9374A</td>
</tr>
<tr>
<td>HP 726 300 ml Matte Black Ink Cartridge (T795 &amp; T1300 series only)</td>
<td>CH575A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printheads</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 72 Gray &amp; Photo Black Printhead</td>
<td>C9380A</td>
</tr>
<tr>
<td>HP 72 Magenta &amp; Cyan Printhead</td>
<td>C9383A</td>
</tr>
<tr>
<td>HP 72 Matte Black &amp; Yellow Printhead</td>
<td>C9384A</td>
</tr>
</tbody>
</table>

Order paper

The following paper types are currently provided for use with your printer.

⚠️ NOTE: This list is likely to change over the course of time. For the latest information, see http://www.hp.com/go/T790/accessories or http://www.hp.com/go/T1300/accessories.

⚠️ NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.

Key to availability:
- (A) indicates papers available in Asia (excluding Japan)
- (C) indicates papers available in China
- (E) indicates papers available in Europe, the Middle East and Africa
- (J) indicates papers available in Japan
- (L) indicates papers available in Latin America
- (N) indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

### Roll paper

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Bond and Coated Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Universal Bond Paper</td>
<td>80</td>
<td>45.7 m (150 ft)</td>
<td>594 mm (A1)</td>
<td>Q8003A (AJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>Q1396A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1397A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1398A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>91.4 m (300 ft)</td>
<td>594 mm (A1)</td>
<td>Q8004A (EAJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in)</td>
<td>Q8005A (EAJ)</td>
</tr>
<tr>
<td>HP Bright White Inkjet Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (A2)</td>
<td>Q1446A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (A1)</td>
<td>Q1445A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C1860A (LN),</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C6035A (AEJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>841 mm (A0)</td>
<td>594 mm (A1)</td>
<td>Q1444A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C1861A (LN),</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C6036A (AEJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>914 mm (A0)</td>
<td>C6810A</td>
</tr>
<tr>
<td>HP Recycled Bond Paper</td>
<td>80</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (A2)</td>
<td>CG892A (E)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>CG889A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CG890A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG891A (EN)</td>
</tr>
<tr>
<td>HP Cockle-free Coated Paper</td>
<td>100</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>CG883A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CG884A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG885A (EN)</td>
</tr>
<tr>
<td>HP Cockle-free Heavyweight Coated</td>
<td>170</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>CG886A (EN)</td>
</tr>
<tr>
<td>Paper</td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CG887A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG888A (EN)</td>
</tr>
<tr>
<td>HP Universal Coated Paper</td>
<td>95</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1404A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1405A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1406A</td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (A2)</td>
<td>Q1443A (J)</td>
</tr>
</tbody>
</table>
### Roll paper (continued)

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Universal Heavyweight Coated Paper</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1412A (AEJN)</td>
</tr>
<tr>
<td>HP Universal Heavyweight Coated Paper</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1413A</td>
</tr>
<tr>
<td>HP Universal Heavyweight Coated Paper</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>1067 mm (42 in)</td>
<td>Q1414A (AEJN)</td>
</tr>
<tr>
<td>HP Heavyweight Coated Paper</td>
<td>131</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>C6029C (AEJN)</td>
</tr>
<tr>
<td>HP Heavyweight Coated Paper</td>
<td>131</td>
<td>30.5 m (100 ft)</td>
<td>914 mm (36 in)</td>
<td>C6030C</td>
</tr>
<tr>
<td>HP Heavyweight Coated Paper</td>
<td>131</td>
<td>30.5 m (100 ft)</td>
<td>1067 mm (42 in)</td>
<td>C6569C</td>
</tr>
<tr>
<td>HP Super Heavyweight Plus Matte Paper</td>
<td>210</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6626A (AEJN)</td>
</tr>
<tr>
<td>HP Super Heavyweight Plus Matte Paper</td>
<td>210</td>
<td>30.5 m (100 ft)</td>
<td>914 mm (36 in)</td>
<td>Q6627A (AEJN)</td>
</tr>
<tr>
<td>HP Super Heavyweight Plus Matte Paper</td>
<td>210</td>
<td>30.5 m (100 ft)</td>
<td>1067 mm (42 in)</td>
<td>Q6628A (AEJN)</td>
</tr>
<tr>
<td>HP Fluorescent Yellow Colored Paper</td>
<td>100</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1757A (E)</td>
</tr>
<tr>
<td>HP Yellow Colored Paper</td>
<td>92</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1760A (EN)</td>
</tr>
<tr>
<td>HP Yellow Colored Paper</td>
<td>92</td>
<td>45.7 m (150 ft)</td>
<td>90 m (295.3 ft)</td>
<td>Q6596A (E)</td>
</tr>
<tr>
<td>HP Technical Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2)</td>
<td>Q1440A (J)</td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q1439A (J)</td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3869A</td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>841 mm (33.11 in) (A0)</td>
<td>Q1438A (J)</td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>C3868A</td>
</tr>
<tr>
<td>HP Translucent Bond Paper</td>
<td>67</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3860A (AJN)</td>
</tr>
<tr>
<td>HP Translucent Bond Paper</td>
<td>67</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>C3859A (LN)</td>
</tr>
<tr>
<td>HP Vellum Paper</td>
<td>75</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3862A (N)</td>
</tr>
<tr>
<td>HP Vellum Paper</td>
<td>75</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>C3861A (LN)</td>
</tr>
<tr>
<td>HP Film (Technical and Graphic)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Clear Film</td>
<td>174</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>C3876A (AEJN)</td>
</tr>
<tr>
<td>HP Clear Film</td>
<td>174</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>C3875A</td>
</tr>
<tr>
<td>HP Clear Film</td>
<td>174</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>C3875A</td>
</tr>
<tr>
<td>HP Matte Film</td>
<td>160</td>
<td>38.1 m (125 ft)</td>
<td>610 mm (24 in)</td>
<td>51642A (AEJN)</td>
</tr>
<tr>
<td>HP Matte Film</td>
<td>160</td>
<td>38.1 m (125 ft)</td>
<td>914 mm (36 in)</td>
<td>51642B</td>
</tr>
<tr>
<td>HP White Matte Polyester Film</td>
<td>167</td>
<td>15.2 m (50 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1736A (AEN)</td>
</tr>
</tbody>
</table>
## Roll paper (continued)

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Vivid White Glossy Polyester Film</td>
<td>230</td>
<td>20.1 m (66 ft)</td>
<td>610 mm (24 in)</td>
<td>CG827A (EJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG828A (EJN)</td>
</tr>
<tr>
<td>HP Photographic Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Universal Instant-dry Gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6574A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6575A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6576A</td>
</tr>
<tr>
<td>HP Universal Instant-dry Semi-gloss</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6579A</td>
</tr>
<tr>
<td>Photo Paper</td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6580A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6581A</td>
</tr>
</tbody>
</table>

**TIP:** The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for more than two weeks, you should laminate them to achieve longer life.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Premium Plus Gloss Photo Paper</td>
<td>280</td>
<td>15.2 m (50 ft)</td>
<td>610 mm (24 in)</td>
<td>Q5488A</td>
</tr>
<tr>
<td>HP Premium Plus Satin Photo Paper</td>
<td>280</td>
<td>15.2 m (50 ft)</td>
<td>457 mm (18 in)</td>
<td>Q7920A</td>
</tr>
<tr>
<td>HP Universal High-gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1426A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1427A (AEJN)</td>
</tr>
<tr>
<td>HP Universal Semi-gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1420A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1421A (AEJN)</td>
</tr>
<tr>
<td>HP RC Matte Photo Paper</td>
<td>200</td>
<td>30.5 m (100 ft)</td>
<td>914 mm (36 in)</td>
<td>C7946A (AEN)</td>
</tr>
<tr>
<td>HP Backlit Material</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Reverse Print Matte Backlit Film</td>
<td>160</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>C7960A (AEJN)</td>
</tr>
<tr>
<td>HP Self-Adhesive Material and Laminate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Two-View Cling Film</td>
<td>240</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1914A (AEN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1915A (AEN)</td>
</tr>
<tr>
<td>HP Self-adhesive Indoor Paper</td>
<td>170</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>CG948A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1733A (EJN)</td>
</tr>
<tr>
<td>HP Matte Adhesive-back Polypropylene</td>
<td>225</td>
<td>21.3 m (70 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1908A (AEN)</td>
</tr>
<tr>
<td>HP Colorfast Adhesive Vinyl</td>
<td>328</td>
<td>12.2 m (40 ft)</td>
<td>914 mm (36 in)</td>
<td>C6775A</td>
</tr>
<tr>
<td>HP Adhesive-backed Polypropylene</td>
<td>128</td>
<td>50 m (164 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8044A (C)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q8884A (C)</td>
</tr>
<tr>
<td>HP Everyday Adhesive Matte Polypropylene</td>
<td>180</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>CG843A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CG824A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG825A</td>
</tr>
</tbody>
</table>
Roll paper (continued)

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Self-adhesive Gloss Polypropylene</td>
<td>180</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8834A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td></td>
<td>Q8835A</td>
</tr>
</tbody>
</table>

Sheet paper

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Bond and Coated Paper</td>
<td>90</td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q1961A (AEJN)</td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td></td>
<td>914 mm (36 in)</td>
<td>610 mm (24 in)</td>
<td>Q1962A (AEN)</td>
</tr>
<tr>
<td>HP Photographic Paper</td>
<td>280</td>
<td>483 mm (19 in)</td>
<td>330 mm (13 in)</td>
<td>Q5486A</td>
</tr>
<tr>
<td>HP Premium Plus Gloss Photo Paper</td>
<td></td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q5487A</td>
</tr>
<tr>
<td>HP Premium Plus Satin Photo Paper</td>
<td>280</td>
<td>483 mm (19 in)</td>
<td>330 mm (13 in)</td>
<td>Q5489A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q5490A</td>
</tr>
</tbody>
</table>

Order accessories

The following accessories can be ordered for your printer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Product number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet PostScript Upgrade</td>
<td>CN500B</td>
</tr>
<tr>
<td>HP DesignJet External Hard Disk</td>
<td>CN501A</td>
</tr>
<tr>
<td>HP DesignJet T790 24-in Spindle</td>
<td>C0783A</td>
</tr>
<tr>
<td>HP DesignJet T790 &amp; T1300 44-in Spindle</td>
<td>Q6709A</td>
</tr>
<tr>
<td>HP DesignJet T790 24-in Stand</td>
<td>Q6663A</td>
</tr>
<tr>
<td>HP Jetdirect 635n IPv6/IPsec Print Server</td>
<td>J7961A</td>
</tr>
</tbody>
</table>

Introduction to the accessories

PostScript upgrade

The PostScript upgrade enables a T790, T795, or T1300 to print the same file types that a T790 PS or T1300 PS can print. The PostScript upgrade can be plugged into the printer's USB host.

Spindle

With extra spindles, you can change rapidly from one paper type to another.

Jetdirect print server

Jetdirect print servers support extra connectivity and security options beyond those provided in the standard Ethernet interface built into the printer.
External hard disk (T790 PS and T1300 series)

The external hard disk replaces the printer's internal hard disk as a repository of personal data (the job queue, including temporary files, accounting and so on). The external hard disk can be removed and stored in a secure place when the printer has been turned off.

You cannot use the external hard disk to share files between HP DesignJets or to download files from any computer to the printer.

For more information about the use of this accessory, see Troubleshooting on page 127.

⚠️ CAUTION: The external hard disk has been designed to be used with HP DesignJets only. It may be damaged if you attempt to connect it to other devices.

⚠️ NOTE: The printer's USB device port is incompatible with the external hard disk. While the external hard disk is connected, the USB device port is disabled, it is not recognized by your computer's plug & play subsystem and you cannot send jobs from your computer to the USB port. However, the USB host port still works, and you can print jobs from a USB flash drive. If you require a point-to-point connection between your computer and printer, without network infrastructure, please use a standard Ethernet cable and install the driver from the HP Start-up Kit DVD in network mode.

Installation

1. Attach the hard disk holder to the left leg of the stand using the adhesive patch on the holder (press firmly).
2. Place the external hard disk into the holder and connect the USB cable to it as shown.
3. Ensure that the printer is turned on.
4. At the front panel, press 🔄 then 🔄, then Setup > External hard disk > Install external hard disk.
5. The front panel displays Connect external hard disk or press Cancel to abort.
6. Connect the other end of the USB cable to the rear of the printer where you see this symbol: 🌐.
7. The front panel displays *Select Secure Disk Erase Level or Cancel to abort.*

8. Choose the SDE level to be applied to the internal hard disk.

Secure Disk Erase provides three different levels of security:

- **Insecure Mode** or **Non-Secure Fast Erase**: All pointers to the information are erased. The information itself remains on the hard disk until the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains on the disk, it is difficult for most people to access, but may be accessed using software designed for the purpose. This is the normal method in which files are erased on most computer systems; it is the fastest method but the least secure.

- **1-Pass Mode** or **Level 1**: All pointers to the information are erased, and the information itself is also overwritten with a fixed character pattern. This method is slower than Insecure Mode/Non-Secure Fast Erase, but more secure. It may still be possible to access fragments of the erased information by using special tools to detect residual magnetic traces.

- **5-Pass Mode** or **Level 5**: All pointers to the information are erased, and the information itself is repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the slowest method, but the most secure; it meets the US Department of Defense 5220-22.m requirements for clearing and sanitization of disk media. This is the default security level when using Secure Disk Erase. If you choose this level, the process can take up to six hours.

9. The front panel displays *Press OK to continue with the external hard disk installation or Cancel to abort. The printer will restart during the process.*

10. Press OK.

11. The front panel displays *External hard disk installation in progress. Please do not remove the USB disk. This process will take a few minutes and will reboot the printer.*

12. The printer restarts.

13. The front panel displays a message in English, but you should wait until it displays *Ready.*

If you connected the USB cable to the printer without using the front panel first, please follow these steps:

1. The front panel displays *External hard disk detected. Press OK to continue with External Hard Disk Installation or Cancel to abort.*

2. Press OK.

3. Go to step 7 above.

**Uninstallation**

1. Ensure that the printer is turned on.

2. At the front panel, press **Setup**, then **External hard disk** > **Uninstall external hard disk.**

3. Choose the Secure Disk Erase (SDE) level for the external hard disk.

4. The front panel displays *External hard disk: Press OK to continue with External Hard Disk uninstallation or Cancel to abort. The printer will restart.*

5. Press OK.

6. The front panel displays *External hard disk: Remove External Hard Disk.*

7. Remove the external hard disk.

8. The printer restarts.
Troubleshooting

- The use of the external hard disk by any device other than an HP DesignJet is not supported and may cause severe damage to the hard disk, which is not covered by the warranty.

- If the external hard disk has been previously inserted into a different HP DesignJet, the front panel displays: **External hard disk not valid for this machine. Power off, plug in the correct hard disk and power on again.**

  If you use an external hard disk with one HP DesignJet and then want to connect it to another:
  
  — If the HP DesignJet has already had an external hard disk installed, you must uninstall it from the first HP DesignJet and then install it on the HP DesignJet you want to use.
  
  — If the HP DesignJet has no external hard disk installed, the installation process starts and the contents of the external hard disk are deleted.

- The printer’s USB device port is incompatible with the external hard disk. While the external hard disk is connected, the USB device port is disabled, it is not recognized by your computer’s plug & play subsystem and you cannot send jobs from your computer to the USB port. However, the USB host port still works, and you can print jobs from a USB flash drive.

  If you require a point-to-point connection between your computer and printer, without network infrastructure, please use a standard Ethernet cable and install the driver from the HP Start-up Kit DVD in network mode.

  If you later disconnect the external disk drive, and resume use of the internal disk drive, you will be able to use the USB device port again.

- The external hard disk should not be removed while the printer is on. If you remove it, the front panel displays the following error message (64:1:01): **USB HDD accessory disconnected. Please reconnect it and restart the printer.**

  If you turn on the printer while the external hard disk is not connected, the same message is displayed.

- If the external hard disk is lost or broken, you must reconfigure the printer to use the internal hard disk.

  Turn on the printer. Wait until you see all of the fixed icons at the left and right of the front panel displayed simultaneously. Then press three icons in the correct sequence: , then , then .

  The front panel displays: **Machine configured to use external hard disk. Do you want to revert the configuration to internal hard disk? Press OK to continue.**

  Press **OK**.

  The front panel displays: **Machine reconfigured to use internal hard disk. Press OK to reboot the machine.**

  Press **OK**. The printer restarts, and you can then use the printer with its internal hard drive.
Troubleshooting paper issues

- The paper cannot be loaded successfully
- The paper type is not in the driver
- The printer printed on the wrong paper type
- An “on hold for paper” message (T1300 series)
- The roll paper will not advance
- The paper has jammed
- A strip stays on the output tray and generates jams
- The printer displays out of paper when paper is available
- Prints do not fall neatly into the basket
- The sheet stays in the printer when the print has been completed
- The paper is cut when the print has been completed
- The cutter does not cut well
- The roll is loose on the spindle
- Recalibrate the paper advance
The paper cannot be loaded successfully

- Ensure no paper is loaded.
- Ensure the paper is far enough inside the printer, you should feel the printer grab the paper.
- Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-panel display. The printer automatically attempts to straighten the paper.
- The paper may be crumpled, or warped, or may have irregular edges.

General unsuccessful roll load issues

- If the paper does not load, the leading edge of the paper may not be straight or clean and needs to be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.
- Ensure the roll ends are tight against the spindle ends.
- Check that the spindle is correctly inserted.
- Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
- Check that all roll end plugs have been removed.
- Check that the paper is wound tightly on the roll.
- Do not touch the roll or paper at during the alignment process.
- When loading a roll on the T1300 series, the roll cover must remain open until the front panel prompts you to close it.
- When loading the upper roll (the only roll on the T790/T795), avoid inserting the paper into the cut sheet slot.

Unsuccessful roll load

If the paper has not been inserted straight, the front panel displays the following instructions.

1. When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to straighten the roll.
2. When prompted by the front-panel display, lower the blue lever. The printer checks the alignment. If the roll is aligned, the T1300 printer series prompts you to close the roll cover, and you are now ready to print.

If the roll is still not aligned, the front panel displays an error and instructions to start again.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll from the end of the spindle until the edge is removed from the printer.
NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load

- Guide the sheet, especially thick papers, when the printer initially feeds the sheet.
- Ensure that the sheet is aligned with the reference line on the roll cover.
- Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel display.
- Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, please follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the sheet from the front of the printer.

Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

<table>
<thead>
<tr>
<th>Front-panel message</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close the roll cover when the paper load is finished</td>
<td>Close the roll cover when the paper load is finished.</td>
</tr>
<tr>
<td>Lever lifted</td>
<td>During the load process the blue lever was lifted. This prevents the printer from loading the paper. Follow the instructions on the front-panel display.</td>
</tr>
<tr>
<td>Paper incorrectly loaded</td>
<td>The paper has not been loaded correctly. Lift the blue lever, remove the paper and lower the lever.</td>
</tr>
<tr>
<td>Paper loaded with too much skew</td>
<td>During the paper load process the printer detected that the paper had too much skew. Follow the instructions on the front-panel display.</td>
</tr>
<tr>
<td>Paper loose around core</td>
<td>The end of the roll has become loose around the core. Tighten the paper to the core or insert a new roll.</td>
</tr>
<tr>
<td>Paper not detected</td>
<td>During the paper load process the printer did not detect any paper. Ensure the paper is inserted fully and is not transparent.</td>
</tr>
<tr>
<td>Roll cover closed during paper load process</td>
<td>Do not close the roll cover until you are prompted to do so by the front panel.</td>
</tr>
<tr>
<td>Sheet too big</td>
<td>During the load process the printer has detected that the sheet of paper is either too wide or too long to be loaded correctly. Press to stop the load process. See Functional specifications on page 175.</td>
</tr>
<tr>
<td>Sheet too small</td>
<td>During the load process the printer detected that the sheet of paper is too narrow or too short to be loaded in the printer. Press to stop the load process. See Functional specifications on page 175.</td>
</tr>
<tr>
<td>Upper roll load and paper is inserted through the single sheet path</td>
<td>Avoid inserting roll paper into the cut sheet slot.</td>
</tr>
</tbody>
</table>

The paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver, however, you must identify whether your paper is transparent or translucent, glossy or matte.

NOTE: For glossy paper, it is important to use a glossy paper type, as matte black ink does not print well on glossy paper.
Transparent or translucent paper

If your paper is a transparent film (for example, a transparency), select paper type **Film > Transparent/Clear film**.

If your paper is a translucent paper (for example, technical paper), select paper type **Technical paper > Natural Tracing Paper, Vellum or Translucent bond**.

Glossy paper

If your paper is a photo paper, use the **Photo Paper** category. For glossy or high-gloss paper select paper type **Photo Gloss Paper**. For Semi-gloss, Satin, Pearl or Luster finishes, select paper type **Semi-gloss/Satin Paper**.

To increase gamut on photo paper, select paper type **HP Universal High-gloss Photo Paper** or **HP Universal Semi-gloss Photo Paper**, depending on the finish.

Matte Paper

Your paper type selection for matte paper depends on the paper’s ink absorption capacity. To select a paper category and type, first identify if your paper is general purpose or photographic. Then select the recommended paper types.

**General-purpose paper**

- For natural tracing papers, select paper type **Natural Tracing Paper < 65 g/m²** or **Natural Tracing Paper > 65 g/m²**, depending on the weight of the paper.
- For thin papers (< 90 g/m²) uncoated papers (for example plain paper or bright white paper) select paper type **Bond and Coated Paper > Plain Paper**.
- For light coated papers (< 110 g/m²), select paper type **Bond and Coated Paper > HP Coated Paper**.
- For heavyweight coated papers (< 200 g/m²), select paper type **Bond and Coated Paper > Heavyweight Coated Paper**.
- For cockle-free very thick coated papers (> 200 g/m²), select paper type **Bond and Coated Paper > Super Heavyweight Coated Paper**.

**Photographic paper**

For photographic paper, select paper type **Photo Paper > Photo Matte Paper**.

**Black ink is easily removed when touched**

This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select paper type **Photo Paper > Photo Gloss Paper**.

**After printing, the paper has wrinkles or there is too much ink**

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories from thinnest to thickest are:

- Plain Paper
- Coated Paper
- Heavyweight Coated Paper
- Super Heavyweight Coated Paper

For other image quality problems, see Troubleshooting print-quality issues on page 140.
The printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have *Any* selected for the Paper Type in the printer driver. When *Any* is selected the printer will print immediately on whichever paper is loaded. Load your desired paper, see Paper handling on page 32, and select your paper type specifically in the driver.

- **In the Windows driver dialog:** select the Paper/Quality tab, then select your paper type from the Paper Type list.
- **In the Mac OS Print dialog (non-PostScript printers):** select the Paper/Quality panel, then select your paper type from the Paper Type list.
- **In the Mac OS PostScript Print dialog (PostScript printers):** select the Paper/Quality panel, then select your paper type from the Paper Type list.

**NOTE:** *Any* is the driver default.

An “on hold for paper” message (T1300 series)

Based on a set of conditions that you can set when sending a job (see Paper mismatch action on page 22), the printer will decide which of the loaded rolls of paper is more suitable to print the job. If there is no roll of paper available that meets all the conditions, the printer will put the job on hold for paper. You can manually resume the job, forcing it to print on a paper other than the one originally specified, otherwise it will stay on hold.

Which criteria are used to decide on which roll a job will be printed?

When a user sends a job, the desired paper type can be set (in the driver or in the Embedded Web Server). The printer will print the job on a roll of paper of the chosen paper type that is large enough to print the drawing without clipping. If there is more than one roll on which the job could be printed meeting all the criteria, the roll will be chosen according to your preferences. These can be set from the front panel: see Roll switching options on page 23.

When is a job put on hold for paper?

If the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 22), a job is put on hold for paper in the following cases:

- The paper type that has been selected by the user is not currently loaded on the specified roll—or on either of the rolls, if no roll has been specified.
- The paper type that has been selected by the user is loaded on the specified roll, but the drawing is too large to fit on the roll—or on either of the rolls, if no roll has been specified.

If I load a new roll of paper, will jobs that were on hold for paper be automatically printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper that could be printed on the loaded roll.

I don’t like jobs being put on hold for paper. Can I prevent it?

Yes, this can be done from the front panel: see Paper mismatch action on page 22.
I set the option “Paper mismatch action” to Print anyway, but some jobs are still put on hold

If the Show print preview option is selected in the driver or the Embedded Web Server, jobs are put on hold until you have checked the preview and resumed the job. Check that the Show print preview option is not checked in the driver, and that there are no pending preview windows waiting for confirmation to continue printing.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put on hold for paper

Margins are managed in different ways depending on the file type:

- For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm (36 in) HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for paper.

- For other file formats, such as PostScript, PDF, TIFF or JPEG, the printer assumes that margins need to be added outside the drawing (as, in many cases, these formats are used for photographs and other images that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs to add margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would cause the job to be put on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip contents by margins option can be used. This option will force the margins to be set inside of the drawing, so a 914 mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper without being put on hold. However, if there is no white space already included in the drawing's borders, some contents could be clipped because of the margins.

The roll paper will not advance

If you have pushed the printer up against a wall, the roll may be touching the wall at the rear of the printer. Use the wall spacers to ensure a minimum distance between printer and wall. See The wall spacers on page 7.

The paper has jammed

When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.

1. Power off the printer at the front panel and also switch it off at the rear.
2. Open the window.

3. Try to move the printhead carriage out of the way.

4. Lift the blue lever as far up as it will go.
5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

**CAUTION:** Do not move the paper sideways, as it could damage the printer.

6. Rewind the roll. If the paper is stuck and cannot be rewound further, cut it from the roll.

7. Remove all pieces of paper from the rear of the printer.
8. Lower the blue lever.

9. Close the window.

10. Switch on the printer.

11. Reload the roll, or load a new sheet see Paper handling on page 32.

**NOTE:** If you find that there is still some paper causing an obstruction within the printer, restart the procedure and carefully remove all pieces of paper.

**A strip stays on the output tray and generates jams**

If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a full-bleed print or after the front panel option Form feed and cut has been used, the cut strip remains in the output tray. Only when the printer is not printing, reach into the tray and remove the strip.
The printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket

- Ensure the basket is correctly installed.
- Ensure the basket is open.
- Ensure the basket not full.
- Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or remove prints manually as they are completed.

The sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 41. If the paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the automatic cutter is disabled, use the Form feed and cut option in the front panel, see Feed and cut the paper on page 42.

The paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying time on page 41. You can disable the cutter, see Turn the automatic cutter on and off on page 42.

The cutter does not cut well

By default the printer is set to automatically cut the paper after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles.

The roll is loose on the spindle

The roll may need to be replaced or reloaded.
Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper placement of dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the paper advances. See Troubleshooting print-quality issues on page 140 for steps to determine if paper advance calibration will solve your issue.

You can check the paper advance calibration status of the currently loaded paper at any time by pressing and then on the front panel. The status may be one of the following.

- DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers in the Front Panel have been optimized by default and unless you experience image quality problems in your printed image such as banding or graininess it is not recommended to recalibrate the paper advance.

- OK: This status indicates that the loaded paper has been calibrated before. However you may need to repeat the calibration if you experience image quality problems such as banding or graininess in your printed image.

NOTE: Whenever you update the printer’s firmware, the paper advance calibration values are reset to factory default, see Update the firmware on page 117.

CAUTION: Transparent papers and films must be calibrated by pressing, then, then Image Quality Maintenance > Paper advance calibration > Adjust paper advance, from step four in Recalibrating the paper advance procedure.

Recalibrating the paper advance procedure

1. From the front panel, press, then, then Image Quality Maintenance > Paper advance calibration > Calibrate paper advance. The printer automatically recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the paper advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return to the default calibration, see Return to default calibration on page 139.

3. If you would like to fine-tune the calibration or are using a transparent paper, press, then, then Image Quality Maintenance > Paper advance calibration > Adjust paper advance.
4. Select the percentage of change from \(-100\%\) to \(+100\%\). To correct light banding, decrease the percentage.

To correct dark banding, increase the percentage.

5. Press **OK** on the front panel, to save the value.

6. Wait until the front panel displays the status screen and reprint your print.

**Return to default calibration**

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, press **Image Quality Maintenance** > **Paper advance calibration** > **Reset paper advance**.

2. Wait until the front panel displays the operation has completed successfully.
17 Troubleshooting print-quality issues

- General advice
- Print quality troubleshooting wizard
- Horizontal lines across the image (banding)
- Lines are too thick, too thin or missing
- Lines appear stepped or jagged
- Lines print double or in the wrong colors
- Lines are discontinuous
- Lines are blurred
- Line lengths are inaccurate
- The whole image is blurry or grainy
- The paper is not flat
- The print is scuffed or scratched
- Ink marks on the paper
- Black ink comes off when you touch the print
- Edges of objects are stepped or not sharp
- Edges of objects are darker than expected
- Horizontal lines at the end of a cut sheet print
- Vertical lines of different colors
- White spots on the print
- Colors are inaccurate
- Colors are fading
- The image is incomplete (clipped at the bottom)
- The image is clipped
- Some objects are missing from the printed image
- A PDF file is clipped or objects are missing
- The Image Diagnostics Print
- If you still have a problem
General advice

When you have any print-quality problem:

- To achieve the best performance from your printer, use only genuine manufacturer’s supplies and accessories, whose reliability and performance have been thoroughly tested to give trouble-free performance and best-quality prints. For details of recommended papers, see Order paper on page 120.

- Make sure that the paper type selected in the front panel is the same as the paper type loaded into the printer (see View information about the paper on page 40). At the same time, check that the paper type has been calibrated. Also make sure that the paper type selected in your software is the same as the paper type loaded into the printer.

  CAUTION: If you have the wrong paper type selected, you could experience poor print quality and incorrect colors, and perhaps even damage to the printheads.

- Check that you are using the most appropriate print-quality settings for your purposes (see Printing on page 46). You are likely to see lower print quality if you have moved the print-quality slider to the ‘Speed’ end of the scale, or set the custom quality level to Fast.

- Check that your environmental conditions (temperature, humidity) are in the recommended range. See Environmental specifications on page 177.

- Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain the ink cartridges on page 116.

Print quality troubleshooting wizard

The Print Quality Troubleshooting Wizard can help with the following problems:

- Horizontal lines across the image (banding)
- The whole image is blurry or grainy
- Lines are too thick, too thin or missing
- Colors are inaccurate

To start the wizard:

- From the HP Utility for Windows: go to the Support tab, and select Print quality troubleshooting.
- From the HP Utility for Mac OS: select Print quality troubleshooting in the Support group.
- From the Mac OS Print dialog: go to the Services panel, select Device Maintenance, then select Print quality troubleshooting from the list of maintenance tasks.
- From the Embedded Web Server: go to the Support tab, select Troubleshooting, then select Print quality troubleshooting.
Alternatively, or if you have other print quality problems, you can continue reading this chapter.

**Horizontal lines across the image (banding)**

If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 40.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 46). In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality settings, you may wish to reprint your job at this point in case the problem has been solved.

3. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 152.

4. If the printheads are working correctly, go to the front panel and press and then to see the paper advance calibration status. If the status is DEFAULT, try performing paper advance calibration: see Recalibrate the paper advance on page 138.

If the problem persists despite all the above actions, contact your customer service representative for further support.
Lines are too thick, too thin or missing

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 40.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 46). Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail option (if available). You may wish to reprint your job at this point in case the problem has been solved.

3. If the resolution of your image is greater than the printing resolution, you may notice a loss of line quality. If you are using the PCL or the HP-GL/2 and HP RTL driver for Windows, you can find the Max. Application Resolution option in the driver dialog’s Advanced tab, under Document Options > Printer Features. If you change this option, you may wish to reprint your job at this point in case the problem has been solved.

4. If lines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics Print on page 152.

5. If the problem remains, go to the front panel and press and then to see the printhead alignment status. If the status is PENDING, you should align the printheads. See Align the printheads on page 159. After alignment, you may wish to reprint your job in case the problem has been solved.

6. Go to the front panel and press and then to see the paper advance calibration status. If the status is DEFAULT, you should perform paper advance calibration: see Recalibrate the paper advance on page 138.

If the problem persists despite all the above actions, contact your customer service representative for further support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are using to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 46.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if available).
Lines print double or in the wrong colors

This problem can have various visible symptoms:

- Colored lines are printed double, in different colors.

- The borders of colored blocks are wrongly colored.

To correct this kind of problem:

1. Reseat the printheads by removing them and then reinserting them. See Remove a printhead on page 109 and Insert a printhead on page 112.

2. Align the printheads. See Align the printheads on page 159.

Lines are discontinuous

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 46.

2. Reseat the printheads by removing them and then reinserting them. See Remove a printhead on page 109 and Insert a printhead on page 112.

3. Align the printheads. See Align the printheads on page 159.
Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing. See Environmental specifications on page 177.

2. Check that the paper type selected in the front panel is the same as the paper type you are using. See View information about the paper on page 40.

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus Matte Paper.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

5. If you are using glossy paper, try changing to a different type of glossy paper.

6. Align the printheads. See Align the printheads on page 159.

Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes, you can try to improve line length accuracy in the following ways.

1. Print on HP Matte Film, for which your printer’s line length accuracy is specified. See Functional specifications on page 175.

   Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner or thicker than HP Matte Film will reduce line length accuracy.

2. Set the Print Quality slider to Quality.

3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance on page 138.
The whole image is blurry or grainy

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 40.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 46). In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality settings, you may wish to reprint your job at this point in case the problem has been solved.

4. Go to the front panel and press and then to see the printhead alignment status. If the status is PENDING, you should align the printheads. See Align the printheads on page 159. After alignment, you may wish to reprint your job in case the problem has been solved.

5. Go to the front panel and press and then to see the paper advance calibration status. If the status is DEFAULT, you should perform paper advance calibration: see Recalibrate the paper advance on page 138.

If the problem persists despite all the above actions, contact your customer service representative for further support.

The paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes saturated with ink.
1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 40.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

The print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after printing, depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

- Handle prints carefully.
- Avoid stacking prints on top of each other.
- Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively, leave a sheet of paper in the basket so that freshly printed sheets do not make direct contact with the basket.

Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printheads move over the paper, the printheads may come into contact with the paper and smear the printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Press \( \text{ } \) and also cancel the job from your computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 40.

2. Use a recommended paper type (see Order paper on page 120) and the correct print settings.

3. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect performance.
4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super Heavyweight Plus Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6. Try to increase the margins by relocating the image to the center of the page using your software application.

**Ink marks on the back of the paper**

This can happen after a lot of borderless printing, especially with non-standard paper sizes. Ink residues on the platen are likely to mark the back of the paper.

Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

**Black ink comes off when you touch the print**

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select Photo Glossy Paper as the paper type (in the Photo Paper category).

**Edges of objects are stepped or not sharp**

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the print-quality slider to Quality in the driver dialog, select the custom print-quality options, and try setting the quality level to Normal. See Printing on page 46.

**Edges of objects are darker than expected**

If edges of objects seem darker than expected, and you have already set the print-quality slider to Quality in the driver dialog, select the custom print-quality options, and try setting the quality level to Normal. See Printing on page 46.
Horizontal lines at the end of a cut sheet print

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the paper. You may see some very thin horizontal lines across the print.

To avoid this problem:

1. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 152.
2. Consider printing with roll paper.
3. Consider using larger margins around your image.

Vertical lines of different colors

If your print has vertical bands of different colors along it:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated Paper and HP Super Heavyweight Paper. See Order paper on page 120.
2. Try using higher print-quality settings (see Printing on page 46). For instance, if you have set the Print Quality slider to Speed, try setting it to Quality.

White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material. To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
2. Always keep the cover of your printer closed.
3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 40. Also, press and then to check the color calibration status. If the status is PENDING or OBSOLETE, you should perform color calibration: see Color calibration on page 70. If you have made any changes, you may wish to reprint your job in case the problem has been solved.
2. Check that you are printing on the correct side of the paper.
3. Check that you are using appropriate print-quality settings (see Printing on page 46). If you have selected the Speed or Fast options, you may not get the most accurate colors. If you change the print-quality settings, you may wish to reprint your job at this point in case the problem has been solved.

4. If you are using Application Color Management, check that the color profile you are using corresponds to the selected paper type and print-quality settings. If you have doubts about which color settings to use, see Color management on page 69.

5. If the problem consists of color differences between your print and your monitor, please follow the instructions in the “How to calibrate your monitor” section of the HP Color Center. At this point, you may wish to reprint your job in case the problem has been solved.

6. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 152.

7. Try using the color adjustment options to produce the colors you want. See Color adjustment options on page 73.

If the problem persists despite all the above actions, contact your customer service representative for further support.

Color accuracy using EPS or PDF images in page layout applications

Page layout applications such as Adobe InDesign and QuarkXPress do not support color management of EPS, PDF or grayscale files.

If you have to use such files, try to ensure that the EPS, PDF or grayscale images are already in the same color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if your final goal is to print the job in a press that follows the SWOP standard, convert the image into SWOP when you create it.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of prints (depending on the type of lamination) with all paper types. For more information, consult your laminate provider.

The image is incomplete (clipped at the bottom)

- Did you press before all the data were received by the printer? If so, you have ended the data transmission and will have to print the page again.
- The I/O timeout setting may be too short. This setting determines how long the printer waits for the computer to send more data, before deciding that the job is finished. From the front panel, increase the I/O timeout setting to a longer period and then send the print again. Press , then , then Setup > Connectivity > Advanced > Select I/O timeout.
- There may be a communications problem between your computer and the printer. Check your USB or network cable.
- Check to make sure that your software settings are correct for your current page size (for example, long-axis prints).
- If you are using network software, make sure it has not timed out.
The image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the printable area as understood by your software. You can often identify this kind of problem before printing by previewing your print (see Preview a print on page 54).

- Check the actual printable area for the paper size you have loaded.
  
  \[
  \text{printable area} = \text{paper size} - \text{margins}
  \]

- Check what your software understands to be the printable area (which it may call "printing area" or "imageable area"). For example, some software applications assume standard printable areas that are larger than those used in this printer.

- If you have defined a custom page size with very narrow margins, the printer may impose its own minimal margins, clipping your image slightly. You may want to consider using a larger paper size, or borderless printing (see Select margins options on page 52).

- If your image contains its own margins, you may be able to print it successfully by using the \textit{Clip Contents by Margins} option (see Select margins options on page 52).

- If you are trying to print a very long image on a roll, check that your software is capable of printing an image of that size.

- You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.

- If necessary, reduce the size of the image or document in your software application, so it fits between the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe Photoshop, Adobe Illustrator and CorelDRAW, use an internal 16-bit coordinate system which means that they cannot handle an image of more than 32,768 pixels.

\textbf{NOTE:} An image 32,768 pixels long would print at a length of 1.39 m (54.61 in) if you select Best or Quality in the driver, 2.78 m (109.23 in) if you select Fast, Normal or Speed in the driver.

If you try to print an image larger than this from these applications, the bottom of the image may be clipped. To print the whole image, try these suggestions:

- Try using the PostScript printer driver to print your job, if you have not already tried it.

- The Windows HP-GL/2 and HP RTL driver dialog includes an option called \textit{Max. application resolution}, which enables you to print successfully in this situation. You will not normally need to change the default setting, which is \textit{Auto}. However, you can find the option in the Advanced tab, under Document Options > Printer Features.

- Save the file in another format, such as TIFF or EPS, and open it with another application.

- Use a RIP to print the file.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific workflows there may be issues that can lead to some objects missing from the output. Here are some suggestions to help you to avoid this problem.

- Try using the PostScript printer driver to print your job, if you have not already tried it.

- Select a smaller page size and scale to the desired final page size in the driver or in the front panel.

- Save the file in another format, such as TIFF or EPS, and open it with another application.
- Use a RIP to print the file.
- Reduce the resolution of bitmap images in your application software.
- Select a lower print quality in order to reduce the resolution of the printed image.

**NOTE:** If you are working under Mac OS, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to solve the problem.

**A PDF file is clipped or objects are missing**

In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some objects when printing with the HP-GL/2 and HP RTL driver at high resolution. In order to avoid such problems, upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From version 7 onwards, these problems should be solved.

**The Image Diagnostics Print**

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It helps you to check the performance of the printheads that are currently installed in your printer, and whether any printhead suffers from clogging or other problems.

To print the Image Diagnostics Print:

1. Use the same paper type that you were using when you detected a problem.
2. Check that the selected paper type is the same as the paper type loaded into the printer. See View information about the paper on page 40.
3. At the printer's front panel, press , then , then select Image Quality Maintenance > Print diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance.

- Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the print quality that you will get from each color.
- Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part complements the first, and aims more specifically to detect how many faulty nozzles each printhead has.

Please look carefully at the print. The names of the colors are shown above the rectangles and in the center of the patterns of dashes.
First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without any horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of the dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a gray printhead in a good state:

And here is an example of the same printhead in a bad state:
Corrective action

1. Clean any faulty printheads (see Clean the printheads on page 157). Then reprint the Image Diagnostics Print to see whether the problem has been solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see whether the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see Clean the printheads on page 157). You could also try reprinting your current print job, in case it now prints satisfactorily.

4. If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you when this is necessary, but it may be worth trying even if the printer has not suggested it. See Clean the printhead drop detector on page 157.

5. If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges and printheads on page 105), or contact HP Support (see Contact HP Support on page 173).

If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some further things that you can do:

- Try using a higher print-quality option. See Printing on page 46.

- Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded from http://www.hp.com/go/T790/drivers or http://www.hp.com/go/T1300/drivers.

- If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with the RIP.

- Check that your printer’s firmware is up to date. See Update the firmware on page 117.

- Check that you have the right settings in your software application.
18 Troubleshooting ink cartridge and printhead issues

- Cannot insert an ink cartridge
- Ink cartridge status messages
- Cannot insert a printhead
- The front-panel display recommends reseating or replacing a printhead
- Clean the printheads
- Clean the printhead drop detector
- Align the printheads
- Printhead status messages
Cannot insert an ink cartridge

1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.
3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side up and readable.

⚠️ CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

- **OK**: the cartridge is working normally, with no known problems.
- **Missing**: there is no cartridge present, or it is not correctly connected to the printer.
- **Low**: the ink level is low.
- **Very low**: the ink level is very low.
- **Empty**: the cartridge is empty.
- **Reseat**: you are recommended to remove the cartridge and then reinsert it.
- **Replace**: you are recommended to replace the cartridge with a new cartridge.
- **Altered**: there is something unexpected about the cartridge's status.
- **Expired**: it is past the cartridge's expiration date.

Cannot insert a printhead

1. Check that you have the correct type of printhead (model number).
2. Check that you have removed the two orange protective caps from the printhead.
3. Check that the colored label on the printhead is the same color as the label on the slot.
4. Check that the printhead is correctly oriented (compare with the others).
5. Check that you have correctly closed and latched the printhead cover, see Insert a printhead on page 112.

The front-panel display recommends reseating or replacing a printhead

1. From the front panel, turn the power off then on.
2. Check the front-panel display message, if it shows the ready message, the printer is ready to print. If the problem remains continue with the next step.
3. Remove the printhead, see Remove a printhead on page 109.
4. Clean the electrical connections on the backside of the printhead with a lint free cloth. You can carefully use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

⚠️ **CAUTION:** This is a delicate process and may damage the printhead. Do not touch the nozzles on the bottom side of the printhead, especially not with any alcohol.

5. Reinsert the printhead, see [Insert a printhead on page 112](#).

6. Check the front-panel display message. If the problem remains, try a new printhead.

---

### Clean the printheads

As long as the printer is kept turned on, automatic cleaning is performed periodically. This ensures there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have not already done so, please see [The Image Diagnostics Print on page 152](#) before proceeding.

To clean the printheads, go to the front panel and press 📢, then 📜, then **Image Quality Maintenance > Clean printheads**. If you have gone through the Image Quality Diagnostic print process, you know which colors are failing. Select the pair of printheads which contain the failing colors. If you are not sure which colors to clean, you can also select to clean all printheads. Cleaning all printheads takes about nine minutes. Cleaning a single pair of printheads takes about six minutes.

⚠️ **NOTE:** Cleaning all printheads uses more ink than cleaning a single pair.

---

### Clean the printhead drop detector

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block the sensor print-quality is affected.

When the front panel displays a warning message that the clean process is needed, you are recommended to clean the printhead drop detector. If you do not clean the printhead drop detector immediately, the printer continues working normally, however, the front panel display continues to show the warning.

⚠️ **CAUTION:** Wear gloves to avoid getting ink on your hands.
1. Turn off the printer at the front panel.

2. To avoid an electric shock, switch the printer off and unplug it.

3. Open the window.

4. Find the printhead drop detector beside the stored printhead carriage.
5. Remove any debris blocking the printhead drop detector.

6. With a dry, lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

7. Close the window.

8. Plug in and switch on the printer.

9. Power the printer on at the front panel.

**Align the printheads**

Precise alignment between printheads is essential for accurate colors, smooth color transitions and sharp edges in graphical elements. Your printer has an automatic printhead alignment process which runs whenever a printhead has been accessed or replaced.

In cases where the paper has jammed or you are experiencing problems with color accuracy, see Color management on page 69; you may need to align the printheads.
NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the realignment procedure by pressing , then , then Image Quality Maintenance > Align printheads.

CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure

1. If the realignment process is running and the wrong paper is loaded, press on the front panel.

   CAUTION: Do not print if the realignment process has been canceled. You can restart the alignment by pressing , then , then Image Quality Maintenance > Align printheads.

2. Load the paper you wish to use, see Paper handling on page 32. You can use a roll that is at least 610 mm (24 in) wide or a cut sheet that is A2 landscape or larger.

   CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

3. Remove and re-insert all the printheads, see Remove a printhead on page 109 and Insert a printhead on page 112. This starts the printhead alignment procedure.

4. Ensure the window is closed, as a strong light source near the printer during printhead realignment can affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete before using the printer.

   NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel display shows any errors in the process.

Image Quality Maintenance menu procedure

1. Load the paper you wish to use, see Paper handling on page 32. You can use a roll or cut sheet, however, it must be A3 landscape or larger (420 by 297 mm).

   CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

2. From the front panel, press , then , then Image Quality Maintenance > Align printheads. The printer checks to see if it has enough paper to run the realignment.
3. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern. Ensure the window is closed, as a strong light source near the printer during printhead realignment can affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process complete before using the printer.

Scanning errors during alignment

If the alignment process fails, a Scanning problems message appears on the front panel. This means that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment should be repeated before printing with good image quality. The problem may be due to:

- The paper used was not valid, repeat the alignment with valid paper
- Printhead health problems, clean printheads, see Clean the printheads on page 157
- The alignment was done with the window open, repeat the alignment with the window closed

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed, there may be a failure in the scanning system needing repair; or the printheads, although clean, may not work and need to be replaced.

Printhead status messages

These are the possible printhead status messages:

- **OK**: the printhead is working normally, with no known problems
- **Missing**: there is no printhead present, or it is not correctly installed in the printer.
- **Test printhead separately**: you are recommended to test the printheads individually to find the failing printhead. Remove all the printheads and insert them alone one by one, closing the latch and the carriage cover after every insertion. The front-panel display indicates the failing one showing the reseat or replace message.
- **Reseat**: you are recommended to remove the printhead and then reinsert it. If that fails, clean the electrical connections, see The front-panel display recommends reseating or replacing a printhead on page 156. If that fails, replace the printhead with a new printhead, see Remove a printhead on page 109 and Insert a printhead on page 112.
- **Replace**: the printhead is failing. Replace the printhead with a working printhead, see Remove a printhead on page 109 and Insert a printhead on page 112.
- **Replacement incomplete**: a printhead replacement process has not completed successfully, re-launch the replacement process and let it finish completely (it is not needed to change the printheads).
- **Remove**: the printhead is not a suitable type for use in printing.
19 Troubleshooting general printer issues

- The printer will not start
- The printer does not print
- The printer seems slow
- Communication failures between computer and printer
- Cannot access the HP Utility
- Cannot access the Embedded Web Server
- Cannot connect to the Internet
- Web Services issues
- Automatic file system check
- Alerts
The printer will not start

If the printer will not start (the front panel is blank or the diagnostic LEDs are all off), you are recommended to replace the firmware, in the following way.

1. Go to the Knowledge Center (see Knowledge Center on page 171) and download the firmware.
2. Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted with the FAT filesystem.
3. Ensure that the printer is turned off. Connect the USB flash drive to the Hi-Speed USB host port beside the front panel, then turn the printer on.
4. The printer takes about a minute to read the firmware file, then asks you to remove the USB flash drive.
5. The printer automatically installs the new firmware and restarts.

The printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file you have sent from your computer may not start printing when expected:

- You may have an electrical power problem. If there is no activity at all from the printer, and the front panel does not respond, check that the power cable is connected correctly and that there is power available at the socket.
- You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this case, turn off the printer using the Power key on the front panel and unplug the power cord, wait until the electromagnetic environment has returned to normal, then turn it on again. If you still experience problems, please contact your customer service representative.
- Nesting may be on (T1300 series only) and the printer is waiting for the specified nest wait time before calculating the appropriate nests. In this case, the front panel shows the remaining time needed for nesting.
- You may have the wrong graphic language setting, see Change the graphic language setting on page 30.
- You may not have installed in your computer the correct driver for your printer, see the Assembly instructions.
- If you are printing on a sheet, you must specify Manual Feed as the paper source in your printer driver.
- The printer may be holding the job for paper or (T1300 series only) accounting information, see Job status messages on page 67.
- You may have requested a print preview (T1300 series only) from your printer driver. This is a function you can use to check that the image is the one you want. In this case, the preview is displayed on your screen, and you must click the Print button to start printing.
- If you are using Mac OS with a USB connection, you may find that you need to change the data encoding (PostScript printers only). Press , then Setup > Printing preferences > PS > Select encoding > ASCII. Then configure your application to send ASCII data.

The printer seems slow

Here are some possible explanations.
• Did you set the print-quality to **Best** or **Max Detail**? Best-quality and maximum detail prints take longer.

• Did you specify the correct paper type when loading the paper? Some paper types require more time for printing; for example, photo and coated papers require more drying time between passes. To find out the printer’s current paper type setting, see View information about the paper on page 40.

• If your printer is connected by network, check that all components used in the network (network interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from other devices on the network?

• If your printer is connected by USB, make sure that the USB host controller and the USB hubs used (if any) are USB 2.0; and check that the USB cables are USB 2.0 certified.

• Did you specify **Extended** drying time in the front panel? Try changing the drying time to **Optimal**.

**Communication failures between computer and printer**

Some symptoms are:

• The front-panel display does not show the **Receiving** message when you have sent an image to the printer.

• Your computer displays an error message when you are trying to print.

• Your computer or printer hangs (stays idle), while communication is taking place.

• Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

• Ensure that you have selected the correct printer in your application, see **Printing on page 46**.

• Ensure that the printer works correctly when printing from other applications.

• Remember that very large prints may take some time to receive, process and print.

• If the printer is connected to a network, try using it when connected directly to your computer through a USB cable.

• If your printer is connected to your computer through any other intermediate devices, such as switch boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to your computer.

• Try another interface cable.

• Ensure that the graphic language setting is correct, see **Change the graphic language setting on page 30**.

• If the printer is connected by USB cable, try disconnecting and reconnecting the USB cable. Also try using a different USB port on the computer.

**Cannot access the HP Utility**

If you have not done so already, please read **Access the HP Utility on page 28**.

From the front panel, press 📡 then 📡 then Setup > Connectivity > Advanced > Web Services > Printer utility software > Enabled.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

**Cannot access the Embedded Web Server**

If you have not done so already, please read **Access the Embedded Web Server on page 28**.
NOTE: If you connect directly to your printer with a USB cable, use the HP Utility.

From the front panel, press , then , then Setup > Connectivity > Advanced > Embedded Web Server > Allow EWS > On.

If you are using a proxy server, try bypassing the server and accessing the Web server directly.

- In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced button and add the printer’s IP address to the list of exceptions, for which the proxy server is not used.
- In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button. Add the printer’s IP address or its domain name to the list of exceptions, for which the proxy server is not used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Cannot connect to the Internet

If your printer has difficulty in connecting to the Internet, it may start the Connectivity Wizard automatically. You can also start the wizard manually at any time.

- From the Embedded Web Server: select Support > Connectivity troubleshooting > Connectivity wizard.

  NOTE: You cannot change connectivity settings from the Embedded Web Server.

- From the front panel: Press , then , then Connectivity > Connectivity wizard.

- From the front panel: Press , then , then Internal prints > Service information prints > Print connectivity config. In this case, the results are printed out.

  NOTE: The results printed out are from the last run of the Connectivity wizard, so you must already have run the Connectivity wizard in order to get any results.

The Connectivity Wizard performs a series of tests automatically. You can also choose to perform individual tests. From the front panel, press , then , then Connectivity > Diagnostics & troubleshooting > Diagnostics & troubleshooting. The following options are available.

- All tests
- Network connectivity test: Check the printer’s connection to the local area network.
- Internet connectivity test: Check the printer’s connection to the Internet.
- HP Connected test: Check the printer’s connection to HP Connected.
- Firmware update test: Check the printer’s connection to HP’s firmware update servers.

If any test fails, the printer describes the problem and recommends how to solve it. You can modify settings and rerun the test, unless you are using the Embedded Web Server or the settings are protected.

Web Services issues

For any issues with HP ePrint, visit HP Connected: (availability varies by product, country, and region).

Automatic file system check

When you turn on the printer, you will occasionally see a front panel display similar to the one shown below.
A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

⚠️ **CAUTION:** If you turn the printer off before the file system check has finished, the file system could be seriously damaged, making the printer’s hard disk unusable. In any case, the file system check will restart from the beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk’s file system integrity.

🔍 **NOTE:** When the printer is powered back on, it takes about three minutes to initialize and check and prepare the printheads. However, it can take up to 40 under some conditions, for example, when the printer has not been used for a long period of time and requires more time to prepare the printheads.

### Alerts

Your printer can communicate two types of alerts:

- **Errors:** Mainly alerting you to the fact that the printer is unable to work normally. However, in the printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is able to print.

- **Warnings:** Alert you when the printer needs attention either for an adjustment, such as a calibration or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer’s system.

- **Front-panel display:** The front panel shows only the most relevant alert at a time. In the case of a warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear when the printer becomes idle and there is not another more severe alert.

   ⚠️ **TIP:** From the front panel display you can configure paper mismatch alerts, see [Paper suitability options (T1300 series)](T1300 series) on page 22.

- **Embedded Web Server:** The upper-right corner of the Embedded Web Server window shows the printer status. If there is an alert in the printer, the status shows the alert text.

- **Driver:** The driver shows alerts. The driver warns about job configuration settings that may produce a problem in the final output. If the printer is not ready to print, it displays a warning.

- **HP Utility:** To see alerts, go to the Overview tab and review the Items needing attention list on the right-hand side.

By default, alerts are displayed only when you are printing. If alerts are enabled and there is a problem that prevents a job from completing, you see a pop-up window, which explains the reason for the problem. Follow the instructions to achieve your required result.

🔍 **NOTE:** There are environments that do not support bidirectional communication, for example: a Windows computer connected to the printer with USB. In those cases, alerts do not reach the job owner.
Occasionally you may see one of the following messages appear on the front-panel display. If so, please follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if the recommended action does not seem to solve the problem, contact HP Support. See Contact HP Support on page 173.

### Text messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Color] cartridge altered</td>
<td>Check the cartridge.</td>
</tr>
<tr>
<td>[Color] cartridge has expired</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 105.</td>
</tr>
<tr>
<td>[Color] cartridge is low on ink</td>
<td>Ensure that you have a new cartridge of the same color ready.</td>
</tr>
<tr>
<td>[Color] cartridge is missing</td>
<td>Insert a cartridge of the correct color. See Handling ink cartridges and printheads on page 105.</td>
</tr>
<tr>
<td>[Color] cartridge is out of ink</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 105.</td>
</tr>
<tr>
<td>[Color] cartridge is very low on ink</td>
<td>Ensure that you have a new cartridge of the same color ready.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: not present</td>
<td>Insert the correct printhead. See Handling ink cartridges and printheads on page 105.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: please remove</td>
<td>Remove the incorrect printhead and insert a new printhead of the correct type (color and number). See Handling ink cartridges and printheads on page 105.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: reseat</td>
<td>Remove and reinsert the same printhead, or try cleaning the electrical connections. If necessary, insert a new printhead. See The front-panel display recommends reseating or replacing a printhead on page 156.</td>
</tr>
<tr>
<td>Cutter replacement advised</td>
<td>Contact HP Support to replace the cutter. See Contact HP Support on page 173.</td>
</tr>
<tr>
<td>Job queue notification</td>
<td>Cancel, resume or delete the job. See Job queue management (T790 PS and T1300 series) on page 62.</td>
</tr>
<tr>
<td>Maintenance #1 advised</td>
<td>Contact HP Support. See Contact HP Support on page 173.</td>
</tr>
<tr>
<td>Maintenance #2 advised</td>
<td>Contact HP Support. See Contact HP Support on page 173.</td>
</tr>
<tr>
<td>Paper loaded incorrectly: remove paper</td>
<td>Remove the paper and try to reload it.</td>
</tr>
<tr>
<td>Paper mispositioned: remove paper</td>
<td>Remove the paper and try to reload it.</td>
</tr>
<tr>
<td>Paper path error: incorrectly loaded</td>
<td>Unload and reload the paper.</td>
</tr>
</tbody>
</table>
### Text messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper path error: misaligned</td>
<td>Unload and reload the paper.</td>
</tr>
<tr>
<td>Printhead replacement incomplete. Restart it.</td>
<td>Restart the printhead replacement process.</td>
</tr>
<tr>
<td>Printheads need individual testing. Do replacement</td>
<td>Test the printheads using the Image Diagnostics Print (see the Image-quality troubleshooting guide) and replace any that are not working correctly.</td>
</tr>
<tr>
<td>Replace [color] cartridge</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 105.</td>
</tr>
<tr>
<td>Reseat [color] cartridge</td>
<td>Remove and reinsert the same cartridge. See Handling ink cartridges and printheads on page 105.</td>
</tr>
</tbody>
</table>

### Numerical error codes

<table>
<thead>
<tr>
<th>Error code</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>01.0, 01.1, 01.2</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>06:03</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>08:04</td>
<td>Restart the printer. If the problem persists, update the printer’s firmware. See Update the firmware on page 117.</td>
</tr>
<tr>
<td>08:08</td>
<td>Retry the operation that you were attempting. If it fails again, restart the printer. If the problem persists, update the printer’s firmware. See Update the firmware on page 117.</td>
</tr>
<tr>
<td>26:01, 26.x:01</td>
<td>Bad contact detected in an ink cartridge (if present, x refers to the cartridge in slot x). Remove and reinsert the cartridge. If necessary, insert a new cartridge.</td>
</tr>
<tr>
<td>26:14</td>
<td>Update your printer's firmware. See Update the firmware on page 117.</td>
</tr>
<tr>
<td>27:01, 27.x:01</td>
<td>Too many printhead nozzles are not working (if present, x refers to the printhead in slot x). Remove and reinsert the printhead, or try cleaning the electrical connections. If necessary, insert a new printhead. See The front-panel display recommends reseating or replacing a printhead on page 156.</td>
</tr>
<tr>
<td>27:03</td>
<td>Printhead error. Restart the printer.</td>
</tr>
<tr>
<td>27:14</td>
<td>Update your printer’s firmware. See Update the firmware on page 117.</td>
</tr>
<tr>
<td>31-03, 41:03, 42:03, 45:1:03, 45:2:03, 47:03, 56:03</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>61:01</td>
<td>The file format is wrong and the printer cannot process the job. You may have sent a PostScript, PDF, TIFF or JPEG job to a non-PostScript printer. If the job is password-protected, try sending it without password protection. Otherwise, update your printer’s firmware and try again. See Update the firmware on page 117.</td>
</tr>
<tr>
<td>61:04:1, 61:04:2</td>
<td>Update your printer’s firmware. See Update the firmware on page 117.</td>
</tr>
<tr>
<td>61:08:1</td>
<td>Resend the job without password protection.</td>
</tr>
<tr>
<td>62, 62:04, 63</td>
<td>Update your printer’s firmware. See Update the firmware on page 117.</td>
</tr>
<tr>
<td>63:01</td>
<td>The printer has failed to get an IP address. Connect to another network or change the IPv4 configuration.</td>
</tr>
<tr>
<td>63:04, 64</td>
<td>Update your printer’s firmware. See Update the firmware on page 117.</td>
</tr>
<tr>
<td>64:1:01</td>
<td>The external hard disk has been removed while it was in use. Please reconnect it and restart the printer.</td>
</tr>
<tr>
<td>64:04, 65, 65:04</td>
<td>Update your printer’s firmware. See Update the firmware on page 117.</td>
</tr>
</tbody>
</table>
### Numerical error codes (continued)

<table>
<thead>
<tr>
<th>Error code</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>66:08</td>
<td>The job cannot be printed on the paper type that is loaded.</td>
</tr>
<tr>
<td>67, 67:04</td>
<td>Update your printer’s firmware. See <a href="#">Update the firmware on page 117</a>.</td>
</tr>
<tr>
<td>68:03</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>71:04</td>
<td>Out of memory. To avoid this, in the HP-GL/2 and HP RTL driver select the Advanced tab and then Send job as a bitmap.</td>
</tr>
<tr>
<td>71:03</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>71:04</td>
<td>Update your printer’s firmware. See <a href="#">Update the firmware on page 117</a>.</td>
</tr>
<tr>
<td>74:04, 74.1:04</td>
<td>The firmware upgrade has failed. Press OK and try again. See <a href="#">Update the firmware on page 117</a>.</td>
</tr>
<tr>
<td>74.1</td>
<td>Try the firmware update again. Do not try to use your computer while the update is in progress.</td>
</tr>
<tr>
<td>74:8:04</td>
<td>The firmware upgrade has failed. Your firmware file may be incorrect; try to download it again. See <a href="#">Update the firmware on page 117</a>.</td>
</tr>
<tr>
<td>76:03</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>77:04, 78.1:04</td>
<td>Update your printer’s firmware. See <a href="#">Update the firmware on page 117</a>.</td>
</tr>
<tr>
<td>78:08</td>
<td>Borderless printing not possible; setting ignored.</td>
</tr>
<tr>
<td>79:03</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>79:04, 79.1:04</td>
<td>Update your printer’s firmware. See <a href="#">Update the firmware on page 117</a>.</td>
</tr>
<tr>
<td>81:01</td>
<td>Please follow the instructions on the front panel. You may be asked to run a test procedure and write down a numeric code before contacting HP Support. See <a href="#">Contact HP Support on page 173</a>.</td>
</tr>
<tr>
<td>81:03, 84:03</td>
<td>Restart the printer.</td>
</tr>
<tr>
<td>86:01</td>
<td>Please follow the instructions on the front panel. You may be asked to run a test procedure and write down a numeric code before contacting HP Support. See <a href="#">Contact HP Support on page 173</a>.</td>
</tr>
<tr>
<td>94, 94:1, 94:08</td>
<td>Restart color calibration. See <a href="#">Color calibration on page 70</a>.</td>
</tr>
<tr>
<td>94:02</td>
<td>Color calibration failed. Check that the paper type that is loaded corresponds to the paper type that you have selected.</td>
</tr>
</tbody>
</table>

### The system error log

The printer saves a log of system errors that you can access in the following ways.

**Using a USB flash drive**

1. Create an empty file named `pdipu_enable.log` in a USB flash drive.
2. Insert the USB flash drive into the Hi-Speed USB host port at the front of the printer. The log will be automatically copied into the drive.

**Using the Embedded Web Server**

1. In your Web browser, go to `http://printer IP address/hp/device/webAccess/log.html`.
2. The Embedded Web Server will send you a file called `log.tar.gz` containing the system error log.
Chapter 21   HP Customer Care

- **Introduction**
- **HP Professional Services**
- **HP Instant Support**
- **HP Proactive Support**
- **Customer Self Repair**
- **Contact HP Support**
Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, providing comprehensive, proven support expertise and new technologies to give you unique end-to-end support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone and Web support, software updates and self-maintenance services. To find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts

or call us on the telephone (see Contact HP Support on page 173). To register your warranty:

http://register.hp.com/

HP Professional Services

Knowledge Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your HP DesignJet printers and solutions.

Join the HP community at the Knowledge Center, your large-format printing community, for 24x7 access to:

● Multimedia tutorials
● Step-by-step how-to guides
● Downloads: the latest printer firmware, drivers, software, paper presets, etc.
● Technical support: online troubleshooting, customer care contacts and more
● Workflows and detailed advice for completing various printing tasks from particular software applications
● Forums for direct contact with the experts, both HP and your colleagues
● Warranty tracking online, for your peace of mind
● Latest product information: printers, supplies, accessories, software, etc.
● Supplies Center for all you need to know about ink and paper

The Knowledge Center can be found at the following locations, depending on your printer:

● http://www.hp.com/go/T790/knowledgecenter
● http://www.hp.com/go/T790ps/knowledgecenter
● http://www.hp.com/go/T1300/knowledgecenter
● http://www.hp.com/go/T1300ps/knowledgecenter

By customizing your registration for the products you have purchased and your type of business, and by setting your communication preferences, you decide the information you need.

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer’s software and documentation.

HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer’s warranty beyond the standard period.
They include remote support. On-site service is also provided if necessary, with two alternative response-time options.

- Next business day
- Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/printservices.

**HP Installation**

The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/printservices.

**HP Instant Support**

HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic information from your printer and match it with intelligent solutions from HP's knowledge bases, allowing you to resolve problems as quickly as possible.

You can start an HP Instant Support session by clicking on the link provided on the Troubleshooting page of your printer's Embedded Web Server. See Access the Embedded Web Server on page 28.

To be able to use HP Instant Support:

- You must have a TCP/IP connection to your printer, because HP Instant Support is accessible only through the Embedded Web Server.
- You must have access to the World Wide Web, because HP Instant Support is a Web-based service.

HP Instant Support is currently available in English, Korean, Simplified Chinese and Traditional Chinese.

You can find more information about HP Instant Support at http://www.hp.com/go/ispe.

**HP Proactive Support**

HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and resolving printer issues before they become problems for you. HP’s Proactive Support tool is designed to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of your printing environment—with a clear focus on maximizing the value of your investment, increasing printer uptime and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and firmware updates.

You can enable Proactive Support in the HP Utility for Windows or the HP Printer Monitor for Mac OS, where you can specify the frequency of connections between your computer and HP's Web server, and the frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To change these settings:

- In the HP Utility for Windows, select the **Tools** menu, then **HP Proactive Support**.
- In the HP Printer Monitor for Mac OS, select **Preferences > Monitoring > HP Proactive Support**.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem and recommend a solution. In some cases, the solution may be applied automatically; in other cases, you may be asked to perform some procedure to solve the problem.
Customer Self Repair

HP's Customer Self Repair program offers our customers the fastest service under either warranty or contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this program, you can replace parts at your own convenience.

Convenient, easy to use

● An HP Support Specialist will diagnose and assess whether a replacement part is required to address a defective hardware component.

● Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact HP.

● Available for most HP products currently under warranty or contract.

● Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.

Contact HP Support

HP Support is available to you by telephone. What to do before you call:

● Review the troubleshooting suggestions in this guide.

● Review the relevant driver documentation.

● If you have installed third-party software drivers and RIPs, see their documentation.

● If you call one of the HP offices, please have the following information available to help us answer your questions more quickly:
  — The product you are using (the product number and the serial number, found on the label at the back of the product)
  — If there is an error code on the front panel, note it down; see Front-panel error messages on page 167
  — The product's Service ID: at the front panel, press , then , then .
  — The computer you are using
  — Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, modems or special software drivers)
  — The cable you are using (by part number) and where you purchased it
  — The type of interface used on your product (USB or network)
  — The software name and version you are currently using
  — If possible, print out the following reports; you may be asked to fax them to the support center helping you: Configuration, Usage Report and “all pages above” from Service Information (see The printer’s internal prints on page 11)

Telephone number

22 Printer specifications

- Functional specifications
- Physical specifications
- Memory specifications
- Power specifications
- Ecological specifications
- Environmental specifications
- Acoustic specifications
## Functional specifications

### HP 72 ink supplies

<table>
<thead>
<tr>
<th>Item</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printheads</strong></td>
<td>Two inks in each printhead: gray and photo black, matte black and yellow, and magenta and cyan</td>
</tr>
<tr>
<td><strong>Ink cartridges</strong></td>
<td>Cartridges containing 69 ml of ink: gray, photo black, yellow, magenta and cyan</td>
</tr>
<tr>
<td></td>
<td>Cartridges containing 130 ml of ink: gray, photo black, matte black, yellow, magenta and cyan</td>
</tr>
<tr>
<td></td>
<td>Cartridges containing 300 ml of ink (T795 &amp; T1300 series only): matte black only</td>
</tr>
</tbody>
</table>

### Paper sizes

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roll width</td>
<td>279 mm (11 in)</td>
<td>610 mm (24 in) or 1118 mm (44 in)</td>
</tr>
<tr>
<td>Roll length</td>
<td>91 m (300 feet)</td>
<td></td>
</tr>
<tr>
<td>Roll diameter</td>
<td>135 mm (5.3 in)</td>
<td></td>
</tr>
<tr>
<td>Roll weight</td>
<td>11.9 kg (26.3 lb)</td>
<td></td>
</tr>
<tr>
<td>Sheet width</td>
<td>210 mm (8.26 in)</td>
<td>610 mm (24 in) or 1118 mm (44 in)</td>
</tr>
<tr>
<td>Sheet length</td>
<td>279 mm (11 in)</td>
<td>1676 mm (66 in)</td>
</tr>
<tr>
<td>Paper thickness</td>
<td></td>
<td>0.8 mm (31.5 mil)</td>
</tr>
<tr>
<td>Paper weight</td>
<td>60 g/m² (24 in)</td>
<td>328 g/m² (66 in)</td>
</tr>
</tbody>
</table>

### Printing resolutions

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Maximum detail</th>
<th>Driver</th>
<th>Rendering resolution (ppi)</th>
<th>Printing resolution (dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best (glossy paper*)</td>
<td>On</td>
<td>HP-GL/2, HP PCL3GUI</td>
<td>1200 × 1200</td>
<td>2400 × 1200</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>PostScript</td>
<td>600 × 600</td>
<td>2400 × 1200</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Any</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Best (other papers)</td>
<td>Off</td>
<td>Any</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Normal</td>
<td>Off</td>
<td>HP-GL/2, HP PCL3GUI</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PostScript, HP PCL3GUI</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Fast</td>
<td>Off</td>
<td>HP-GL/2</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PostScript, HP PCL3GUI</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Economode (heavyweight coated and</td>
<td>Off</td>
<td>Any</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>glossy paper*)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Economode (other papers)</td>
<td>Off</td>
<td>Any</td>
<td>300 × 300</td>
<td>600 × 1200</td>
</tr>
</tbody>
</table>

* For a list of supported glossy papers, see [Order paper on page 120](#).
Margins

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Top, right and left margins</td>
<td>5 mm (0.2 in)</td>
</tr>
<tr>
<td>Bottom margin (trailing edge)</td>
<td>5 mm (0.2 in) (roll)</td>
</tr>
<tr>
<td></td>
<td>17 mm (0.67 in) (sheet)</td>
</tr>
</tbody>
</table>

Mechanical accuracy

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0 printing material in Best or Normal mode with HP Matte Film roll feed.

Graphic languages supported

<table>
<thead>
<tr>
<th>HP DesignJet</th>
<th>Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>T790, T795</td>
<td>HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG</td>
</tr>
<tr>
<td>T790 PS</td>
<td>HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG, Adobe PDF 1.7, Adobe PostScript 3</td>
</tr>
<tr>
<td>T1300</td>
<td>HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG</td>
</tr>
<tr>
<td>T1300 PS</td>
<td>HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG, Adobe PDF 1.7, Adobe PostScript 3</td>
</tr>
</tbody>
</table>

Physical specifications

Printer physical specifications

<table>
<thead>
<tr>
<th>HP DesignJet T790 24-in series</th>
<th>HP DesignJet T790 44-in series</th>
<th>HP DesignJet T1300 series</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>60 kg (132 lb)</td>
<td>86 kg (189 lb)</td>
</tr>
<tr>
<td>Width</td>
<td>1262 mm (49.7 in)</td>
<td>1770 mm (69.7 in)</td>
</tr>
<tr>
<td>Depth Minimum: 692 mm (27.2 in)</td>
<td>Minimum: 692 mm (27.2 in)</td>
<td>Minimum: 692 mm (27.2 in)</td>
</tr>
<tr>
<td>Depth Maximum: 702 mm (27.6 in)</td>
<td>Maximum: 701 mm (27.6 in)</td>
<td>Maximum: 721 mm (28.4 in)</td>
</tr>
<tr>
<td>Height</td>
<td>1050 mm (41.3 in)</td>
<td>1050 mm (41.3 in)</td>
</tr>
</tbody>
</table>

The depth is measured without the upper spindle; wall spacers up; ink cover opened; roll covers and basket closed.

Memory specifications

<table>
<thead>
<tr>
<th>HP DesignJet</th>
<th>Dedicated file-processing memory *</th>
<th>Hard disk</th>
</tr>
</thead>
<tbody>
<tr>
<td>T790 series</td>
<td>8 GB</td>
<td>160 GB</td>
</tr>
<tr>
<td>T795</td>
<td>16 GB</td>
<td>160 GB</td>
</tr>
<tr>
<td>T1300 series</td>
<td>32 GB</td>
<td>160 GB</td>
</tr>
</tbody>
</table>
* 640 MB physical DRAM

**Power specifications**

* **Printer power specifications**

<table>
<thead>
<tr>
<th>Source</th>
<th>100–240 V ac ±10%, auto-ranging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>50–60 Hz</td>
</tr>
<tr>
<td>Current</td>
<td>&lt; 2 A</td>
</tr>
<tr>
<td>Consumption</td>
<td>&lt; 120 W</td>
</tr>
</tbody>
</table>

**Ecological specifications**

This product complies with European Union WEEE and RoHS Directives. To determine the ENERGY STAR qualification status of these product models, please go to [http://www.hp.com/go/energystar](http://www.hp.com/go/energystar).

**Environmental specifications**

* **Printer environmental specifications**

<table>
<thead>
<tr>
<th>Operating temperature</th>
<th>5 to 40°C (41 to 104°F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended operating temperature</td>
<td>15 to 35°C (59 to 95°F), depending on paper type</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>−25 to 55°C (~−13 to 131°F)</td>
</tr>
<tr>
<td>Recommended operating humidity</td>
<td>20 to 80% RH, depending on paper type</td>
</tr>
<tr>
<td>Storage humidity</td>
<td>0 to 95% RH</td>
</tr>
</tbody>
</table>

**Acoustic specifications**

*Printer acoustic specifications (declared according to ISO 9296).*

* **Printer acoustic specifications**

<table>
<thead>
<tr>
<th>Idle sound power level</th>
<th>4.4 B (A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating sound power level</td>
<td>6.3 B (A)</td>
</tr>
<tr>
<td>Idle sound pressure at bystander position</td>
<td>29 dB (A)</td>
</tr>
<tr>
<td>Operating sound pressure at bystander position</td>
<td>46 dB (A)</td>
</tr>
</tbody>
</table>
**AppleTalk**
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends TCP/IP and Bonjour networking instead. HP DesignJet products no longer support AppleTalk.

**Bonjour**
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area network. It was originally known as Rendezvous.

**Color accuracy**
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited color gamut and may not be physically capable of matching certain colors precisely.

**Color consistency**
The ability to print the same colors from a particular print job from print to print and from printer to printer.

**Color model**
A system of representing colors by numbers, such as RGB or CMYK.

**Color space**
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same color model; for instance, monitors generally use the RGB color model, but they have different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

**Cutter**
A printer component that slides back and forth across the platen to cut the paper.

**ESD**
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up the printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

**Ethernet**
A popular computer networking technology for local area networks.

**Fast Ethernet**
An Ethernet network capable of transferring data at up to 100,000,000 bits/second. Fast Ethernet interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

**Firmware**
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

**Gamut**
The range of colors and density values reproducible on an output device, such as a printer or monitor.
**Gigabit Ethernet**
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

**Hi-Speed USB**
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible with original USB. Most personal computers today use Hi-Speed USB.

**HP RTL**
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

**HP-GL/2**
HP Graphics Language 2: a language defined by HP to describe vector graphics.

**I/O**
Input/Output: this term describes the passing of data between one device and another.

**ICC**
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

**Ink cartridge**
A removable printer component that stores ink of a particular color and provides it to the printhead.

**IP address**
May mean an IPv4 address (most likely) or an IPv6 address.

**IPSec**
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware whether IPSec is being used or not.

**IPv4 address**
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated by full stops. Most networks in the world use IPv4 addresses.

**IPv6 address**
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of hexadecimal digits separated by colons. Each group contains up to 4 hexadecimal digits. Only a few new networks in the world use IPv6 addresses.

**Jetdirect**
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.

**LED**
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

**MAC address**
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

**Network**
A network is a set of connections that pass data between computers and devices. Every device is able to communicate with every other device in the same network. This allows data to be moved between computers and devices, and allows devices such as printers to be shared between many computers.

**Nozzle**
One of many tiny holes in a printhead through which ink is deposited onto the paper.

**Paper**
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, dried and pressed.
**Platen**  
The flat surface within the printer over which the paper passes while it is being printed on.

**Printer driver**  
Software that converts a print job in a generalized format into data suitable for a particular printer.

**Printhead**  
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it on the paper, through a cluster of nozzles. In the HP DesignJet T790 and T1300 series, each printhead prints two different colors.

**Spindle**  
A rod that supports a roll of paper while it is being used for printing.

**TCP/IP**  
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

**USB**  
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed USB (sometimes called USB 2.0).

**USB device port**  
A square USB socket found on USB devices, though which a computer can control the device. For a computer to print to your printer using a USB connection, the computer must be connected to the printer’s USB device port.

**USB host port**  
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.
Index

A
access control 25
accessories
order 124
account ID [T1300]
requiring 26
accounting 102
accounting data by email 103
acoustic specifications 177
alerts
errors 166
turn on and off 24
warnings 166

B
banding problems 138
basket
output problems 137
black and white 73
black point compensation 78
blurred lines 145
brightness in front panel 29
buzzer on/off 29

C
calibration
color 70
cannot load paper 129
clean the platen 148
clean the printer 116
clipped at bottom 150
clipped image 151
color
adjustment options 73
advantages 70
calibration 70
CMYK 70
emulation 75
fading 150
inaccurate 149
printer emulation 72
profile 70
RGB 70
color management
from drivers 71
from EWS [T1300] 77
from front panel 78
from PS drivers 74
options 71
process 70
communication ports 7
components of printer 5
computer communication
printer/computer communications issues 164
configure 29
connect the printer
choose a method 13
general 13
Mac OS network 16
Mac OS USB 18
Windows network 14
Windows USB 15
crop lines [T1300] 56
Customer Care 171
Customer Self Repair 173
cutter
on/off 42
disk erase, secure 118
draft for revision, print 81
draft printing 54
driver preferences 26
drying time
change 41
e-mail notifications 24
eco logical specifications 177
economize
on ink 58
on paper 57
e-mail printing 61
Embedded Web Server
access 28
cannot access 164
job preview 65
job queue 65
language 29
usage per job 102
usage statistics 102
environmental specifications 177
erase hard disk securely 118
error messages
front panel 167
log 169
external hard disk 125
fading colors 150
features of printer 4
file system check 165
firmware update 117
manual setup 22
setup 21
front panel 8
brightness 29
job preview 63
job queue 63
language 28
units 29
front panel option
adjust paper advance 138
align printheads 160
allow EWS 165
black point compensation 79
calibrate color 71
calibrate paper advance 138
clean printheads 157
CMYK source profile 79
color/grayscale 79
connectivity wizard 21, 165
emulate printer 79
enable buzzer 29
enable crop lines 56
enable cutter 42
enable economode 55
enable maximum detail 55
enable merge 53
generate merge 53
form feed and cut 42
Internet connectivity 21
modify configuration 30
move paper 41
PANTONE emulation 79
paper mismatch action 22
print connectivity config. 165
print diagnostic image 152
print quality 120
Printer utility software 164
printhead information 109
rendering intent 79
replace ink cartridges 106
replace printheads 109
reset paper advance 139
resize 53
RGB source profile 79
roll protection 59
roll switching options 23
select display brightness 29
select drying time 41
select graphics language 31
select I/O timeout 150
select language 28
select paper size 50
select paper type 131
select units 29
select wait time 58
sleep mode wait time 29
unload paper 38
front view 5
functional specifications 175

G
Graininess 146
graphic languages 176
gray shades 73

H
hard disk specification 176
hard disk, external 125
HP Care Packs 171
HP Customer Care 171
HP ePrint
disable 26
HP Jetdirect print server 124
job preview
Embedded Web Server 65
front panel 63
job queue
Embedded Web Server 65
front panel 63
Knowledge Center 171

K
Knowledge Center 171

L
language 28
line length accuracy 145
line thickness 143
load paper
cannot load 129
general advice 33
paper not in driver 130
roll cannot load 129
roll into printer 35
roll onto spindle 33
sheet 38
sheet spindle 33

M
maintenance kits 118
margins 52
none[T1300] 56
specification 176
mechanical accuracy 176
memory specifications 176
Microsoft Office
print from 95
misaligned colors 144
models, printer 3
move the printer 116
multiroll printer[T1300] 44

N
nesting[T1300] 57
turn on and off 23
Network settings 29

O
on hold for paper
enable/disable 132
message[T1300] 132
order
accessories 124
ink cartridges 120
paper 120
printheads 120
overlapping lines 53
overnight printing[T1300] 59

P
page size 50
PANTONE emulation 75
PANTONE swatch book 78
paper
advance 42
calibrate the paper advance 138
cannot load 129
cut after printing 137
displaying information 41
download presets 40
economical use of 57
feed and cut 42
incorrect out of paper 137
jam due to cut strip 136
jammed 133
loading error messages 130
maintenance 41
movement 41
not cut well 137
not flat 146
output problems in basket 137
paper not in driver 130
presets 40
print on loaded paper 52, 132
printed on wrong paper 132
retained by printer 137
roll loose on spindle 137
select type 52
size 50
sizes (max and min) 175
usage 102
view information 40
paper mismatch action [T1300] 22
paper not in driver 130
paper suitability [T1300] 22
paper types 120
PDF clipped 152
PDF missing objects 152
physical specifications 176
platen cleaning 148
ports 7
PostScript upgrade 124
power
on/off 10
power specifications 177
preferences, Windows driver 26
presentation, print 90
preview a print 54
print by email 61
print from
Embedded Web Server [T1300] 48
HP Utility [T1300] 48
printer driver 49
USB flash drive 47
print job
nesting [T1300] 57
print preview 54
print quality
select 49
print-quality problems
banding 142
black ink comes off 148
blurred lines 145
bottom of print 149
discontinuous lines 144
edges darker than expected 148
edges stepped or not sharp 148
general 141
graininess 146
horizontal lines 142
inaccurate line lengths 145
ink marks 147
line thickness 143
misaligned colors 144
paper not flat 146
scratching 147
scuffing 147
stepped lines 143
vertical lines of different colors 149
white spots 149
wizard 141
printer does not print 163
printer models 3
printer security 31
printer software 9
Mac OS uninstall 19
Windows uninstall 16
printer status 116
printer will not start 163
printer’s main components 5
printer’s main features 4
printhead
about 108
align 159
cannot insert 156
clean; purge 157
insert 112
order 120
remove 109
replace, reseat 156
specification 175
status 109
status messages 161
printhead cleaner
specification 175
printhead drop detector
clean 157
printing 46
printing resolutions 175
Proactive Support 172
project, print 83
protect a roll [T1300] 59
Q
quality, high 55
R
rear view 6
rendering intent 77
rescale a print 53
roll paper
load 35
spindle load 33
unload 38
roll protection [T1300] 59
roll switching options [T1300] 23
S
safety precautions 2
scale a print 53
scratched prints 147
scuffed prints 147
secure disk erase 118
security 25
sheet paper
load 38
unload 40
sleep mode wait time 29
slow printing 163
software 9
software update 118
specifications
acoustic 177
ecological 177
environmental 177
functional 175
graphic languages 176
hard disk 176
ink supplies 175
margins 176
mechanical accuracy 176
memory 176
paper size 175
physical 176
power 177
printing resolutions 175
spindle 124
statistics
ink cartridge 106
usage 102
usage per job 102
stepped lines 143
store the printer 116
support services
HP Care Packs 171
HP Customer Care 171
HP Instant Support 172
HP Proactive Support 172
HP Start-Up Kit 171
HP Support 173
Knowledge Center 171
printer installation 172
warranty extensions 171
T
telephone number 173
two rolls [T1300] 44

U
unattended printing [T1300] 59
unload paper
  roll 38
  sheet 40
usage information
  turn on and off 24
  using this guide 2

W
wall spacers 7
warranty extensions 171
Web connection
  setup 21
web services
  introduction 10
  troubleshooting 165